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0003 1章　概要

本機の特長
新開発36×24mmフルフ
レームCMOSイメージセ
ンサーを搭載

最大6048画素×4032画素の解像度でキャプ
チャーすることが可能*で、撮像モードを切り換
えることにより、標準的なSuper35mm  
24.3×12.8mm、4096画素×2160画素（3パー
フォレーションに相当）はもちろんのこと4:3ア
ナモフィックに対応するSuper35mm 24.3×
18.3mm、4096画素×3024画素（4パーフォレー
ションに相当）*をネイティブサポート。
* フルフレームおよびアナモフィックモードは別売りラ
イセンスが必要となります

ワイドラチチュード

15ストップ＋の広大なラチチュードを実現。ハ
イライト部から暗部まで幅広い輝度条件の下で、
低ノイズで美しい映像をキャプチャーすること
ができ、グレーディング作業において高い自由
度をもたらします。

広色域キャプチャーが可能

DCI-P3を越える色域でのキャプチャーが可能
です。ソニーが定義するワイドカラースペース
S-Gamut3とS-Gamut3.Cineを搭載しS-Log3
と一緒に活用することにより、グレーディング
時の自由度が飛躍的に向上します。

Dual Base ISO

基準感度として、ISO500とISO2500の2種類
から選択できます。通常の照明下では Base 
ISO500を、低照度の条件ではBase ISO2500を
使用することによりノイズ感を粗くせず、ハイ
ライトとローライトのラチチュードバランスを
保ったまま撮影が可能となります。

PLレンズマウント

標準でPLレンズマウントが装着されています。
レンズマウントはCooke/iに対応しており、レ
ンズ情報はフレームごとにメタデータとして記
録されます。

Eマウントレンズ対応

PLレンズアダプターを取り外すことにより、Eマウ
ントレンズが使用可能です。PLレンズと比較して小
型・軽量であり、またEマウントレンズの多彩なラ
インナップにより更なる映像表現の幅を広げます。

コンパクトなボディと直感
的な操作感

ソニー独自の小型化技術によりフルフレーム大
型イメージセンサーを搭載しながらコンパクト
なサイズを実現しており、狭いスペースでの撮影
やドローン搭載時の利便性を向上させています。

操作ボタンは直観的な操作を実現するために場
所、形状、サイズを徹底的に検討して配置され
ており、また暗所撮影を考慮しバックライトを
備えています。

高い堅牢性

筐体は高い堅牢性を誇るマグネシウム合金製。
吸排気機構はすべての電子部品から完全に隔離
されていて、砂や埃、水滴の侵入を防ぎます*。
静粛性に優れたファンは取り外し可能で清掃す
ることができ、過酷な映画制作の現場で高い可
用性を保つことができます。
* 防塵・防滴に配慮された構造になっていますが埃や水
滴の侵入を完全に防ぐものではありません

モジュラー構造

完全なモジュラー設計であり、撮影用途に合わせ
さまざまなリグや周辺機器との組み合わせに柔軟
に対応することができます。レンズとのバランス
や使いかたに合わせてトップハンドルとビュー
ファインダーは簡単に調整できます。光軸高は
PMW-F55と同じなのでPMW-F55用の周辺機器を
活用することが可能です。後部には別売りのポー
タブルメモリーレコーダー AXS-R7（別売り）を4本
の六角ネジにより強固に固定することができます。

8ポジション光学式ND
フィルター

8ポジション光学式NDフィルターを採用してい
ます。0.3ND（1/2 = 1ストップ）から2.4ND（1/256 
= 8ストップ）の広範囲のNDを備えており、外部
NDフィルターを交換する手間を省きます。この
NDフィルターはサーボ制御が可能です。

現場での運用を考えた、シ
ンプルで直感的なメニュー
操作

メニュー画面をカメラの両側に、メイン操作部
はカメラのアシスタントサイドに配置していま
す。これにより撮影現場でカメラアシスタント
が設定操作をすばやく行うことができます。
オペレーターサイドの有機ELミニディスプレイ
は、NDポジション、シャッター、ホワイトバ
ランス、EI値、FPSなど、頻繁に使う設定を簡
単に操作でき、またカメラマンの方がステータ
スを確認するのにも便利です。

RM/RCPおよび本機からの
ペイントコントロールに対
応

本機はブロードキャストカムコーダーやシス
テムカメラで使用可能なRM/RCPパネルから
の制御にも対応しています。接続時にはITU-R 
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Rec.2020色域とHLGも選択可能であり、各種ペ
イント項目の調整も可能です。
また、本機のフルメニューからペイントコント
ロールの操作が可能です。

ハイフレームレート（HFR）
撮影

本機とAXS-R7を組み合わせることにより、最
大120FPSでの4K X-OCN記録が可能です。

リモートコントロールユ
ニット対応

RM-B170などのリモートコントロールユニッ
トを接続すると、Technicalメニュー > System 
Configuration > RM/RCP Paint Control（81
ページ）がOffに設定されていても、リモートコ
ントロールユニットから本機の機能の一部をコ
ントロールすることが可能です。

多彩なレコーディング
フォーマット

XAVC 4K/QFHD、MPEG HDフォーマット、
HD ProRes 422フォーマットでSxSメモリー
カードに収録することができます。また、ポー
タブルメモリーレコーダー AXS-R7（別売り）と
の組み合わせによりAXSメモリーカードに16
ビットRAWまたはX-OCNフォーマットでの記

録にも対応します。

イメージャーブロックの延
長

カメラエクステンションシステムCBK-3610XS 
*を接続することでイメージャブロックを約
2.7mまたは約5.5mに延長することができます。
* 本機のファームウェアを3.0以降にバージョンアップし
てください。

有効画サイズについて

本機では、以下の有効画サイズでの撮影が可能です。

[ご注意]
6K 17:9、6K 1.85:1、6K 2.39:1、6K 3:2、5.7K 16:9、4K 4:3および4K 6:5で撮影するためにはソフトウェアライセンスが
必要です。

6K 3:2

6K 1.85:1

6K 17:9

4K 6:5

4K 4:3

6K 2.39:1

4K 2.39:1

4K 17:9
(DCI 4K)

3.8K 16:9
(Ultra HD)

5.7K 16:9
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ソフトウェアライセンスについて

本機の運用状況に応じてソフトウェアライセンス（別売り）を選択できます。
ソフトウェアライセンスのインストールは、フルメニューのMaintenance > License Options
（85ページ）にて行います。

ソフトウェアライセンス イメージャー
モード

有効画素
（撮像画素）

W x H (mm) プロジェクトフレーム 
レート

ライセンス不要1) 3.8K 16:9 3840 x 2160 22.8 x 12.8 23、24、25、29、50、59
3.8K 16:9 
Surround 
View

3840 x 2160
(4268 x 2400)

22.8 x 12.8
(25.4 x 14.3)

23、24、25、29

4K 2.39:1 4096 x 1716 24.3 x 10.3 23、24、25、29、47、
50、59

4K 17:9 4096 x 2160 24.3 x 12.8 23、24、25、29、47、
50、59

4K 17:9 
Surround 
View

4096 x 2160
(4552 x 2400)

24.3 x 12.8
(27.0 x 14.3)

23、24、25、29

アナモフィックライセンス 4K 4:3 4096 x 3024 24.3 x 18.0 23、24、25、29、47、
502)、592)

4K 4:3 
Surround 
View

4096 x 3024
(4552 x 3360)

24.3 x 18.0
(27.0 x 20.0)

23、24、25、29

4K 6:5 4096 x 3432 24.3 x 20.4 23、24、25、29
フルフレームライセンス1) 5.7K 16:9 5674 x 3192 33.7 x 18.9 23、24、25、29

6K 2.39:1 6048 x 2534 35.9 x 15.0 23、24、25、29、472)3)、
502)3)、592)3)

6K 17:9 6054 x 3192 36.0 x 19.0 23、24、25、29、472)3)、
502)3)、592)3)

6K 1.85:1 6054 x 3272 36.0 x 19.4 23、24、25、29、472)3)、
502)3)、592)3)

6K 3:2 6048 x 4032 35.9 x 24.0 23、24、25、292)、472)3)、
502)3)、592)3)

1） Off(1.0x)以外のデスクイーズ機能を有効にするには、アナモフィックライセンスが必要です。
2） ハイフレームレートライセンス有効時のみ。
3） AXS記録は可能ですが、AXS再生は本機ではできません。

使用可能な撮像フレームレートとDe-Squeeze値について

各イメージャーモードで使用可能な撮像フレームレートとDe-Squeeze値（67ページ）は以下のと
おりです。

フルフレームライセンス アナモフィックライセンス ハイフレームレートライセンス

イメージャーモード 撮像フレームレート De-Squeeze 
標準 拡張フレームレート Off(1.0x) 1.25x 1.3x 1.5x 1.65x 1.8x 2.0x

6K 3:2 1～ 25 ～ 60 ○ ○ ○ ○ ○ ○ ○
6K 1.85:1 1～ 30 ～ 60、66、72 ○ ― ― ― ― ― ―
6K 17:9 1～ 30 ～ 60、66、72 ○ ○ ○ ― ○ ○ ○
6K 2.39:1 1～ 30 ～ 60、66、72、

75、88、90
○ ― ― ― ― ― ―

5.7K 16:9 1～ 30 ― ○ ― ― ― ― ― ―
4K 6:51) 1～ 30 ― ○ ― ― ― ― ― ○
4K 4:3 Surround 1～ 30 ― ○ ― ○ ― ○ ○ ○
4K 4:32) 1～ 48 ～ 60、66、72、75 ○ ― ○ ― ○ ○ ○
4K 17:9 Surround 1～ 48 ― ○ ○ ○ ― ○ ○ ○
4K 17:9 1～ 60 66、72、75、88、

90、96、100、110
○ ○ ○ ― ○ ○ ○

4K 2.39:1 1 ～ 60 66、72、75、88、
90、96、100、
110、120

○ ― ― ― ― ― ―

3.8K 16:9 Surround 1～ 48 ― ○ ― ― ― ― ― ―
3.8K 16:9 1～ 60 ― ○ ― ― ― ― ― ―

1) SxS Rec FormatがProRes 4444 HD Pの場合は、Off(1.0x)のみ使用可能です。
2) SxS Rec FormatがProRes 4444 HD Pの場合は、Off(1.0x)と1.3xのみ使用可能です。
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Surround Viewについて

以下のイメージャーモードにおいて、有効画サイズの上下左右5％外側領域も含めた画像領域を
ビューファインダーおよびSDIモニター出力で確認しながら撮影できるモードです。記録領域は外側
領域を含みません。
3.8K 16:9
4K 17:9
4K 4:3

［ご注意］

ˎˎ 本モードでは、プロジェクトフレームレートの上限設定に制限がかかる場合があります。
ˎˎ 4K 4:3モードのデスクイーズ倍率が2.0xの場合は、上下5％外側領域のみを含む画像領域となります。
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システム構成例

MPC-3610

ショルダーアダプター 
VCT-FSA5

ビューファインダー 
DVF-L700 
（VFケーブル A-2201-632-A 
またはA-2201-633-Aが必要）

ビューファインダー 
DVF-EL200
（VFケーブルA-2203-
745-A（本機に付属）
または1-912-598-21
が必要）

マイクロホン 
ECM-680S、ECM-678、 
ECM-674（EC-
0.5X3F5Mが必要）

マイクホルダーベースASSY（A-2182-620-A） 
ロッドクランプ（A-2182-621-A） 
ロッド（4-684-612-01）
マイクホルダー ASSY（X-2596-733-2）
ネジ P2.6×8（2本）（7-627-556-98）

SxS メモリーカード 
SBP-64/128/256E、SBS-32/64/128G1C、SBP-240F/120F 
 
XQDメモリーカード 
（XQD ExpressCardアダプター QDA-EX1が必要） 
QD-G32E/G64E/G120F/G240F

SxSメモリーカードリーダー 
SBAC-US30/T40

AC アダプター 
AC-DN10A

AXS メモリーカードリーダー 
AXS-AR1

バッテリーパック 
BP-FL75、BP-GL95B

S35 PL レンズ 
SCL-PK6 
SCL-P11X15

アナモフィック 
ライセンス 
CBKZ-3610A 
CBKZ-3610AM 
CBKZ-3610AW

フルフレーム 
ライセンス 
CBKZ-3610F 
CBKZ-3610FM 
CBKZ-3610FW

アナモフィックレンズ
（PLマウント/Eマウント）

カメラエクステンション
システム
CBK-3610XS

フルフレームレンズ
（PLマウント/Eマウント）

Eマウントレンズ
SELP28135G、SEL1635GM、SEL2470GM、SEL70200GM、
SEL100400GM、SEL1224G、SEL35F14Z、SEL50F14Z、
SEL85F14GM、SEL90M28G、SEL100F28GM

ポータブルメモリー 
レコーダー 
AXS-R7

AXSメモリーカード 
AXS-A256S24、AXS-
A512S48、AXS-A512S24、
AXS-A1TS48、AXS-A1TS24

AXS メモリー 
カードリーダー 
AXS-AR1、AXS-CR1

リモートコントロールユニット
RM-B170/B750
RCP-1000/1500/1530
RCP-1001/1501

ハイフレームレート
ライセンス 
CBKZ-3610H 
CBKZ-3610HM 
CBKZ-3610HW
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各部の名称と働き
オペレーターサイド

4

678910111213

15

16

14

1 2 3

5

吸気口
SxSメモリーカード 
スロット部（9ページ）

1. ASSIGN 1/2（アサイナブル1/2）ボタン 
（43ページ）
ユーザー機能画面のEDITページで機能を割
り当てます（43ページ）。
押すたびに、割り当てられた機能のOn（有
効）とOff（無効）を切り換えたり、割り当て
られた機能を起動したりできます。

2. ASSIGN 1/2（アサイナブル1/2）ランプ 
（43ページ）
割り当てられた機能がOn（有効）または起動
している場合はオレンジ色に点灯し、Off（無
効）または停止している場合は消灯します。

3. ミニディスプレイITEMキー 1～ 3
ミニディスプレイで機能の操作を行います
（90ページ）。

4. ミニディスプレイ
シャッター開角度などの各種設定を確認・
変更できます（90ページ）。

5. ACCESSランプ SLOT(A)/(B)
SxSカードスロットA/Bの記録メディアが記
録、再生の対象となっているとき、および
SxSカードスロットA/Bの記録メディアに対
して書き込みや読み出しが行われていると
きに点灯します（24ページ）。

6. ネットワーク端子（RJ-45）
LANケーブル（別売り）を接続することで、
有線LAN接続により、本機をリモートコン
トロールできます（94ページ）。

7. CLIPSボタン
押すとミニディスプレイにクリップ画面が
表示され、クリップ操作を有効にします
（93ページ）。
同時にサブディスプレイにもクリップリス
ト画面が表示され、クリップ操作が可能に
なります。
再生状態から撮影モードにする場合は
HOMEボタンを押します。

8. 電源スイッチ
電源を入れるときはON（の位置）にします。
電源を切るときはOFF（の位置）にします。

 ［ご注意］

ˎˎ 本機は、電源スイッチをOFFにした状態でも、わ
ずかに待機電力を消費します。本機を長時間使用
しないときは、バッテリーパックを取り外してく
ださい。
ˎˎ バッテリーパックやDC IN電源は、電源スイッチを

OFFにしてから取り外してください。記録中やメ
モリーカードアクセス中に電源を遮断すると故障
の原因となることがあります。

9. HOMEボタン
押すとミニディスプレイ上のアイテム選択
表示はクリアされ、ホーム画面が表示され
ます。
本機が再生状態のときに押すと、記録操作
が可能な状態になります（90ページ）。

10. LOCKスイッチ
オペレーターサイドのボタン操作をロック
します。ロックするとスイッチ背面のLED
がオレンジ色に点灯します。

11. ヘッドホン端子（ステレオミニジャック）
音声モニター用のイヤホンを接続します。
撮像、記録中は収録音を、再生中は再生音
をモニターできます（89ページ）。

12. 内蔵スピーカー
撮像、記録中は収録音を、再生中は再生音
をモニターできます。警告ランプや警告表
示の点滅・点灯に合わせて警告音も聞こえ
ます（89ページ）。
なお、ヘッドホン端子にイヤホンをつなぐ
と、内蔵スピーカーからは音が聞こえなく
なります。

13. REC ACTIVEランプ
RECボタンが有効な状態のときに緑色に点
灯します。

14. ASSIGN 3（アサイナブル3）ランプ 
（43ページ）
割り当てられた機能がOn（有効）または起動
している場合はオレンジ色に点灯し、Off（無
効）または停止している場合は消灯します。

15. REC（記録開始／記録停止）ボタン／ランプ
押すと記録が始まりRECランプが点灯し、も
う一度押すと記録が停止し、RECランプが
消灯します（99ページ）。
また、機器のエラーやワーニングをRECラ
ンプを点滅させて表示します。

16. Φマーク
Φマークがイメージセンサー面の位置にな
ります。
本機から被写体までの距離を正確に測るに
は、このマークの位置を参考にしてください。
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SxSメモリーカードスロット部 
（24ページ）

SxSメモリーカードスロットはカバー内にあり
ます。

1

3

2

1. SxSメモリーカードスロットA/B

2. 製造調整用端子
製造調整、サービス専用端子です。 
(使用できません)

3. SLOT SELECT（SxSメモリーカード選択）ボ
タン
ボタンを押すことで、アクティブなスロッ
トを切り換えることができます。

アシスタントサイド

1 2 3 4

6

5

7

8

9

1011
12

13
14

15
16

17

18
1 2 3

4 5 6

1. ASSIGN 4（アサイナブル4）ボタン 
（43ページ）
ユーザー機能画面のEDITページで機能を割
り当てます（43ページ）。
押すたびに、割り当てられた機能のOn（有
効）とOff（無効）を切り換えたり、割り当て
られた機能を起動したりできます。

2. ASSIGN 4（アサイナブル4）ランプ 
（43ページ）
割り当てられた機能がOn（有効）または起動
している場合はオレンジ色に点灯し、Off（無
効）または停止している場合は消灯します。

3. サブディスプレイ
本機の動作状態の確認や各種設定ができま
す（33ページ）。
ホーム画面が表示されている状態でBACKボ
タン（10ページ）を押しながらSEL/SETダ
イヤルを回すことで、サブディスプレイと
ミニディスプレイの明るさを調整すること
ができます。
フルメニューのTechnical > Control 
Display > Brightness levelでも調整できま
す（84ページ）。

4. サブディスプレイITEMキー 1～ 6
サブディスプレイで機能の操作を行います
（48ページ）。

5. メジャーフック
メジャーフックがイメージセンサー面の位
置となります。本機から被写体までの距離
を正確に測るには、メジャーフックの位置
を参考にしてください。メジャーフックに
メジャーの先端をかけて、被写体からの距
離を実測できます。

6. HOMEボタン
押すとサブディスプレイ上の表示はクリアさ
れ、ホーム画面が表示されます（35ページ）。
本機が再生状態のときに押すと、記録操作
が可能な状態になります。

7. MENU（メニュー表示ON/OFF）ボタン
（48、60ページ）
MENUボタンを押すと、サブディスプレイ
にメニュー画面が表示されます。MENUボ
タンを2秒以上押し続けると、フルメニュー
画面がサブディスプレイに表示されます。
メニュー画面、フルメニュー画面のときに
押すと元の画面に戻ります。

8. SEL/SET（選択／確定）ダイヤル（MENUダ
イヤル）
各メニュー内の項目選択や設定値の変更をす
るときに使います（35、48、60ページ）。

9. +48V Powerランプ
AUDIO INスイッチをMICに設定した場合
に、AUDIO IN端子への+48Vファントム電
源を供給しているときは、緑に点灯します。
供給していないときは消灯します。
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+48Vファントム電源の重畳のOn/Offは、メ
ニューのAudioカテゴリー > Audio Details 
> Audio Configuration > Phantom 
Power +48Vで設定できます（78ページ）。

10. AUDIO IN（オーディオ入力切り換え）スイッチ
AUDIO IN端子に入力される音声の音源に合
わせて入力信号を切り換えます。
LINE：外部のアナログオーディオ信号源を
接続する場合 

AES/EBU：外部のデジタルオーディオ信号
源を接続する場合

MIC：マイクを接続する場合

11. AUDIO IN端子（XLR 5ピン）
外部マイクや外部オーディオ機器などの信
号を入力します。
AUDIO INスイッチで音源をLINEまたはMIC
に設定しているときは、AUDIO IN CH-1端
子、およびAUDIO IN CH-2端子として機能
します。
AUDIO INスイッチで音源をAES/EBUに設
定しているときは、AUDIO IN CH-1/2端子、
およびAUDIO IN CH-3/4端子として機能し
ます。

12. BACKボタン
メニュー表示中は、メニューのキャンセルや
メニュー階層を1つ上に戻します。実行中表
示または実行指示待ち表示のときは、実行中
または実行指示待ち表示中の処理をキャンセ
ルします（35、48、60ページ）。

13. LOCKスイッチ
アシスタントサイドのボタン操作をロック
します。ロックするとスイッチ背面のLED
がオレンジ色に点灯します。

14. ACCESS（SDカードアクセス）ランプ（27
ページ）

15. REC ACTIVEランプ
RECボタンが有効な状態のときに緑色に点
灯します。

16. REC（記録開始／記録停止）ボタン／ランプ
押すと記録が始まりRECランプが点灯し、も
う一度押すと記録が停止し、RECランプが
消灯します（99ページ）。
また、機器のエラーやワーニングをRECラ
ンプを点滅させて表示します。

17. CLIPSボタン
押すとサブディスプレイにクリップリスト
画面が表示され、クリップ操作を有効にし
ます（87ページ）。
同時にミニディスプレイにもクリップ画面
が表示されます。
再生状態から撮影モードにする場合は
HOMEボタンを押します。

18. USERボタン
押すとサブディスプレイにユーザー機能リ
ストが表示され、ITEMキー 1～ 5がユーザー
機能ボタンとなります。
ITEMキー 6はユーザー機能リストのEDITボ
タンです。このボタンを押すと、ユーザー
機能ボタンとアサイナブルボタンの機能選
択画面が表示されます。ユーザー機能画面
状態で押すと元の画面に戻ります。（43
ページ）。

フロント（前面）

1

23

4

5

1. ASSIGN 3（アサイナブル3）ボタン 
（43ページ）
ユーザー機能画面のEDITページで機能を割
り当てます（43ページ）。
押すたびに、割り当てられた機能のOn（有
効）とOff（無効）を切り換えたり、割り当て
られた機能を起動したりできます。

2. PLレンズマウントアダプター（19ページ）

3. VF（ビューファインダー出力）端子（22
ページ）

4. LENS（レンズ接続用）端子（12ピン）
ファームウェアバージョン4.0からネット
ワーク接続されたコンピューターやスマー
トフォン、タブレットよりアイリス、フォー
カスおよびズーム制御が可能です。

5. 24V OUT端子（DC OUT 24V、Fischer 3
ピン）
24V DC電源出力用端子です（113ページ）。
本機に入力する電圧によって、この端子か
ら出力する電圧と出力最大電流が異なりま
す。最大電流は、本機リア（後面）の24V 
OUT端子（11ページ）との合計となりま
す。

11 V～ 17 V入力時
出力電圧：24 V
出力最大電流：1.0 A

22 V～ 32 V入力時
出力電圧：入力電圧と同じ
出力最大電流：2.0 A
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リア（後面）

2
1

3
4
5
6

7

8

9

10
11
12
13

1. 24V OUT端子（DC OUT 24V、Fischer 3
ピン）
24V DC電源出力用端子です（113ページ）。
本機に入力する電圧によって、この端子か
ら出力する電圧と出力最大電流が異なりま
す。最大電流は、本機フロント（前面）の
24V OUT端子（10ページ）との合計とな
ります。

11 V～ 17 V入力時
出力電圧：24 V
出力最大電流：1.0 A

22 V～ 32 V入力時
出力電圧：入力電圧と同じ
出力最大電流：2.0 A

2. 12V OUT端子（DC OUT 12V、Hirose 4ピン）
12V DC電源出力用端子です（113ページ）。
本機に入力する電圧によって、この端子から
出力する電圧と出力最大電流が異なります。

11 V～ 17 V入力時
出力電圧：入力電圧と同じ
出力最大電流：1.0 A

22 V～ 32 V入力時
出力電圧：15 V
出力最大電流：0.8 A

3. MONITOR OUT端子（BNC型）
HD SDIモニター信号を出力する端子です
（113ページ）。

4. GENLOCK（ゲンロック入力）端子（BNC型）
外部から本機にゲンロックをかけるとき、
または本機のタイムコードを外部ロックさ
せるとき、基準信号を入力する端子です。
デジタル信号とアナログ信号を入力できま
す。
デジタル信号：1.5G HDSDI interlace信号
アナログ信号：HD sync、Analog

5. TC IN(タイムコード入力)端子（BNC型）
本機のタイムコードを外部ロックさせると
き、基準となるタイムコード信号を入力す
る端子です。

6. AUX端子（LEMO 5ピン）
タイムコード信号を出力する端子です
（114ページ）。

7. REMOTE（リモートコントロール）端子 
（8ピン）
リモートコントロールユニットなどの外部
コントロール機器を接続します。

8. 12V/24V （DC電源入力）端子（16ページ）
本機に外部電源を供給するためのDC電源入
力端子です。入力電圧は12Vと24Vに対応し
ています。

No. 信号
1 GND
2 NC
3 NC
4 DC IN（11V～ 17V または 22V～

32V）

9. バッテリー取り付け端子（16ページ）

10. SDI OUT 1～ 4（シリアルデジタル出力）端
子（BNC型）（113ページ）

11. バッテリーパック取り付け部（16ページ）

12. バッテリーリリースレバー（16ページ）

13. HDMI OUT端子（113ページ）
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トップ（上面）

1 2 3 4

1. 外部機器接続端子
本機にAXSレコーダー AXS-R7（別売り）を
取り付けた状態でAXS-R7をバージョンアッ
プする（31ページ）、またはワイヤレス
LANアダプター CBK-WA02（別売り）を接続
することで、カメラワイヤレスリモートコ
ントロールする（94ページ）際に使用しま
す。

2. リリースボタン（18ページ）

3. ハンドル/VFアタッチメント取り付け部
（18ページ）

4. アクセサリー取り付けねじ穴
ネジ種：1/4-20UNC（×8）
ネジ種：3/8-16UNC（×10）
ネジ勘合長：10 mm 以下

ボトム（底面）

3

1 2

排気口

1. 三脚プレート取り付け穴
ネジ種：1/4-20UNC（×2）
ネジ種：3/8-16UNC（×4）
ネジ勘合長：9 mm 以下

2. ボトムカバー
六角ネジ（4本）を外してカバーを取り外す
ことができます。

3. SDカードスロット（27ページ）
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ビューファインダー・モニター画面

撮影中（記録中／記録待機中）および再生中は、Monitoringメニュー > OSD AppearanceのStatus 
Info A/B Setup（73ページ）で選択された情報が表示されます。

撮影中の画像に表示される情報

29

1 2 3 64 5 7 9

22232425262728

10

8

11

14
15
16
17
18
19
21

12 13

20

33
35
36

34

30
31
32

37

1. 撮影フレームレート設定表示
撮影フレームレートとプロジェクトフレー
ムレートが表示されます。

2. シャッター開角度／スピード表示
メニューのTechnicalカテゴリー > System 
Configurationの設定に従って、電子シャッ
ターの開角度またはスピードが表示されま
す。

3. NDフィルター表示
NDフィルターの濃度が表示されます。表示
値はLOG指標値です。（61ページ）。

CLEAR

0.3（1/2）
0.6（1/4）
0.9（1/8）
1.2（1/16）
1.5（1/32）
1.8（1/64）
2.1（1/128）
2.4（1/256）

4. 温度計アイコン
温度上昇に関する警告メッセージがあると
きに表示されます。

メニューのInfoカテゴリーに内容が表示さ
れます。

5. 警告アイコン
温度上昇を除く警告メッセージがあるとき
に表示されます。
メニューのInfoカテゴリーに内容が表示さ
れます。

6. 感度（Exposure Index）／ゲイン表示
EI値またはRM-B170などのリモートコント
ロールユニットで設定したゲイン値（dB単
位）が表示されます。

［ご注意］
ゲイン値は、Technicalメニュー > System 
Configuration > RM/RCP Paint Control（81ペー
ジ）がOnに設定されている場合のみ表示されます。

7. 色温度表示
ホワイトバランスの色温度とTint値が表示
されます。

8. Look情報表示
選択したLookが表示されます（65ページ）。

9. バッテリー残量／電圧表示
本機を駆動している電源の種類に応じて次
のように表示されます。

電源の種類 表示

インフォバッ
テリー

バッテリー残量と記録可能
な残り時間

アントンバウ
アー社製バッ
テリー

バッテリー残量（%表示）

その他の電源 入力電圧

10. VF LUT表示
ビューファインダーのLUTが表示されます
（64ページ）。

11. VF Double Speed Scan表示
ビューファインダー表示のフレームレート
を倍速にする機能の有効／無効状態が表示
されます。

12. VF Peaking表示
ビューファインダー表示のピーキング機能
の有効／無効状態が表示されます。

13. VF Zebra表示
ビューファインダー表示のゼブラ機能の有
効／無効状態が表示されます（45ペー
ジ）。

14. SDI OUT 1/2端子 LUT表示
SDI OUT 1/2端子のLUT設定が表示されます
（62ページ）。

15. SDI OUT 3/4端子 LUT表示
SDI OUT 3/4端子のLUT設定が表示されます
（62ページ）。

16. Monitor LUT表示
Monitor出力のLUT設定が表示されます
（63ページ）。

17. HDMI LUT表示
HDMI出力のLUT設定が表示されます（63
ページ）。
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18. SDI出力RECトリガー表示
SDI出力のRECトリガーの状態が表示されます。

条件 表示
フルメニューのTechnical > System Configuration >  
SDI Rec Remote Trigger

SDI出力への 
記録コマンドの重畳

Off － （空欄）
HD SDI Remote I/F Stopコマンド送信 上段：SDI

下段：Stop
Recコマンド送信 上段：SDI

下段：REC
Parallel Rec Stopコマンド送信 上段：SDI-P

下段：Stop
Recコマンド送信 上段：SDI-P

下段：REC

19. ネットワーク接続状態表示
ネットワークの接続状態（LANまたはWi-Fi）
が表示されます。

条件 表示
ネットワーク接続設定状態で接続断
などのエラー時

点滅

ネットワーク接続設定状態で接続時 点灯
ネットワーク接続機能を使用してい
ない

空欄

20. High Key/Low Key表示（Monitor出力）
Monitor出力がHigh Key（高輝度の白飛
び確認画面）、またはLow Key（低輝度の
暗部の確認画面）であることを表示します
（Monitor Out出力の場合に表示）。

21. オーディオレベルメーター表示
撮影中の音声チャンネル1、2のレベルが表
示されます。

22. 各メディアスロットの記録メディア状態／
残量表示
SxSメモリーカードスロットA/BおよびAXS

メモリーカードスロットA/B内のメディアの
状態と残量が表示されます。
AXSまたはSxSの左に  がある：記録対象メ
ディア
AXSまたはSxSの右のスロットA/Bアイコン
右上の緑ランプ点灯時 ：再生対象メディ
ア（ランプが点灯している方のメディアを再
生）
また、記録に影響のあるメディアに対して
は アイコンが表示されます。

23. 水準器グラフィカル表示
本機の水平方向の傾きが±0.1°刻みで±10°
まで表示されます。
Technicalメニュー > Special 
Configuration > Level Gauge Adjust
（82ページ）を実行すると、水準器のゼロ
調整を行うことができます。

24. 記録メディアフォーマット（コーデック）表示
AXSメモリーカード、SxSメモリーカードに
記録されるフォーマット名称が表示されま
す。

25. 記録動作状態表示
本機の記録動作状態が次のように表示され
ます。

表示 説明

● Rec 記録中

 Stby 記録待機中

● Cache ピクチャーキャッシュ
レック記録待機中

26. クリップ名表示
記録待機中は、次に記録されるクリップに
付けられるクリップ名の前8文字が表示され
ます。
記録中は、記録中のクリップに付けられる
クリップ名の前8文字が表示されます。

27. High Key/Low Key表示（ビューファイン
ダー出力）
ビューファインダー出力がHigh Key（高輝
度の白飛び確認画面）、またはLow Key（低
輝度の暗部の確認画面）であることを表示し
ます（ビューファインダー出力の場合に表
示）。

28. タイムデータ表示
メニューのTC/Mediaカテゴリー > TC 
Displayの設定に従って、デュレーション
またはタイムコードが表示されます（49
ページ）。

29. アイリスポジション表示
アイリスの位置が表示されます。（アイリス
設定表示対応レンズ装着時のみ） 
Eマウントレンズ使用時のアイリス表示値は
1/3stop刻みとなります。

［ご注意］
T値が取得できない場合など、T値ではなくF値が表示
される場合があります。

30. フォーカスポジション表示
フォーカスの位置を表示します。（フォーカ
ス設定表示対応レンズ装着時のみ）

31. ズームポジション表示
ズームの焦点距離が表示されます。（ズーム
設定表示対応レンズ装着時のみ）

32. 水準器表示
水準器の情報が数値で表示されます。
R（Roll）は本機の水平方向の傾きです。
T（Tilt）は本機の上下方向の傾きです。
Technicalメニュー > Special 
Configuration > Level Gauge Adjust
（82ページ）を実行すると、水準器のゼロ
調整を行うことができます。

33. 同時記録状態表示
1スロット同時記録時のサブクリップ記録
フォーマットが表示されます。（100ペー
ジ）。

34. SxS Sub LUT表示
SxS 1スロット同時記録時のサブクリップに
記録するLUT設定が表示されます。

35. SxS LUT表示
SxS記録のLUT設定が表示されます。
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36. Base ISO表示
設定された基準感度が表示されます。

37. 有効画サイズ表示
メニューのProjectカテゴリー > Imager 
Modeの設定に従って、有効撮像画サイ
ズとデアナモ変換の有無が表示されます。
Surround Viewモードの場合は、デアナモ
変換倍率アイコンの下にSur.Vアイコンが表
示されます（49ページ）。

ビューファインダー画面のメニュー
表示と設定

本機にDVF-EL200が装着されている場合、DVF-
EL200のMenuボタンを長押しすると、ビュー
ファインダー画面にMonitoringメニューのVF 
Display（77ページ）とVF Function（77
ページ）の設定メニューが表示されます。ビュー
ファインダー画面を見ながら、これらの機能を
設定できます。

再生中の画像に表示される情報

再生画像には、次の情報が表示されます。

98

54321

6
7

1. タイムデータ表示
メニューのTC/Mediaカテゴリー > TC 
Displayの設定に従って、デュレーション
またはタイムコードが表示されます（49
ページ）。

2. 再生クリップ名表示
再生画像のクリップ名の前8文字が表示され
ます。

3. 再生動作状態表示
再生動作の状態が表示されます。

4. 再生メディアフォーマット（コーデック）表
示
再生中のクリップの記録フォーマット（コー
デック）が表示されます。

5. 再生メディア表示
再生中の記録メディアが表示されます。
メモリーカードがプロテクトされている場
合は、右に  マークが表示されます。

6. オーディオレベルメーター表示
再生中の音声チャンネル1、2のレベルが表
示されます。

7. ネットワーク接続状態表示
ネットワークの接続状態（LANまたはWi-Fi）
が表示されます。

条件 表示
ネットワーク接続設定状態で接続断
などのエラー時

点滅

ネットワーク接続設定状態で接続時 点灯
ネットワーク接続機能を使用してい
ない

空欄

8. 温度計アイコン
温度上昇に関する警告メッセージがあると
きに表示されます。
メニューのInfoカテゴリーに内容が表示さ
れます。

9. 警告アイコン
温度上昇を除く警告メッセージがあるとき
に表示されます。
メニューのInfoカテゴリーに内容が表示さ
れます。
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電源の準備
バッテリーパック、またはACアダプターを介し
てAC電源を使用できます。
安全のため、下記ソニー純正以外のバッテリー
を使用しないでください。

リチウムイオンバッテリーパック
BP-FL75
BP-GL95B

ACアダプター
AC-DN10A

バッテリーパックを使用す
る

バッテリーパックをバッテリーパック取り付け
部（11ページ）に差し込んで、下にスライド
させてロックします。
取り外すときは、バッテリーリリースレバー
（11ページ）を押しながらバッテリーパック
を上にスライドさせてロックを外し、取り外し
ます。

［ご注意］

ˎˎ 装着する前に、バッテリーチャージャーを使用して充
電してください。
ˎˎ 使用直後でバッテリーパックの温度が上昇した状態で
充電すると、完全に充電されないことがあります。
ˎˎ バッテリーアダプターを取り外す際は、必ず手で支え
ながら外してください。

残量を確認する

バッテリーパックを使用して撮影・再生してい
るときは、サブディスプレイ画面（33ペー
ジ）およびビューファインダー・モニター画面
（13ページ）にバッテリー残時間またはバッ
テリー電圧が表示されます。
残り時間は、現在の消費電流のペースで本機を
継続使用した場合のバッテリーパックの使用可
能時間を計算して分単位で表示されます。

バッテリーパックの容量が低下する
と

使用中にバッテリーパックの容量が一定の値ま
で低下すると、バッテリー残量表示が点滅し、
RECランプの点滅で警告します。
さらに容量が減り、動作が継続不可能な状態に
なると、バッテリーパックの残りがないことを
知らせるメッセージが表示されます。
充電されたバッテリーパックに交換してくださ
い。

警告残量を変更する

フルメニューのTechnical > Battery（84
ページ）で変更します。

AC電源を使用する（DC IN
電源） 

本機はACアダプター AC-DN2B（別売り）、 
AC-DN10A（別売り）およびDCケーブル
CCDD-X2（別売り）を使用することによって、
AC電源に接続して動作させることができます。
入力電圧範囲は11 V～ 17 Vと22 V～ 32 Vに対
応しています。

［ご注意］

ˎˎ バッテリー運用時にDC IN電源へ切り換える際には、 
12 V～ 17 Ｖの電圧の電源を使用してください。
ˎˎ 22 V～ 32 V電圧を使用する場合は、本機の電源スイッ
チをOFFの状態で電源接続（給電）してください。
ˎˎ 11 V～ 17 V電圧使用状態から22 V～ 32 V電圧使用状
態に直接切り換える、またはその逆の状態に直接切り
換えることはしないでください。故障の原因となりま
す。

バッテリーパックとDC IN 
電源の併用について

バッテリーパックおよびDC IN電源がどちらも
給電可能な電圧の場合は、DC IN電源側から優
先的に給電状態となります。

[ご注意]
バッテリー運用時にDC IN電源からの給電状態に切り換え
ると、以下の要因等により本機の動作が停止する場合があ
りますのでご注意ください。
ˎˎ DCコネクター挿抜時のコネクター部のチャタリング
（コネクターこじり等）
ˎˎ 電源供給元が切り換わったときの電圧ドロップ（外部負
荷状態が重いほど大きい）
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時計を合わせる
本機を初めて使用するとき、電源を入れるとサ
ブディスプレイ画面に初回設定画面が表示され
ます。
この画面を使用して内蔵時計の日付／時刻を設
定してください。

Time Zone について

UTC（協定世界時）からの時差を設定します。必
要に応じて変更してください。

[ご注意]
Time Zoneを変更すると時差に合わせて時刻設定が変更
されます。

日付/時刻を設定する

MENUダイヤル（9ページ）を回して項目や
数値を選び、MENUダイヤルを押して決定しま
す。最後にカーソルをSetに合わせてMENUダ
イヤルを押すと、設定画面が消えて時計合わせ
が完了します。
初回設定画面が消えた後は、フルメニューの
Maintenance > Clock Set（85ページ）を使
用してTime Zoneおよび日時の設定を変更でき
ます。

［ご注意］

ˎˎ 動作電源が供給されていない（バッテリーパックもDC 
IN電源も接続されていない）状態でバックアップ電池
が消耗するなどして現在日時の情報が失われた場合は、
次に電源を入れると初回設定画面が表示されます。
ˎˎ 初回設定画面が表示されている状態では、この画面で
の設定が完了するまで電源を切る以外の操作はできま
せん。
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VFアタッチメントを取り
付ける

1	 VFアタッチメントを矢印の方向にスライド
させて取り付ける。

2	 VFアタッチメントの前後位置を決め、ロッ
クレバーを回して締める。

1

2

ロック
レバー

 ［ご注意］

ˎˎ VFアタッチメントを前後逆および左右方向に取り
付けることもできます。
ˎˎ ロックレバーが締めにくい場合や緩む場合は、
ロックレバー上にあるロックネジを六角レンチ
（3 mm）で回して固定することができます。

VFアタッチメントを取り外すには

ロックレバーを回して緩め、リリースボタンを
押してVFアタッチメントを取り付けたときと逆
の方向にスライドさせて抜き取ります。

ハンドルを取り付ける

1	ハンドルを矢印の方向にスライドさせて取
り付ける。

2	ハンドルの前後位置を決め、ロックレバー
を回して締める。

2

1

ロックネジ

六角穴付き
ボルト

ロック
レバー

 ［ご注意］

ˎˎ 六角レンチ（5 mm）でロックネジを回して固定す
ることもできます。
ˎˎ 使用時にハンドルのロックレバーが緩む場合は、
ロックネジの隣にある六角穴付きボルト（2 mm）
を締めると緩まなくすることができます。
ˎˎ ハンドルを前後逆方向に取り付けることもできま
す。

ハンドルを取り外すには

ロックレバーを回して緩め、リリースボタンを
押してハンドルを取り付けたときと逆の方向に
スライドさせて抜き取ります。

VFアタッチメントとハンドルの取り付け
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推奨PLマウントレンズ（Super 35mm
サイズ用）
SCL-PK6/F、SCL-PK6/M（6本セット、
20 mm/25 mm/35 mm/50 mm/85 mm/ 
135 mm）
SCL-PK3/F、SCL-PK3/M（3本セット、
20 mm/25 mm/135 mm）
SCL-P11X15

推奨Eマウントレンズ
SELP28135G、SEL1635GM、
SEL2470GM、SEL70200GM、
SEL100400GM、SEL1224G、
SEL35F14Z、SEL50F14Z、SEL85F14GM、
SEL90M28G、SEL100F28GM

［ご注意］
一部のEマウントレンズでは制御できない場合があります。
推奨レンズをご使用ください。

 ˜ 本機で使用できるレンズについて詳しくは、ソニーの
サービス窓口にご相談ください。

レンズを太陽に向けて放置しないでください。
太陽光がレンズを通して機器内部に焦点を結び、
火災の原因となることがあります。

［ご注意］

ˎˎ レンズおよびアダプターの取り付け／取り外しは、本
機の電源を切った状態で行ってください。
ˎˎ レンズは精密部品です。レンズは、マウント部側を下
にして直に置かないでください。必ず付属のキャップ
をかぶせてください。
ˎˎ 本機のレンズインターフェースは、工場出荷時にSCL-

P11X15およびCooke型コネクター付きレンズ用に
合わせて設定されています。SCL-PK6、SCL-PK3や
それ以外のCooke型コネクターを持たないレンズを
使用する場合は、フルメニュー > Technical > Lens 
Configuration > PL-Mt Interface Position（82ペー

ジ）をOffに設定します。インターフェースが正しく設
定されていないと、レンズを取り付け後に電源を入れ
ると警告メッセージが表示されます。

PLマウントレンズを取り
付ける

1	 PLマウントレバーを反時計方向に回して、
レンズマウントからマウントキャップを外
す。

PLマウント
レバー

 ［ご注意］
PLマウントレバーを反時計回りにストッパーの位置
まで回してください。

2	レンズマウント上面右の位置決めピンに、
レンズの凹部を合わせ、レンズをマウント
に差し込む。

3	レンズを支えながら、PLマウントレバーを
時計方向に回して、レンズを固定する。

 ［ご注意］
PLレンズを装着の際は、レンズを回さないでくださ
い。レンズを回すと、ホットシューピン折れの原因と
なります。

Cooke /i レンズを取り付けるには

レンズ側のコンタクトと本機側のホットシュー
の位置を合わせてください。レンズアダプター
側のコネクターは2か所ありますが、どちらも
使用できます。

レンズを取り外すには

1	レンズを下から支えて、PLマウントレバー
を反時計方向に回す。

2	レンズを前方に引き抜く。
 ［ご注意］

別のレンズをすぐに取り付けないときは、マウント
キャップの凹部を確実に合わせて、PLマウントレバー
を時計方向に回して固定してください。

フランジバックを調整する

本機はフランジバックを調整した状態で出荷し
ています。フランジバックの調整を行いたい場
合は、レンズマウントを取り外し、シムを適切
な厚みのものと交換してください。0.01 mm
単位で±0.1 mmの調整ができます。

シムについて

本機には以下のシムが同梱されています
0.05 mm ×1（円弧型）
0.01 mm ×15（1/3円弧型）
1/3円弧型シムは3枚組でご使用ください。フ
ランジバックを長く調整する場合は、シムを挿
入してください。本機は出荷時に以下の3種類
のシムによってフランジバックを調整した状態
で出荷しています。
0.10 mm（円弧型）
0.05 mm（円弧型）
0.01 mm（1/3円弧型）
また、出荷時のシム厚みを示すシールが貼られ
ています。

レンズの取り付けとフランジバックの調整
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フランジバックの調整

1	トルクスネジ（6本）を外してPLマウントフ
ランジを取り外す。

1

PLマウントフランジ

2	 PLコネクター（2か所）の両側の十字ネジ 
（4本）を緩めてPLコネクターとPLコネク
ター台を取り外す。

3	 PLマウントアダプター（3か所）にシムを取
り付ける。

33

33
33

22
22

PLコネクター

PLコネクター台

1/3円弧型のシムを使用する場合
3か所とも同じ厚みになるようにシムを取り
付けます。

シム

円弧型のシムを使用する場合
刻印がある面を表にして取り付けます。

刻印

刻印

4	 PLコネクター（2か所）を元の位置に戻し、
締め付けトルク0.18N・mで十字ネジ（4本）
を締め付ける。

5	 PLマウントフランジを元の位置に戻し、ト
ルクスレンチ T8を使用して、締め付けトル
ク0.35N・mでトルクスネジ（6本）を締め
付ける。

フィルターのお手入れにつ
いて

フィルターを掃除するときは、アダプターを外
して拭いてください。アダプター中央部（網掛
け部）をクロスなどで拭くと、繊維が付着する
場合がありますので注意してください。繊維が
付着した場合は、ソフトブラシで掃除してくだ
さい。

アダプター
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PLレンズアダプターを取
り外す

本機にEマウントレンズを取り付ける場合、PL
レンズアダプターを取り外します。取り付け／
取り外しは、本機後面を下にした状態で行いま
す。
六角ネジ（2.5 mm、6本）を外してPLレンズア
ダプターを取り外します。

PLレンズアダ
プター

［ご注意］

ˎˎ バッテリーを取り付けて本機後面を下にして置くと、
安定した状態で作業できます。
ˎˎ 取り付け／取り外し作業時、本機とPLレンズアダプター
の端子接点に触れないようにご注意ください。

PLレンズアダプターを取り付けるに
は

1	マウントレバーがロック位置になっている
ことを確認する。

マウントレバー

2	 PLレンズアダプターを元の位置に戻し、六
角レンチ（2.5 mm）を使用して、締め
付けトルク0.8±0.12N・mで六角ネジ
（2.5 mm、6本）を締め付ける。

Eマウントレンズを取り付
ける

1	 PLレンズアダプターを取り外す（21ペー
ジ）。

2	ロックスイッチを上方向に押してから、マ
ウントレバーを時計方向に回してロックを
解除する。

マウントレバー

ロックスイッチ

3	本体とレンズのマウント標点（白色）を合わ
せ、レンズをマウントに差し込む。

4	レンズを支えながら、マウントレバーを反
時計方向に回して、レンズを固定する。

 

マウント標点（白色）

［ご注意］
Eマウントレンズ接続時は、12pinレンズコネクターの動
作は保証できません

レンズを取り外すには

1	ロックスイッチを上方向に押してから、マ
ウントレバーを時計方向に回してロックを
解除する。

2	レンズを前方に引き抜く。
 ［ご注意］

別のレンズをすぐに取り付けないときは、マウント
キャップの凹部を確実に合わせて、マウントレバーを
反時計方向に回して固定してください。
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ビューファインダーの取り付け
本機で使用できるビューファインダー
DVF-EL200：OLEDカラービューファインダー
DVF-L700：LCDカラービューファインダー

ビューファインダーは別売りです。
ここではDVF-EL200を取り付ける場合を例に
示します。

 ˜ 各ビューファインダーの取り扱いについて詳しくは、
使用するビューファインダーの取扱説明書をご覧くだ
さい。

接眼レンズを太陽に向けて放置しないでくださ
い。太陽光が接眼レンズを通してビューファイ
ンダー内部に焦点を結び、火災の原因となるこ
とがあります。

［ご注意］

ˎˎ ビューファインダーの取り付け／取り外しは、本機の
電源を切った状態で行ってください。
ˎˎ DVF-L700を取り付ける場合は、VFケ-ブル（A-2201-

632-AまたはA-2201-633-A）が必要です。また、
DVF-L700側のPOWER（電源）スイッチをONにした状
態で本機の電源を入れてください。

ビューファインダーを取り
付ける

1	 VFアタッチメントのビューファインダー
取り付け部の溝に、ビューファインダーの
シューを合わせて取り付ける。

2	ビューファインダーのロックレバーをLOCK
方向に回して固定する。

2

1

ロックレバー

3	ビューファインダーと本機をVF接続ケーブ
ルで接続する。
ビューファインダー側：
コネクターの標点（赤色）を上側にして、奥
まで差し込んでください。
本機側：
コネクターの標点（赤色）とVF端子の凹部を
合わせて、奥まで差し込んでください。

クランパー

 ［ご注意］
必要に応じて、クランパーでケーブルを固定してくだ
さい。

ビューファインダーを取り外すには

1	ビューファインダーと本機からVF接続ケー
ブルを引き抜く。

2	ロックレバーをLOCKと反対方向に回して
ロックを解除し、ビューファインダーをVF
アタッチメントから取り外す。

位置を調整する

前後の位置を調整するには

1	 VFアタッチメントの前後のロッドロックレ
バーを両方、またはどちらか一方を緩める。

2	 VFアタッチメントを前後にスライドさせて、
ビューファインダーの位置を調整する。

11
11

22

ロッドロック
レバー

3	ロッドロックレバーを締める。
 ［ご注意］

ロッドロックレバーが回しにくい場合は、レバーを引
き出してから操作しやすい位置まで回転させ、押して
もとに戻してください。
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左右の位置と高さ（角度）を調整する
には

1	 VFアタッチメントの前面のロッドロックレ
バーを緩める。

2	 VFアタッチメントのロッドを左右にスライ
ドさせたり、上下に回して、ビューファイ
ンダーの位置を調整する。

11

22
22

ロックネジ

ロッドロック
レバー

3	ロッドロックレバーを締める。
 ［ご注意］

ロッドロックレバーを緩めたときにビューファイン
ダーが下に回ってしまう場合は、6角レンチ（3 mm）
でロックネジを調節してください。

角度を調整するには

主に撮影中にビューファインダーの角度を調整
します。

1	ビューファインダー取り付け部の回転ロッ
クレバーを緩める。

2	ビューファインダーを上下に回して角度を
調整する。

11

22

回転ロックレバー

3	回転ロックレバーを締める。
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本機では、撮影した映像・音声を、カードスロッ
ト内のSxSメモリーカード（別売り）に記録します。

SxSメモリーカードについ
て

本機では、下記のソニー製SxSメモリーカード
およびXQDメモリーカード*をご使用ください。
* XQDメモリーカードを使用する際にはXQD 

ExpressCardアダプター（QDA-EX1）が必要です。

記録フォーマットによって使用可能なメモリー
カードが異なります。

SxS PROX
SBP-240F/120F：すべての記録フォーマットで
使用可能

SxS PRO+
SBP-256D/E、SBP-128B/C/D/E、SBP-64B/
C/D/E：すべての記録フォーマットで使用可能

SxS PRO
SBP-64A、SBP-32： 
MPEG 1920x1080i、HD ProRes 422、 
HD ProRes 422 Proxy

SxS-1
SBS-128G1B/C、SBS-64G1A/B/C、 
SBS-32G1A/B/C：
MPEG 1920x1080i、HD ProRes 422、 
HD ProRes 422 Proxy

XQDメモリーカード Sシリーズ、Gシ
リーズ
QD-S64E、QD-S32E、QD-G128A/E、 
QD-G64A/E、QD-G32A/E、QD- G120F、
QD-G240F：すべての記録フォーマットで使
用可能

XQDメモリーカード Nシリーズ、Mシ
リーズ
QD-N64、QD-M128A、QD-M64A、 
QD-M32A： 
MPEG 1920x1080i、HD ProRes 422 Proxy

ソニー製SxSメモリーカードおよびソニー製
XQDメモリーカード以外のメモリーカードをご
使用の場合、動作の保証はいたしかねます。
これらのカードは、ExpressCard規格に準拠し
たメモリーカードです。

 ˜ SxSメモリーカードの使いかたや使用上のご注意につ
いて詳しくは、SxSメモリーカードの取扱説明書をご
覧ください。

ˎˎ SxS、SxS PRO、およびSxS-1はソニー株式会
社の商標です。

ˎˎ XQDはソニー株式会社の商標です。
ˎˎ ExpressCardワードマークとロゴは、
Personal Computer Memory Card 
International Association (PCMCIA) の所有
であり、ソニーへライセンスされています。

ˎˎ ProResは米国アップルコンピュータ社の登録
商標です。
他のトレードマークおよびトレード名称につい
ては、個々の所有者に帰属します。

SxSメモリーカードを入れ
る

1	カードスロット部（9ページ）のカバー
を開ける。

2	 SxSメモリーカードを、SxSのラベルを右に
してカードスロットに差し込む。
ACCESSランプ（8ページ）が赤く点灯
し、使用可能な状態になると緑で点灯しま
す。

3	カバーを閉める。
ACCESSランプによる状態表示

AとBのカードスロットの状態を示すために、そ
れぞれにACCESSランプがあります。

ランプ スロットの状態
赤で点灯 装着されているSxSメモリー

カードにアクセス中（データの
書き込み／読み出し中）

緑で点灯 スタンバイ状態（装着されてい
るSxSメモリーカードを使用し
て記録・再生を行います。）

消灯 ˎˎ SxSメモリーカードが装着さ
れていない。 
ˎˎ 使用できないカードが装着
されている。 
ˎˎ SxSメモリーカードは装着さ
れているが、別のスロット
のカードが選択されている。

SxSメモリーカードを取り
出す

1	カードスロット部のカバーを開ける。

2	 SxSメモリーカードカードを抜く。

［ご注意］
メモリーカードにアクセス中に本機の電源を切ったりメモ
リーカードを抜いた場合はデータは保証されません。カー
ドに記録されたすべてのデータが壊れる可能性がありま
す。電源を切ったり、カードを抜くときは、必ず使用する
メモリーカードのACCESSランプが緑で点灯または消灯し
ていることを確認してから操作してください。

使用するSxSメモリーカー
ドを切り換える

カードスロットAとBの両方にSxSメモリーカー
ドが装着されているときは、SLOT SELECTボタ
ン（9ページ）を押して使用するカードを切
り換えることができます。
記録実行中にカードがフルになったときは、自
動的にもう1枚のカードに切り換わります。

［ご注意］
記録中および再生中は、SLOT SELECTボタンは無効にな
ります。ボタンを押しても切り換わりません。

SxSメモリーカードの取り扱い
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SxSメモリーカードを
フォーマット（初期化）す
る

フォーマットされていないSxSメモリーカード、
または別の仕様でフォーマットされたSxSメモ
リーカードを装着すると、ファイルシステムが
異なることを知らせるメッセージが表示されま
す。その場合は、以下の操作を行ってメモリー
カードをフォーマットします。

1	メニューのTC/Mediaカテゴリー > Format 
Mediaを選択する。

2	 SxS Slot A（スロットA）またSxS Slot B（ス
ロットB）を選択し、MENUダイヤルを押す。
フォーマットを実行するかどうかの確認画
面が表示されます。

3	実行する場合はITEMキー 1とITEMキー 3を
同時に3秒間押す。
フォーマットが始まり実行中メッセージが
表示され、ACCESSランプが赤く点灯します。
フォーマットが終了すると、完了メッセー
ジが表示されます。MENUダイヤルを押し
てメッセージを消します。

フォーマットできなかったときは

プロテクトされたSxSメモリーカードや本機で
使用できないメモリーカードはフォーマットさ
れません。
警告メッセージが表示されますので、メッセー
ジに従って、使用できるSxSメモリーカードに
交換してください。

［ご注意］
メモリーカードをフォーマットすると、記録された映像
データ、セットアップファイルなどを含む、すべてのデー
タが消去されます。

記録中のフォーマット

記録中でも、もう一方のカードスロットに装着し
たSxSメモリーカードのフォーマットが可能です。

残りの記録可能時間を確認
する

撮影中（記録中／記録待機中）は、サブディスプ
レイのホーム画面（33ページ）およびビュー
ファインダー・モニター画面（13ページ）の
記録メディア残量表示部で、各スロットに装着
したSxSメモリーカードの残量を確認すること
ができます。
現在設定されているビデオフォーマット（記録
ビットレート）で撮影した場合に記録可能な時
間を、それぞれのスロット内のメディアの残量
から計算して分単位で表示します。

［ご注意］

メモリーカードがプロテクトされている場合は、  マーク
が表示されます。

SxSメモリーカードの交換時期

ˎˎ 記録中に挿入されているメモリーカードの残
記録可能時間の合計が、Technicalメニュー 
> System Configuration > Media Near Full 
Alarm（81ページ）で設定されている時間
をきると、記録メディア残量表示が点滅し、
RECランプの点滅とブザー音で警告します。
空きのあるメディアに交換してください。

ˎˎ 記録を継続して、残記録可能時間の合計が0
になると、メッセージがMedia Fullに変わり
記録が停止します。

［ご注意］
1枚のSxSメモリーカードに約600個までのクリップを記
録できます。
記録できるクリップ数の上限に達すると、残時間表示が
「0」になり、メッセージMedia Fullが表示されます。

SxSメモリーカードを修復
する

何らかの原因でメモリーカード内のデータに異
常が発生した場合は、メモリーカードの修復が
必要になります。
修復が必要なSxSメモリーカードを挿入したと
きは、修復を実行するかどうかを確認するメッ
セージがサブディスプレイに表示されます。
修復を実行するには、MENUダイヤルを回して
Executeを選択し、MENUダイヤルを押します。
修復が始まります。
実行中メッセージが表示され、ACCESSランプ
が赤く点灯します。
修復が終了すると、完了メッセージが表示され
ます。MENUダイヤルを押してメッセージを消
します。

修復できなかったときは

ˎˎ プロテクトされたSxSメモリーカードや、エ
ラーが発生したSxSメモリーカードは修復で
きません。警告メッセージが表示されますの
で、メッセージに従って、プロテクトを解除
するか、別のSxS メモリーカードに交換して
ください。

ˎˎ エラーが発生したSxSメモリーカードは、
フォーマットをし直すと再利用できる場合が
あります。

ˎˎ 一部のクリップのみが修復できない場合もあ
ります。修復できたクリップは再生可能にな
ります。

ˎˎ 修復を実行しても繰り返し「一部修復できま
せんでした」とメッセージが表示されるよう
になったSxSメモリーカードは、以下の手順
で正常に戻せる場合があります。

[1] 必要なクリップを他のSxSメモリーカー
ドへコピーする。

[2] 問題のあるSxSメモリーカードを本機で
フォーマットする。

[3] 必要なクリップをフォーマットしたSxS
メモリーカードにコピーして戻す。

[4] 下記の「管理ファイルを更新する」を実
施する。

［ご注意］
本機で記録されたメディアは、本機で修復してください。
本機以外で記録されたメディアや、本機と同一機種であっ
てもバージョンが異なる機器で記録されたメディアは、本
機では修復できない場合があります。

管理ファイルを更新する

クリップが再生できない状態になったときは、
管理ファイルを更新することによって症状が改
善する場合があります。
管理ファイルの更新には、フルメニューのTC/
Media > Update Media（72ページ）を使
用します。
また、RAW Viewer V2.2以降でエクスポートさ
れたXAVCファイルを、直接SxSメモリーカード
の「XDROOT/Clip」ディレクトリー内に書き込
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んだ場合、このUpdate Mediaを実行すること
により再生が可能になります。
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本機では、カメラの設定値ファイルをSDカード
（別売り）に保存することができます。保存した
ファイルはSDカードから読み込んで使用できま
す。

本機で使用可能なSDカー
ド

SDHCメモリーカード*（Speed Class：4～ 10/ 
UHS非対応/容量：2～ 32 GB）
SDメモリーカード*（File system：FAT16/容量：
2GBまで）
* 本書ではSDカードと表現しています。

SDカードを入れる

SDカードスロット（12ページ）にSDカード
を差し込みます。
ACCESSランプ（10ページ）が赤く点灯し、
使用可能な状態になると緑で点灯します。

ACCESS ランプによる状態表示

ランプ スロットの状態
赤で点灯 装着されているSDカードにア

クセス中（データの書き込み／
読み出し中）

消灯 ˎˎ SDカードが装着されていな
い。
ˎˎ 使用できないカードが装着
されている。

SDカードを取り出す

SDカードを軽く1回押して取り出します。

［ご注意］

ˎˎ メモリーカードにアクセス中に本機の電源を切ったり
メモリーカードを抜いた場合はデータは保証されませ
ん。カードに記録されたすべてのデータが壊れる可能
性があります。電源を切ったり、カードを抜くときは、
必ず使用するメモリーカードのACCESSランプが緑で点
灯または消灯していることを確認してから操作してく
ださい。
ˎˎ 出し入れ時にはメモリーカードの飛び出しにご注意く
ださい。

SDカードをフォーマット
（初期化）する

本機で初めてSDカードを使用するときは、
フォーマットが必要です。
本機で使用するSDカードは、本機のフォーマッ
ト機能を使用してフォーマットしてください。
SDカードを装着したときに注意メッセージが表
示された場合も、フォーマットして使用してく
ださい。
本機が対応していないフォーマットで初期化さ
れたSDカードを装着すると、ファイルシステム
が異なることを知らせるメッセージが表示され
ます。

1	メニューのTC/Mediaカテゴリー > Format 
Media > SD Cardを選択し、MENUダイヤ
ルを押す。
フォーマットを実行するかどうかの確認画
面が表示されます。

2	実行する場合はITEMキー 1とITEMキー 3を
同時に3秒間押す。
フォーマットが始まり実行中メッセージが
表示され、ACCESSランプが赤く点灯します。
フォーマットが終了すると、完了メッセー
ジが表示されます。MENUダイヤルを押し
てメッセージを消します。

［ご注意］
SDカードをフォーマットすると、すべてのデータが消去
され、復元できません。

本機でフォーマットしたメディアを
他の機器のスロットで使用するには

あらかじめバックアップを取り、お使いになる
機器でフォーマットし直して使用してください。

設定データ保存用SDカードの取り扱い
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AXS-R7を使う
本機にAXS（Access Memory Card System）レ
コーダー AXS-R7（別売り）を取り付けて、RAW
またはX-OCNの映像・音声を記録できます。

［ご注意］
本機にAXS-R7を取り付ける場合、本機のファームウェ
アバージョンに合わせてバージョンアップが必要です
（31ページ）。以下の組み合わせでご使用ください。

本機のバージョン AXS-R7のバージョン
1.0、1.01 1.1
2.01 2.0
3.0 3.0
4.0 4.0
5.0 5.0

AXS-R7を取り付ける

［ご注意］
AXS-R7の取り付け／取り外しは、本機の電源を切った状
態で行ってください。

1	本機後面の六角ネジ（3 mm、4本）を緩めて、
バッテリープレートを取り外す。

バッテリー
プレート

2	 AXS-R7後面の六角ネジ（4本）を緩めて、
AXS-R7からドッキングモジュールを取り外
す。

AXS-R7

ドッキングモジュール

3	 AXS-R7を本機に取り付け、六角ネジ（4本）
を締める。

AXS-R7

AXS-R7を取り外すには

六角ネジ（4本）を緩めて、AXS-R7を取り外し
ます。

AXSメモリーカードを入れ
る

1	メモリースロットカバーオープンボタンを
押してカバーを開ける。

2	 AXSメモリーカードのラベルを図の向きに
してカードスロットに差し込む。

ラベル

3	カバーを閉める。

AXSメモリーカードを切り
換える

AXSメモリーカードが2枚装着されているとき
は、AXS-R7のSLOT SELECTボタンを押してア
クティブなスロットを切り換えます。

SLOT SELECTボタン

AXSメモリーカードを取り
出す

AXS-R7のメモリースロットカバーを開け、
AXSメモリーカードを手で引き抜きます。

［ご注意］
AXSメモリーカードにアクセス中に本機の電源を切ったり
メモリーカードを抜いた場合はデータは保証されません。
カードに記録されたすべてのデータが壊れる可能性があり
ます。電源を切ったり、カードを抜くときは、必ず使用す
るメモリーカードのACCESSランプが緑で点灯または消灯
していることを確認してから操作してください。
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AXSメモリーカードに記録する

メニューのProjectカテゴリー > AXS Rec Format（49ページ）で、AXSメモリーカードに記録す
るフォーマットを選択できます。
AXS-R7内のAXSメモリーカードは、AXS単独記録実行中にカードがフルになったときは、もう1枚
のカードに自動的に切り換わります。

S24またはS48 AXSメモリーカード使用時、AXS Rec FormatとImager Modeの設定によって以下
の制限があります。S24 AXSメモリーカードが使用できない状態のときに、S24 AXSメモリーカー
ドが検出されると、注意メッセージが表示されます。

［ご注意］
ProRes 4444 HD Pのビデオフォーマットでの記録時は、AXS同時記録はできません。

AXS Rec Format Imager Mode 撮像フレームレートと対応S24/S48 AXSメモリーカード
24 25 30 48 50 60 75 110 120

X-OCN XT 3.8K 16:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

－ － －

3.8K 16:9 
Surround View

S24/
S48

S24/
S48

S24/
S48

S24/
S48

－ － － － －

4K 2.39:1 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 S48

4K 17:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 S48 －

4K 17:9 Surround 
View

S24/
S48

S24/
S48

S24/
S48

S24/
S48

－ － － － －

4K 4:3 S24/
S48

S24/
S48

S24/
S48

S48 S48 S48 S48 － －

4K 4:3 Surround 
View

S24/
S48

S24/
S48

S24/
S48

－ － － － － －

4K 6:5 S24/
S48

S24/
S48

S24/
S48

－ － － － － －

5.7K 16:9 S24/
S48

S24/
S48

S48 － － － － － －

6K 2.39:1 S24/
S48

S24/
S48

S24/
S48

S48 S48 S48 － － －

6K 17:9 S24/
S48

S24/
S48

S48 S48 S48 － － － －

AXS Rec Format Imager Mode 撮像フレームレートと対応S24/S48 AXSメモリーカード
24 25 30 48 50 60 75 110 120

6K 1.85:1 S24/
S48

S24/
S48

S48 S48 S48 － － － －

6K 3:2 S48 S48 S48 － － － － － －
RAW SQ 4K 17:9 S24/

S48
S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 －

4K 17:9 Surround 
View

S24/
S48

S24/
S48

S24/
S48

S24/
S48

－ － － － －

X-OCN ST 3.8K 16:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

－ － －

3.8K 16:9 
Surround View

S24/
S48

S24/
S48

S24/
S48

S24/
S48

－ － － － －

4K 2.39:1 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48

4K 17:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 －

4K 17:9 Surround 
View

S24/
S48

S24/
S48

S24/
S48

S24/
S48

－ － － － －

4K 4:3 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 － －

4K 4:3 Surround 
View

S24/
S48

S24/
S48

S24/
S48

－ － － － － －

4K 6:5 S24/
S48

S24/
S48

S24/
S48

－ － － － － －

5.7K 16:9 S24/
S48

S24/
S48

S24/
S48

－ － － － － －

6K 2.39:1 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 S48 － －

6K 17:9 S24/
S48

S24/
S48

S24/
S48

S48 S48 S48 － － －

6K 1.85:1 S24/
S48

S24/
S48

S24/
S48

S48 S48 S48 － － －

6K 3:2 S24/
S48

S24/
S48

S24/
S48

S48 S48 S48 － － －

X-OCN LT 3.8K 16:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

－ － －

3.8K 16:9 
Surround View

S24/
S48

S24/
S48

S24/
S48

S24/
S48

－ － － － －
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AXS Rec Format Imager Mode 撮像フレームレートと対応S24/S48 AXSメモリーカード
24 25 30 48 50 60 75 110 120

4K 2.39:1 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

4K 17:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

－

4K 17:9 Surround 
View

S24/
S48

S24/
S48

S24/
S48

S24/
S48

－ － － － －

4K 4:3 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

－ －

4K 4:3 Surround 
View

S24/
S48

S24/
S48

S24/
S48

－ － － － － －

4K 6:5 S24/
S48

S24/
S48

S24/
S48

－ － － － － －

5.7K 16:9 S24/
S48

S24/
S48

S24/
S48

－ － － － － －

6K 2.39:1 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

－ －

6K 17:9 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

－ － －

6K 1.85:1 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

－ － －

6K 3:2 S24/
S48

S24/
S48

S24/
S48

S24/
S48

S24/
S48

S48 － － －

AXSメモリーカードを
フォーマット（初期化）す
る

本機に装着されたAXS-R7で初めてAXSメモリー
カードを使用するときは、フォーマットが必要
です。
AXS-R7で使用するAXSメモリーカードは、本機
のフォーマット機能を使用してフォーマットし
てください。AXS-R7を装着して本機の電源を

入れたときに注意メッセージが表示された場合
も、フォーマットして使用してください。
AXS-R7が対応していないフォーマットで初期
化されたAXSメモリーカードを装着すると、ファ
イルシステムが異なることを知らせるメッセー
ジが表示されます。

1	メニューのTC/Mediaカテゴリー > Format 
Mediaを選択し、MENUダイヤルを押す。

2	 AXS Slot A（スロットA）またAXS Slot B（ス
ロットB）を選択する。
フォーマットを実行するかどうかの確認画
面が表示されます。

3	実行する場合はITEMキー 1とITEMキー 3を
同時に3秒間押す。
フォーマットが始まり実行中メッセージが
表示され、ACCESSランプが赤く点灯します。
フォーマットが終了すると、完了メッセー
ジが表示されます。MENUダイヤルを押し
てメッセージを消します。

［ご注意］
メモリーカードをフォーマットすると、すべてのデータが
消去され、復元できません。

残りの記録可能時間を確認
する

撮影中（記録中／記録待機中）は、サブディスプ
レイのホーム画面（33ページ）およびビュー
ファインダー・モニター画面（13ページ）の
記録メディア残量表示部で、装着したAXSメモ
リーカードの残量を確認することができます。
現在設定されているビデオフォーマット（記録
ビットレート）で撮影した場合に記録可能な時
間を、メディアの残量から計算して分単位で表
示します。

［ご注意］

AXSメモリーカードがプロテクトされている場合は、  
マークが表示されます。

AXSメモリーカードを修復
する

何らかの原因でメモリーカード内のデータに異
常が発生した場合は、メモリーカードの修復が
必要になります。
修復が必要なAXSメモリーカードを装着したと
きは、修復を実行するかどうかを確認するメッ
セージが表示されます。
修復を実行するには、MENUダイヤルを回して
Executeを選択し、MENUダイヤルを押します。
修復が始まります。
実行中メッセージが表示され、ACCESSランプ
が赤く点灯します。
修復が終了すると、完了メッセージが表示され
ます。MENUダイヤルを押してメッセージを消
します。

修復できなかったときは

ˎˎ プロテクトされたAXSメモリーカードや、エ
ラーが発生したAXSメモリーカードは修復で
きません。警告メッセージが表示されますの
で、メッセージに従って、プロテクトを解除
するか、別のAXSメモリーカードに交換して
ください。

ˎˎ エラーが発生したAXSメモリーカードは、
フォーマットをし直すと再利用できる場合が
あります。

ˎˎ 一部のクリップのみが修復できない場合もあ
ります。修復できたクリップは再生可能にな
ります。



000 2章　準備：AXS-R7を使う31

［ご注意］
本機で記録されたメディアは、本機で修復してください。
本機以外で記録されたメディアや、本機と同一機種であっ
てもバージョンが異なる機器で記録されたメディアは、本
機では修復できない場合があります。

管理ファイルを更新する

クリップが再生できない状態になったときは、
管理ファイルを更新することによって症状が改
善する場合があります。
管理ファイルの更新には、フルメニューのTC/
Media > Update Media（72ページ）を使用
します。

AXS-R7のファームウェア
をバージョンアップする

AXS-R7を取り付けた状態で、AXS-R7のファー
ムウェアをバージョンアップできます。

［ご注意］

ˎˎ この操作を行うには、本機のファームウェアバージョ
ンが2.0以上である必要があります。
ˎˎ AXS Rec Format（49ページ）をRec Offに設定して
から操作を行ってください。

1	 AXS-R7のバージョンアップ手順書に従って、
バージョンアップ用USBメモリーを用意する。

2	外部機器接続端子（12ページ）にバージョ
ンアップ用USBメモリーを装着する。

3	 Maintenanceメニュー > Firmware > FW 
Update-AXS-R7（86ページ）で、AXS-R7の
ファームウェアバージョンアップを実行する。
バージョンアップが完了するまで約15分
かかります。バージョンアップが完了する
と、自動で本機が再起動し、「Firmware 
Upgrade Done」が表示されます。
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サブディスプレイ
サブディスプレイにはホーム画面、クリップリスト画面、再生画面、メニュー画面、フルメニュー画面、ユーザー機能画面の6種類の画面が表示されます。
アシスタントサイドの各ボタンを操作して、サブディスプレイの各画面が下図のように遷移します。

 

ユーザー機能画面

ホーム画面 クリップリスト画面

メニュー画面 フルメニュー画面

再生画面

USERボタン

USERボタン

MENUボタン

HOMEボタン

HOMEボタン

HOMEボタン

CLIPSボタン

CLIPSボタン

CLIPSボタン

USERボタン

MENUボタン

MENUボタン
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ホーム画面

アシスタントサイドのHOMEボタンを押すとホーム画面が表示されます。ホーム画面では本機の状
態の確認や基本的な項目の設定ができます。

項目名／設定値／
機能表示部

ステータス
表示部

項目名／設定値／機能表示部

1 2 3

4 5 6

ITEMキー 4 ITEMキー 5 ITEMキー 6

ITEMキー 3ITEMキー 2ITEMキー 1

［ご注意］
1～ 6に表示される各項目はITEMキー 1～ 6（43ページ）
にそれぞれ対応しています。ITEMキーを押すと、対応する
項目の操作ができます。オレンジ文字色で表示している機
能に対してITEMキーは有効となります。

1. FPS
撮像フレームレートの表示／設定

2. Exposure Index/Gain
Exposure Indexの表示／設定または
RM-B170などのリモートコントロールユ
ニットで設定したゲイン値の表示（上部アイ
コンには基準感度を表示）

 ［ご注意］
ゲイン値は、Technicalメニュー > System 
Configuration > RM/RCP Paint Control（81ペー
ジ）がOnに設定されている場合のみ表示されます。

3. Shutter
電子シャッターの開角度／スピードの 
表示／設定

4. ND Filter
NDフィルターのポジションの表示／設定

5. LUT
モニター LUTの表示／設定

6. WB（White Balance）
ホワイトバランスの表示／設定

ステータス表示部

1

9

2 3

5

4

7 6810

13
12
11

1. タイムデータ表示
メニューのTC/Mediaカテゴリー > TC 
Displayの設定に従って、デュレーション
またはタイムコードが表示されます（49
ページ）。
タイムデータに現在表示しているデータの
種類は、次のように表示されます。
TCG：記録タイムコード
TCR：再生タイムコード
Dur：デュレーション

2. フレームレート表示
メニューのProjectカテゴリー > Project 
Frame Rateの設定値が表示されます（49
ページ）。

3. イメージャーモード表示
メニューのProjectカテゴリー > Imager 
Modeの設定値、およびデスクイーズ情報が
表示されます。

4. クリップ名表示
「Reel：Camera ID + Reel Number」と
「ShotNumber」が表示されます。

5. 音声レベルメーター
音声記録レベルまたは再生レベルが表示さ
れます。「1」、「2」は音声チャンネル1、2を
示します。

6. 同時記録情報
表示しているメディアに1スロット同時記録
を行う設定になっているときは、表示して
いるメイン記録フォーマットの右側にSub
アイコンが表示されます。

7. 記録フォーマット（コーデック）表示
AXSメモリーカード、SxSメモリーカードに
記録されるフォーマット名称が表示されま
す（53ページ）。

8. 電源電圧／バッテリー残量表示
電源電圧またはバッテリー残量が表示され
ます。

9. メディア残量表示
記録アクティブアイコン、メディア種類、ス
ロット種類（A/B）、残時間（現在の記録フォー
マットで記録できる時間）が表示されます。
また、再生中のクリップ名が表示されます。   
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10. 記録動作状態表示
本機の記録動作状態が次のように表示され
ます。

表示 説明

Stby 記録待機中

●Rec 記録中

●Cache ピクチャーキャッシュレッ
ク記録待機中

11. 温度計アイコン
温度上昇に関する警告メッセージがあると
きに表示されます。
メニューのInfoカテゴリーに内容が表示さ
れます。

12. 警告アイコン
温度上昇を除く警告メッセージがあるとき
に表示されます。
メニューのInfoカテゴリーに内容が表示さ
れます。

13. Ext-LKアイコン
内蔵のタイムコードジェネレーターがTC IN 
端子に接続した外部信号にロックしている
ときに表示されます。
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サブディスプレイのホーム画面の操作方法
基本操作

1	 HOMEボタンを押す。
ホーム画面が表示されます。

2	 ITEMキー 1～ 6で設定したい項目を選ぶ。
設定を変更できる項目は、設定値がオレン
ジ色になっています。
下図はITEMキー 3を押した場合の表示例で
す。

3	  ボタン（ITEMキー 2）、  ボタン（ITEM
キー 5）またはMENUダイヤルで、選択項目
または設定値にカーソルを合わせる。

4	 MENUダイヤルまたはSetボタン（ITEM 
キー 3）を押して決定する。

サブディスプレイの明るさを変更す
る

サブディスプレイの明るさは、フルメニュー
のTechnical > Control Display > Brightness 
level（84ページ）で変更できます。
また、ホーム画面で、BACKボタンを押しなが
らMENUダイヤルを時計方向に回すと、サブ
ディスプレイの明るさが、その時点での設定を
基点にMinimum→Low→Mid→Highの順で変
わります。
ホーム画面で、BACKボタンを押しながら
MENUダイヤルを反時計方向に回すと、サブ
ディスプレイの明るさが、その時点での設定を
基点にHigh→Mid→Low→Minimumの順で変
わります。

［ご注意］
ディスプレイの明るさの設定はサブディスプレイとミニ
ディスプレイ共通で、設定が両画面に同時に反映されます。

RM/RCP Paint Control有効時の表示
と動作について

ˎˎ Technicalメニュー > System Configuration 
> RM/RCP Paint Control（81ページ）が
Onに設定されている場合は、EI操作部には
RM-B170などのリモートコントロールユニッ
トで設定したゲイン値が表示されます。この
場合、EI値は変更できませんが、ゲイン値を
変更できます（36ページ）。ただし、Base 
ISOの切り換えは可能です。 
また、この場合、Monitorおよびビュー
ファインダーのLUT設定が可能となり、
R709(800%)またはR709-Likeを選択する
と、SDR Gain設定で出力ゲインを変更で
きます。ただし、Projectメニュー > Basic 

Setting > Input Color Space（67ページ）
がRec.709/User Gammaに設定されている
場合は、出力ゲインは変更できません。

ˎˎ Technicalメニュー > System Configuration 
> RM/RCP Paint Control（81ページ）が
Onで、RM-B170などのリモートコントロー
ルユニット接続時は、以下の操作部はグレー
アウトされ操作できません。リモートコント
ロールユニットで設定してください（108
ページ）。

ˎˎ シャッター操作部

ˎˎ WB操作部

Step Edit操作

基本操作の手順2でITEMキー 4の位置に「Step 
Edit」が表示されていた場合は、選択できる設定
値を変更することができます。設定値編集画面
で設定値の追加と削除が行えます。

1	設定値選択画面で、変更または削除したい
設定値にカーソルを合わせ、Step Editボタ
ン（ITEMキー 4）を押す。
設定値編集画面が表示されます。

2	設定値を削除する場合は、Delete（ITEMキー 4）
を押す。

 ［ご注意］
Deleteの文字がオレンジ色の場合に、選択している
設定値を削除できます。

3	  ボタン（ITEMキー 2）、  ボタン（ITEM
キー 5）またはMENUダイヤルで、設定値を
変更する。

4	設定値が決まったら、Addボタン（ITEMキー
4）を押す。
設定値が追加され、設定値選択画面に戻り
ます。

 ［ご注意］
Addの文字がオレンジ色の場合に、設定値を追加でき
ます。

White Balance設定時の操作につい
て

White Balanceの設定値編集画面では、
Coarse/Fineボタン（ITEMキー 1）を押すと、1
ステップの可変量を「粗い」（Coarse）または「細
かい」（Fine）に切り換えることができます。ま
た、Temp/Tintボタン（ITEMキー 3）を押すと、
変更する値の色温度（Temp）と色合い（Tint）を
切り換えることができます。
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FPS操作

ホーム画面でITEMキー 1を押してFPS操作画面
表示時、Variable/Fixedボタン（ITEMキー 4）
を押すと、Project Frame Rateに対して等速撮
影を行う「Fixed」と可変速撮影を行う「Variable
（Select FPS）」を切り換えることができます。

［ご注意］
Select FPS時は音声記録されません。

EI操作/Gain操作

EI値を変更できます。また、Technicalメニュー 
> System Configuration > RM/RCP Paint 
Control（81ページ）がOnで、RM-B170など
のリモートコントロールユニットが接続されて
いないときは、EI値の代わりにゲイン値が表示
され、設定を変更できます。

EI値またはゲイン値を変更する

［ご注意］
ここではEI値を変更する場合の画面を例に示します。

ホーム画面でITEMキー 2を押すと、EI値または
ゲイン値を変更できます。

1	ホーム画面でITEMキー 2を押す。
EI操作画面またはGain操作画面が表示され
ます。

2	  ボタン（ITEMキー 2）、  ボタン（ITEM
キー 5）またはMENUダイヤルで設定値を変
更する。

3	 MENUダイヤルまたはSetボタン（ITEMキー
3）を押して決定する。

Base ISOを切り換える

EI操作画面またはGain操作画面でITEMキー 4を
押すと、Base ISOを切り換えることができます。

1	 EI操作画面またはGain操作画面でITEMキー
4を押す。
Base ISOの切り換え画面が表示されます。

2	 2つのChangeボタン（ITEMキー 1とITEM
キー 3）を同時に押す。

Base ISOが切り換わります（40ページ）。

AWB操作

ホーム画面でITEMキー 6を押してホワイトバラ
ンス操作画面表示時、Auto White Bal.ボタン
（ITEMキー 1）を押すとオートホワイトバランス
を実行します。実行後、Addボタン（ITEMキー 4）
を押して設定値をステップに追加します。また、
設定値をステップに追加する前に、Temp/Tint
ボタン（ITEMキー 3）を押して色温度（Temp）
と色合い（Tint）を切り換えることにより各値を
微調整できます。

［ご注意］
AWB操作を行う場合は、均一適正輝度のホワイトチャー
トを撮像してください。

LUT操作

LUTを設定する

ホーム画面でITEMキー 5を押すと、各出力系統
のLUTを設定できます。

1	ホーム画面でITEMキー 5を押す。
LUT選択画面が表示されます。

LUT選択画面は2ページで構成されており、
ITEMキー 1を押すとページを切り換えるこ
とができます。
ページ1では、SDI 1/2(表示のみ)、SDI 
3/4、Monitor、HDMIのLUT設定ができま
す。
ページ2では、Viewfinder、SDR Gain、
SxS Rec、Sub RecのLUT設定ができます。

 ［ご注意］
Projectメニュー > Basic Setting > Input Color 
Space（67ページ）がRec.2020/User Gammaまた
はRec.709/User Gammaに設定されている場合は、
LUT選択画面にはユーザーガンマの情報が表示されま
す。

2	 ITEMキー 2、3、5、6で設定したい出力を
選ぶ。
設定値変更画面が表示されます。
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3	  ボタン（ITEMキー 2）、  ボタン（ITEM
キー 5）またはMENUダイヤルで、設定値を
変更する。

4	 MENUダイヤルまたはSetボタン（ITEMキー
3）を押して決定する。

Preset Lookを変更する

ページ1またはページ2のEdit Lookボタン
（ITEMキー 4）を押すと、LUT選択画面でLook
を選択したときのLUTを設定できます。

1	 LUT選択画面でEdit Lookボタン（ITEMキー
4）を押す。
Look選択画面が表示されます。

2	 Selectボタン（ITEMキー 3）を押す。
選択可能な値が表示されます。

3	  ボタン（ITEMキー 2）、  ボタン（ITEM
キー 5）またはMENUダイヤルで、設定値を
変更する。

4	 MENUダイヤルまたはSetボタン（ITEMキー
3）を押して決定する。

LUT操作のカテゴリーを変更する

LUT操作の対象となるカテゴリーを、User 3D 
LUT、ACESまたはPreset Lookのいずれかに変
更できます（65ページ）。

1	 LUT選択画面でEdit Lookボタン（ITEMキー
4）を押す。
Look選択画面が表示されます。

2	  ボタン（ITEMキー 2）、  ボタン（ITEM
キー 5）またはMENUダイヤルで、カテゴ
リーの選択が可能な状態にする。

3	 MENUダイヤルまたはSelectボタン（ITEM
キー 3）を押す。

4	  ボタン（ITEMキー 2）、  ボタン（ITEM
キー5）またはMENUダイヤルで、カテゴリー
（User 3D LUT、ACESまたはPreset Look）
を選択する。

5	 MENUダイヤルまたはSetボタン（ITEMキー
3）を押して決定する。

User 3D LUTファイルを読み込む

SDカードに保存されているUser 3D LUTファイ
ルを本機に読み込むことができます。

［ご注意］
User 3D LUTファイルは、SDカードの以下の階層に保存
してください（102ページ）。
PRIVATE\SONY\PRO\LUT\

1	 SDカードスロット（12ページ）にSDカー
ドを差し込む。

2	 LUT選択画面でEdit Lookボタン（ITEMキー
4）を押す。
Look選択画面が表示されます。

3	 Load Fileボタン（ITEMキー 4）を押す。

4	 MENUダイヤルまたはSelectボタン（ITEM
キー 3）を押す。
読み込み先の番号（01～ 16）が表示されま
す。
読み込み済みの番号にはファイル名が表示
されます。

5	  ボタン（ITEMキー 2）、  ボタン（ITEM
キー 5）またはMENUダイヤルで、読み込み
先の番号を選択する。

6	 MENUダイヤルまたはSelectボタン（ITEM
キー 3）を押す。
SDカードに保存されているUser 3D LUTの
ファイル名が表示されます。

7	  ボタン（ITEMキー 2）、  ボタン（ITEM
キー 5）またはMENUダイヤルで、ファイル
を選択する。

8	 MENUダイヤルまたはLoadボタン（ITEM
キー 3）を押す。
ファイルの読み込みが完了すると、
「Successfully loaded」が表示されます。

9	 OKボタン（ITEMキー 6）を押す。

ASC CDLファイルを読み込む

SDカードに保存されているASC CDLファイル
を本機に読み込むことができます。

［ご注意］
ASC CDLファイルは、SDカードの以下の階層に保存して
ください（102ページ）。
PRIVATE\SONY\PRO\CDL\

1	 SDカードスロット（12ページ）にSDカー
ドを差し込む。
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2	 LUT選択画面でEdit Lookボタン（ITEMキー
4）を押す。
Look選択画面が表示されます。

3	 Load Fileボタン（ITEMキー 4）を押す。

4	 Load ASC CDL Fileを選択し、MENUダイ
ヤルまたはSelectボタン（ITEMキー 3）を押
す。

SDカードに保存されているASC CDLのファ
イル名が表示されます。

5	  ボタン（ITEMキー 2）、  ボタン（ITEM
キー 5）またはMENUダイヤルで、ファイル
を選択する。

6	 MENUダイヤルまたはLoadボタン（ITEM
キー 3）を押す。
Load All Filesボタン（ITEMキー 1）を押す
と、すべてのファイルを読み込むことがで
きます。
ファイルの読み込みが完了すると、
「Successfully loaded」が表示されます。

7	 OKボタン（ITEMキー 6）を押す。

8	 ASC CDL ProcessでASC CDLの処理の順番
を指定する。

User 3D LUTファイルを変
更する

現在選択されているUser 3D LUTファイルを変
更できます。

1	 LUT選択画面でEdit Lookボタン（ITEMキー
4）を押す。
Look選択画面が表示されます。

2	 MENUダイヤルまたはSelectボタン（ITEM
キー 3）を押す。

3	  ボタン（ITEMキー 2）、  ボタン（ITEM
キー 5）またはMENUダイヤルで、User 3D 
LUTファイルを変更する。

4	 MENUダイヤルまたはSetボタン（ITEMキー
3）を押して決定する。

ASC CDLファイルを変更
する

現在選択されているASC CDLファイルを変更で
きます。

1	 LUT選択画面でEdit Lookボタン（ITEMキー
4）を押す。
Look選択画面が表示されます。

2	 ASC CDL Selectを選択し、MENUダイヤル
またはSelectボタン（ITEMキー 3）を押す。

3	  ボタン（ITEMキー 2）、  ボタン（ITEM
キー 5）またはMENUダイヤルで、ASC CDL
ファイルを変更する。

 ［ご注意］
本機に適用できないファイルはグレーアウト表示され
ます。
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4	 MENUダイヤルまたはSetボタン（ITEMキー
3）を押して決定する。

ASC CDLファイルの情報を表示する

現在選択されているASC CDLファイルの情報を
表示できます。

1	 LUT選択画面でEdit Lookボタン（ITEMキー
4）を押す。
Look選択画面が表示されます。

2	 ASC CDL Selectを選択し、ASC CDL Info
ボタン（ITEMキー 1）を押す。

ASC CDLファイルの情報が表示されます。

ASC CDLファイルの設定可能範囲に
ついて

ASC CDLファイルの設定可能範囲は以下のとお
りです。範囲を超えたファイルは読み込めません。
Slope：0.000～ 3.999
Offset：-1.000～ 1.000
Power：0.400～ 4.000
Saturation：0.000～ 3.999

Monitor/ビューファイン
ダーのLUT設定

Technicalメニュー > System Configuration > 
RM/RCP Paint Control（81ページ）がOnに
設定されている場合は、Monitorとビューファ
インダーの出力のそれぞれをSDI出力などの本
線と同じ信号にするか、R709(800％ )または
R709-Likeにするかを選択できます。

［ご注意］
Projectメニュー > Basic Setting > Input Color Space
（67ページ）がRec.2020/User Gammaに設定されてい
る場合は、R709-Likeと表示されます。

ゲインを切り換える

Monitorまたはビューファインダーの出力を
R709(800％ )またはR709-Likeに設定すると、
各出力のゲインを切り換えることができます。

1	ホーム画面のページ2で、SDR Gainボタン
（ITEMキー 3）を押す
SDR Gain画面が表示されます。

2	 ボタン（ITEMキー 2）、 ボタン（ITEMキー
5）またはMENUダイヤルで設定値を変更す
る。

3	 MENUダイヤルまたはSetボタン（ITEMキー
3）を押して決定する。
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サブディスプレイのホーム画面設定項目一覧

各項目名称と設定内容は次のとおりです。
太字とアンダーラインで表示されている設定値は、出荷時の設定です。

［ご注意］
撮像フレームレートの最大値は記録フォーマットによっても変わります。SxS単独記録時およびAXSとSxSの同時記録時
は、撮像フレームレートの最大値が次のように制限されます。
4K/QFHD XAVC Intra Class 480：最大30FPS
4K/QFHD XAVC Intra Class 300：最大60FPS
MPEG HD 422 Codec：最大30FPS
ProRes 422 Codec：最大60FPS

項目 内容

FPS 撮像フレームレートを設定する。
Variable/Fixed：等速撮影と可変速撮影を切り換えます。
「Fixed」を選択した場合、メニューのProjectカテゴリー > Project Frame 
Rate（49ページ）の設定で値が決まります。

Project Frame Rate 表示

23.98 Fix 23.98

24 Fix 24.00

25 Fix 25.00

29.97 Fix 29.97

47.95 Fix 47.95

50 Fix 50.00

59.94 Fix 59.94

項目 内容

「Variable」を選択した場合、Projectカテゴリー > Imager Mode（67ペー
ジ）の設定によって、設定値が次のように異なります。

Imager Mode 設定値

3.8K 16:9
4K 17:9
4K 2.39:1

1～ 60 FPS

4K 17:91) 1 ～ 60、66、72、75、88、90、
96、100、110 FPS

3.8K 16:9 Surround View
4K 17:9 Surround View
4K 4:3

1～ 48 FPS

4K 4:31) 1 ～ 60、66、72、75 FPS

4K 2.39:11) 1 ～ 60、66、72、75、88、90、
96、100、110、120 FPS

4K 4:3 Surround View
4K 6:5
5.7K 16:9
6K 2.39:1
6K 17:9
6K 1.85:1

1～ 30 FPS

6K 2.39:11) 1 ～ 60、66、72、75、90 FPS
6K 17:91)

6K 1.85:11)
1 ～ 60、66、72 FPS

6K 3:2 1～ 25 FPS

6K 3:21) 1 ～ 60 FPS

Exposure Index EI値を設定する。Change Baseボタン（ITEMキー 4）を押して、次の画面で2
つのChangeボタン（ITEMキー 1とITEMキー 3）を同時に押すと、Base ISO
を切り換えることができます。Base ISOの設定によって、設定値が次のよう
に異なります。
Base ISO 500：

125EI/160EI/200EI/250EI/320EI/400EI/500EI/640EI/800EI/1000EI/ 
1250EI/1600EI/2000EI

Base ISO 2500：
640EI/800EI/1000EI/1250EI/1600EI/2000EI/2500EI/3200EI/4000EI/ 
5000EI/6400EI/8000EI/10000EI
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項目 内容

Gain 基準感度を設定する。
－6dB/－3dB/0dB/3dB/6dB/9dB/12dB/15dB/18dB

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）
がOnで、RM-B170などのリモートコントロールユニットが接続されていない場合のみ
設定できます。

Shutter 電子シャッターの開角度／スピードを設定する。
Step/Cont.ボタン（ITEMキー 1）を押して、StepとCont.を切り換えることで
選択方法が変えられます。
Step：ステップシャッターとして登録されている最大16種類のプリセット値
から選択する。（選択後、Step Editボタンを（ITEMキー 4）を押すと、任意の
設定値をプリセット値から変更することができます。）
フルメニューのTechnical > System Configuration > Shutter Mode
（81ページ）の設定によって次のように選択肢が表示される。
Angle：開角度表示
工場出荷時の選択肢

360/180/172.8/144/90/45/22.5/11.2/5.6
Speed：スピード表示
工場出荷時の選択肢

1/24、1/25、1/30、1/50、1/60、1/100、1/120、1/250、1/500、
1/1000、1/20002)

[ご注意]
スピードの初期値はProject Frame Rate（49ページ）の設定によって次のよう
になります。
23.98/24：1/24, 25：1/25, 29.97：1/30, 47.95：1/48, 50：1/50, 59.94：1/60

Cont.：設定可能な任意の開角度／スピードを選択する。
ND Filter NDフィルターのポジションを設定する。設定値は以下のとおりです。

Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4

項目 内容

LUT 各種出力映像に適用するLUTに関する設定を行う。Technicalメニュー > 
System Configuration > RM/RCP Paint Control（81ページ）の設定によっ
て設定値が異なる。

Page 1
SDI 1/2（ITEMキー 2）

RM/RCP Paint ControlがOffのとき：Log
SDI 1/2出力映像にはLUTを適用できないため表示のみ。

RM/RCP Paint ControlがOnのとき：Log/HLG(Natural)/HLG(Live)/User 
Gamma

SDI 1/2出力映像の設定値は、メニューのProjectカテゴリー > Input 
Color Spaceの設定で決まるため表示のみ。

SDI 3/4（ITEMキー 3）
RM/RCP Paint ControlがOffのとき：Log/Look

SDI 3/4出力映像に適用するLUTを選択する。
メニューのMonitoringカテゴリー > Output Format > SDI 1/2が4K/
QFHDのときは無効となります。

RM/RCP Paint ControlがOnのとき：Log/HLG(Natural)/HLG(Live)/User 
Gamma

SDI 3/4出力映像の設定値は、メニューのProjectカテゴリー > Input 
Color Spaceの設定で決まるため表示のみ。

Monitor（ITEMキー 5）
RM/RCP Paint ControlがOffのとき：

Monitor出力映像に適用するLUTを選択する。
Output Format > SDI1/2が2K/HDのとき：Log/s709/R709(800%)
Output Format > SDI1/2が4K/QFHDのとき：Log/Look

RM/RCP Paint ControlがOnのとき：
Monitor出力映像の種類を選択する。
メニューのProjectカテゴリー > Input Color Spaceの設定によって、設
定値が次のように異なります。

S-Gamut3.Cine/SLog3またはS-Gamut3/SLog3：Log/R709(800%)
HLG(Natural)：HLG(Natural)/R709(800%)
HLG(Live)：HLG(Live)/R709(800%)
Rec.2020/User Gamma：User Gamma/R709-Like
Rec.709/User Gamma：User Gamma
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項目 内容

HDMI（ITEMキー 6）
RM/RCP Paint ControlがOffのとき：Log/s709/R709(800%)/Look

HDMI出力映像に適用するLUTを表示する。
メニューのMonitoringカテゴリー > Output Format > SDI 1/2が4K/
QFHDで、HDMIが4K/QFHDのときはLog固定となります。それ以外は
Monitorと同期します。

RM/RCP Paint ControlがOnのとき（4K/QFHD出力時）：Log/
HLG(Natural)/HLG(Live)/User Gamma

HDMI出力映像の設定値はSDI 1/2と同じため表示のみ。
RM/RCP Paint ControlがOnのとき（2K/HD出力時）：Log/HLG(Natural)/

HLG(Live)/User Gamma/R709(800%)/R709-Like
HDMI出力映像の設定値はMonitorと同じため表示のみ。

Page 2
Viewfinder（ITEMキー 2）

RM/RCP Paint ControlがOffのとき：Log/s709/R709(800%)
ビューファインダー・モニター画面出力映像に適用するLUTを選択する。

RM/RCP Paint ControlがOnのとき：
ビューファインダー・モニター画面出力映像の種類を選択する。
メニューのProjectカテゴリー > Input Color Spaceの設定によって、設
定値が次のように異なります。

S-Gamut3.Cine/SLog3またはS-Gamut3/SLog3：Log/R709(800%)
HLG(Natural)：HLG(Natural)/R709(800%)
HLG(Live)：HLG(Live)/R709(800%)
Rec.2020/User Gamma：User Gamma/R709-Like
Rec.709/User Gamma：User Gamma

SDR Gain（ITEMキー 3）：－15dB ～ 0dB（－12dB）
HDRモード時のSDR出力ゲインを設定する。

 ［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ペー
ジ）がOnに設定されている場合に設定できます。

SxS Rec（ITEMキー 5）
RM/RCP Paint ControlがOffのとき：Log/Look

SxS Mainクリップ記録映像に適用するLUTを選択する。
メニューのProjectカテゴリー > SxS Rec FormatがRec Offのときは無効、
XAVCのときはLog固定となります。

RM/RCP Paint ControlがOnのとき：Log/HLG(Natural)/HLG(Live)/User 
Gamma

SxS Mainクリップ記録映像の設定値は、メニューのProjectカテゴリー > 
Input Color Spaceの設定で決まるため表示のみ。

項目 内容

Sub Rec（ITEMキー 6）
RM/RCP Paint ControlがOffのとき：Log/Look

SxS Subクリップ記録映像に適用するLUTを選択する。
メニューのProjectカテゴリー > SxS Rec FormatがRec Offのときは無効
となります。

RM/RCP Paint ControlがOnのとき：Log/HLG(Natural)/HLG(Live)/User 
Gamma

SxS Subクリップ記録映像の設定値は、メニューのProjectカテゴリー > 
Input Color Spaceの設定で決まるため表示のみ。

Page1/2共通
Edit Look：Lookとして使用するLUTを設定する。
s709 / R709(800%) / S-Gamut3.Cine/SLog3 / S-Gamut3/SLog3 / 
User 3D LUT

WB（White Balance） ホワイトバランスの色温度／色合いを設定する。
工場出荷時の選択肢

3200K+00/4300K+00/5500K+00
（Step Editボタン（ITEMキー 4）を押すとホワイトバランスのプリセット値と
Tint値を変更できます。）
Auto White Bal.：オートホワイトバランスを実行する。

1) ハイフレームレートライセンス有効時のみ。
2) プロジェクトフレームレートが59.94の場合は1/60以降の値、50.0の場合は1/50以降の値、29.97の場合は1/30以降
の値、25.0の場合は1/25以降の値が選択肢となります。
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ユーザー機能画面
USERボタン（10ページ）を押すと、サブディ
スプレイにユーザー機能画面が表示され、ITEM
キー 1～ 5をアサイナブルボタン（User 1～ 5）
として機能させることができます。
また、機能を割り当てて使用できるアサイナブ
ルボタン（1～ 4）が4個（8、9、10ペー
ジ）と、ビューファインダー（DVF-EL200）ア
サイナブルボタン（A ～ C）があります。
これらのボタンへの機能の割り当てはユーザー
機能画面で行えるほか、フルメニューのProject
メニュー > Assignable Buttonで行えます。
 

ITEMキー 4 ITEMキー 5 ITEMキー 6

ITEMキー 3ITEMキー 2ITEMキー 1

［ご注意］
アイリス設定表示対応レンズ装着時は、ユーザー機能画面
の左側中央にアイリスの位置が表示されます。

ボタンの機能を変更する

ユーザー機能画面のEdit（ITEMキー 6）を押すと
ユーザー機能選択画面が表示されます。ユーザー
機能選択画面で、User1 ～ 5とアサイナブルボ
タン1 ～ 4、ビューファインダーアサイナブル
ボタンA ～ Cの機能を設定します。

1	ユーザー機能選択画面で、変更したいボタ
ンにカーソルを合わせ、Select（ITEMキー 3）
を押す。
選択可能な機能が表示されます。

2	  ボタン（ITEMキー 2）、  ボタン（ITEM
キー 5）またはMENUダイヤルで、設定値を
変更する。

3	設定値が決まったら、Setボタン（ITEMキー 3）
を押す。
画面がユーザー機能画面に切り換わり、変
更した機能が表示されます。

工場出荷時には、それぞれ下表に示す機能が割り当てられています。

ボタン 機能 Assignable Buttonの設定
アサイナブル1 高輝度のためクリップされた箇所を赤色にして

ビューファインダーに表示する。
VF Highlight Clip Ind

アサイナブル2 未設定 Not Assigned
アサイナブル3 未設定 Not Assigned
アサイナブル4 未設定 Not Assigned
ITEMキー 1 未設定 Not Assigned
ITEMキー 2 未設定 Not Assigned
ITEMキー 3 未設定 Not Assigned
ITEMキー 4 高輝度のためクリップされた箇所を赤色にして

Monitor出力に表示する。
Monitor Highlight Clip Ind

ITEMキー 5 ファンの回転方法を設定する。 Fan Mode
ビューファインダー
アサイナブルA

ビューファインダーのピント拡大機能をオン／
オフする。

VF Focus Magnifier

ビューファインダー
アサイナブルB

ビューファインダーに表示するフォルスカラー
機能をオン／オフする。

VF False Color

ビューファインダー
アサイナブルC

ビューファインダー・モニター画面出力映像へ
の情報の表示をオン／オフする。

VF Status Info

ITEMキー 1～ 5に割り当て可能な機能

Assignable Buttonの
設定

機能 電源再投入時の状態

No Assign 未設定 －
SDI Frame Line SDI 3/4出力映像へのフレームラインの重畳を

オン／オフする。
設定を保持する

SDI Status Info SDI 3/4出力映像への情報の表示をオン／オフ
する。

設定を保持する

Press & Hold for SDI 
Log1)

押している間だけSDI 3/4出力映像に適用して
いるLUTをOffにして、LUTを適用しないLogの
画質にする。

設定を保持しない

Monitor Frame Line Monitor出力映像へのフレームラインの重畳を
オン／オフする。

設定を保持する

Monitor Status Info Monitor出力映像への情報の表示をオン／オフ
する。

設定を保持する



000 3章　カメラ操作：ユーザー機能画面44

Assignable Buttonの
設定

機能 電源再投入時の状態

Monitor Focus 
Magnifier2)3)

Monitor出力映像のピント拡大機能をオン／オ
フする。

設定を保持しない

Press & Hold for 
Monitor Log4)

押している間だけMonitor出力映像に適用して
いるLUTをOffにして、LUTを適用しない画質に
する。

設定を保持しない

Monitor Highlight 
Clip Ind1)

高輝度のためクリップされた箇所を赤色にして
Monitor出力映像に表示する機能をオン／オフ
する。

設定を保持する

Monitor False Color1) モニターに表示するフォルスカラー機能をオン／
オフする。

設定を保持する

Color Bars5) カラーバーをオン／オフする。 設定を保持する
AXS Slot Change AXSメモリーカードが2枚挿入されているとき

のアクティブスロットを切り換える。
キーを押すたびにAとBが切り換わる。

設定を保持する

SxS Slot Change SxSメモリーカードが2枚挿入されているとき
のアクティブスロットを切り換える。
キーを押すたびにAとBが切り換わる。

設定を保持する

Fan Mode ファンの回転方法を選択する。
ボタンを押すたびにAuto→Max→Off in Rec/
Auto→Off in Rec/Maxと切り換わる。

設定を保持する

Format Media AXS 
Slot A

AXS Slot Aをフォーマットする。 －

Format Media AXS 
Slot B

AXS Slot Bをフォーマットする。 －

Format Media SxS 
Slot A

SxS Slot Aをフォーマットする。 －

Format Media SxS 
Slot B

SxS Slot Bをフォーマットする。 －

APR APRを実行する。 －
PL-Mt Interface 
Position

PLマウントレンズのインターフェース位置を設
定する。
キーを押すたびにTop→Side→Offと切り換わ
る。

設定を保持する

VF Highlight Clip 
Ind1)

高輝度のためクリップされた箇所を赤色にして
ビューファインダーに表示する機能をオン／オ
フする。

設定を保持する

VF False Color1) ビューファインダーに表示するフォルスカラー
機能をオン／オフする。

設定を保持する

Assignable Buttonの
設定

機能 電源再投入時の状態

Auto White 
Balance5)

オートホワイトバランスを実行する。 －

Picture Cache Rec ピクチャーキャッシュレック機能をオン／オフ
する。

設定を保持する

Iris Open (1/16 
stop)6)

レンズのアイリスをOpen側に動かす。
押し続けると連続的にOpen端まで動き続け
る。
電動アイリス対応のEマウントレンズ装着時に
有効な機能です。
1/16 stop刻みの設定に対して、アイリス表示
は1/3stop単位になります。

－

Iris Close (1/16 
stop)6)

レンズのアイリスをClose側に動かす。
押し続けると連続的にClose端まで動き続ける。
電動アイリス対応のEマウントレンズ装着時に
有効な機能です。
1/16 stop刻みの設定に対して、アイリス表示
は1/3stop単位になります。

－

H & V Flip7) 撮影モード時、画像を上下左右反転する機能を
オン／オフする。

設定を保持する

1） Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnに設定されている場合は、
キーを押しても何も動作しません。

2) HDMI出力がMonitor出力と同じ出力フォーマットの場合、HDMI出力も連動します。Monitoringメニュー > OSD 
Appearance > HDMI（73ページ）で設定を確認できます。HDMIがSame as Monitorに設定されている場合、
HDMI出力はMonitor出力と同じです。

3) SDIの出力フォーマットが1920x1080iの場合は、ピント拡大機能がオフになり、キーを押しても何も動作しません。
4) 押している間だけ、Projectメニュー > Basic Setting > Input Color Space（67ページ）で選択した本線と同じ映像
に切り換わります。

5） Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnで、RM-B170などのリモー
トコントロールユニット接続時は、キーを押しても何も動作しません。

6） RM-B170などのリモートコントロールユニット接続時は、キーを押しても何も動作しません。
7) Technical > Special Configuration > Flip Image（81ページ）のH & V Flipがグレーアウトされているときは、キー
を押しても何も動作しません。
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アサイナブル1～ 4ボタンに割り当て可能な機能

Assignable Buttonの設定 機能 電源再投入時の状態
No Assign 未設定 －
SDI Frame Line SDI 3/4出力映像へのフレームラインの重畳

をオン／オフする。
設定を保持する

SDI Status Info SDI 3/4出力映像への情報の表示をオン／オ
フする。

設定を保持する

Press & Hold for SDI Log1) 押している間だけSDI 3/4出力映像に適用し
ているLUTをOffにして、LUTを適用しない
Logの画質にする。

設定を保持しない

Monitor Frame Line Monitor出力映像へのフレームラインの重
畳をオン／オフする。

設定を保持する

Monitor Status Info Monitor出力映像への情報の表示をオン／
オフする。

設定を保持する

Monitor Focus Magnifier2)3) Monitor出力映像のピント拡大機能をオン
／オフする。

設定を保持しない

Press & Hold for Monitor 
Log4)

押している間だけMonitor出力映像に適用
しているLUTをOffにして、LUTを適用しな
いLogの画質にする。

設定を保持しない

Monitor Highlight Clip Ind1) 高輝度のためクリップされた箇所を赤色に
してMonitor出力映像に表示する機能をオ
ン／オフする。

設定を保持する

Monitor High/Low Key1) Monitor出力の状態を選択する。
ボタンを押すたびにHigh Key（高輝度の白
飛び確認画面）Low Key（低輝度の暗部の
確認画面）Off（通常画面）と切り換わる。

設定を保持しない

Monitor False Color1) モニターに表示するフォルスカラー機能を
オン／オフする。

設定を保持する

Color Bars5) カラーバーをオン／オフする。 設定を保持する
AXS Slot Change AXSメモリーカードが2枚挿入されていると

きのアクティブスロットを切り換える。
ボタンを押すたびにAとBが切り換わる。

－

SxS Slot Change SxSメモリーカードが2枚挿入されていると
きのアクティブスロットを切り換える。
ボタンを押すたびにAとBが切り換わる。

－

Rec Review レックレビュー機能の実行。 設定を保持しない

Assignable Buttonの設定 機能 電源再投入時の状態
VF Frame Line ビューファインダー・モニター画面出力映

像へのフレームラインの重畳をオン／オフ
する。

設定を保持する

VF Zebra ビューファインダー・モニター画面出力映
像のゼブラ機能をオン／オフする。

設定を保持する

VF Status Info ビューファインダー・モニター画面出力映
像への情報の表示をオン／オフする。

設定を保持する

VF Focus Magnifier ビューファインダーのピント拡大機能をオ
ン／オフする。

設定を保持しない

Press & Hold for VF Log6) 押している間だけビューファインダー・モ
ニター画面出力映像に適用しているLUTを
Offにして、LUTを適用しない画質にする。

設定を保持しない

VF Highlight Clip Ind1) 高輝度のためクリップされた箇所を赤色に
してビューファインダーに表示する機能を
オン／オフする。

設定を保持する

VF High/Low Key1) ビューファインダー出力の状態を選択する。
ボタンを押すたびにHigh Key（高輝度の白
飛び確認画面）→Low Key（低輝度の暗部の
確認画面）→Off（通常画面）と切り換わる。

設定を保持しない

VF False Color1) ビューファインダーに表示するフォルスカ
ラー機能をオン／オフする。

設定を保持する

Auto White Balance5) オートホワイトバランスを実行する。オー
トホワイトバランス実行中に中断する。

－

Picture Cache Rec ピクチャーキャッシュレック機能をオン／
オフする。

設定を保持する

Iris Open (1/16 stop)7) レンズのアイリスをOpen側に動かす。
押し続けると連続的にOpen端まで動き続け
る。
電動アイリス対応のEマウントレンズ装着時
に有効な機能です。
1/16 stop刻みの設定に対して、アイリス表
示は1/3stop単位になります。

－

Iris Close (1/16 stop)7) レンズのアイリスをClose側に動かす。
押し続けると連続的にClose端まで動き続け
る。
電動アイリス対応のEマウントレンズ装着時
に有効な機能です。
1/16 stop刻みの設定に対して、アイリス表
示は1/3stop単位になります。

－
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Assignable Buttonの設定 機能 電源再投入時の状態
ND +1stop NDフィルターを濃度の濃い側に切り換え

る。
－

ND -1stop NDフィルターを濃度の薄い側に切り換え
る。

－

Rec 記録を開始／停止する。 －
H & V Flip8) 撮影モード時、画像を上下左右反転する機

能をオン／オフする。
設定を保持する

1） Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnに設定されている場合は、
ボタンを押しても何も動作しません。

2) HDMI出力がMonitor出力と同じ出力フォーマットの場合、HDMI出力も連動します。Monitoringメニュー > OSD 
Appearance > HDMI（73ページ）で設定を確認できます。HDMIがSame as Monitorに設定されている場合、
HDMI出力はMonitor出力と同じです。

3) SDIの出力フォーマットが1920x1080iの場合は、ピント拡大機能がオフになり、ボタンを押しても何も動作しません。
4) 押している間だけ、Projectメニュー > Basic Setting > Input Color Space（67ページ）で選択した本線と同じ映像
に切り換わります。

5） Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnで、RM-B170などのリモー
トコントロールユニット接続時は、ボタンを押しても何も動作しません。

6) Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnで、Shootingメニュー > 
LUT Select > VF LUT（64ページ）がR709(800%)またはR709-Likeに設定されている場合は、押している間だけ本線
と同じ映像に切り換わります。または、RM/RCP Paint ControlがOffで、VF LUTがLog以外に設定されている場合は、
押している間だけ本線と同じ映像に切り換わります。

7） RM-B170などのリモートコントロールユニット接続時は、ボタンを押しても何も動作しません。
8) Technical > Special Configuration > Flip Image（81ページ）のH & V Flipがグレーアウトされているときは、ボタ
ンを押しても何も動作しません。

ビューファインダー（DVF-EL200）アサイナブルA ～ Cボ
タンに割り当て可能な機能

Assignable Buttonの設定 機能 電源再投入時の状態
No Assign 未設定 －
Color Bars1) カラーバーをオン／オフする。 設定を保持する
AXS Slot Change AXSメモリーカードが2枚挿入されていると

きのアクティブスロットを切り換える。
ボタンを押すたびにAとBが切り換わる。

－

SxS Slot Change SxSメモリーカードが2枚挿入されていると
きのアクティブスロットを切り換える。
ボタンを押すたびにAとBが切り換わる。

－

Assignable Buttonの設定 機能 電源再投入時の状態
Rec Review レックレビュー機能の実行。 設定を保持しない
VF Frame Line ビューファインダー・モニター画面出力映

像へのフレームラインの重畳をオン／オフ
する。

設定を保持する

VF Zebra ビューファインダー・モニター画面出力映
像のゼブラ機能をオン／オフする。

設定を保持する

VF Status Info ビューファインダー・モニター画面出力映
像への情報の表示をオン／オフする。

設定を保持する

VF Focus Magnifier ビューファインダーのピント拡大機能をオ
ン／オフする。

設定を保持しない

Press & Hold for VF Log2) 押している間だけビューファインダー・モ
ニター画面出力映像に適用しているLUTを
Offにして、LUTを適用しない画質にする。

設定を保持しない

VF Highlight Clip Ind3) 高輝度のためクリップされた箇所を赤色に
してビューファインダーに表示する機能を
オン／オフする。

設定を保持する

VF High/Low Key3) ビューファインダー出力の状態を選択する。
ボタンを押すたびにHigh Key（高輝度の白
飛び確認画面）→Low Key（低輝度の暗部の
確認画面）→Off（通常画面）と切り換わる。

設定を保持しない

VF False Color3) ビューファインダーに表示するフォルスカ
ラー機能をオン／オフする。

設定を保持する

Picture Cache Rec ピクチャーキャッシュレック機能をオン／
オフする。

設定を保持する

Iris Open (1/16 stop)4) レンズのアイリスをOpen側に動かす。
押し続けると連続的にOpen端まで動き続け
る。
電動アイリス対応のEマウントレンズ装着時
に有効な機能です。
1/16 stop刻みの設定に対して、アイリス表
示は1/3 stop単位になります。

－

Iris Close (1/16 stop)4) レンズのアイリスをClose側に動かす。
押し続けると連続的にClose端まで動き続け
る。
電動アイリス対応のEマウントレンズ装着時
に有効な機能です。
1/16 stop刻みの設定に対して、アイリス表
示は1/3 stop単位になります。

－

ND +1stop NDフィルターを濃度の濃い側に切り換え
る。

－
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Assignable Buttonの設定 機能 電源再投入時の状態
ND -1stop NDフィルターを濃度の薄い側に切り換え

る。
－

Rec 記録を開始／停止する。 －
H & V Flip5) 撮影モード時、画像を上下左右反転する機

能をオン／オフする。
設定を保持する

1） Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnで、RM-B170などのリモー
トコントロールユニット接続時は、ボタンを押しても何も動作しません。

2) 押している間だけ、Projectメニュー > Basic Setting > Input Color Space（67ページ）で選択した本線と同じ映像
に切り換わります。

3） Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnに設定されている場合は、
ボタンを押しても何も動作しません。

4） RM-B170などのリモートコントロールユニット接続時は、ボタンを押しても何も動作しません。
5) Technical > Special Configuration > Flip Image（81ページ）のH & V Flipがグレーアウトされているときは、ボタ
ンを押しても何も動作しません。
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メニューの操作方法
撮影中（記録中/記録待機中）および再生中に
MENUボタンを押すと、サブディスプレイにメ
ニュー画面が表示され、操作することができます。

ˎˎ Projectカテゴリー：基本設定、記録フォーマッ
トの設定

ˎˎ TC/Mediaカテゴリー：タイムコードの値や
TCフォーマットの設定
ˎˎ Monitoringカテゴリー：SDI、HDMI、
Monitorの各外部出力の信号フォーマットや
OSDやマーカーの重畳状態の設定
ˎˎ Audioカテゴリー：オーディオのソースやレ
ベルなどの設定

ˎˎ Infoカテゴリー：カメラやメディア、バッテ
リーなどの状態確認

操作部

MENUボタン（9ページ）
サブディスプレイにメニューが表示されます。

ITEMキー 1～ 6（9ページ）
メニューのカテゴリーを選びます。

SEL/SET ダイヤル（MENUダイヤル） 
（9ページ）
回すとカーソルが上下に移動して、設定項目や
設定値を選択できます。
MENUダイヤルを押すと、選択している項目を
決定します。

BACKボタン（10ページ）
1つ前の階層に戻ります。確定前の変更はキャ
ンセルされます。

基本操作

1	 MENUボタンを押す。
メニュー画面が表示されます。

2	 ITEMキー 1～ 6で設定したいカテゴリーを
選ぶ。

3	 MENUダイヤルで、選択項目にカーソルを
合わせる。
各設定項目には、設定値が表示されていま
す。

 ˜「メニュー設定項目一覧」（49ページ）

4	 MENUダイヤルを押す。
選んだ項目の横に、設定値の選択画面が表
示されます。

5	 MENUダイヤルで設定値にカーソルを合わ
せる。

6	 MENUダイヤルを押して決定する。
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メニュー設定項目一覧

各カテゴリーの設定内容は以下のとおりです。

Projectカテゴリー

太字とアンダーラインで表示されている設定値は、出荷時の設定です。

項目 設定値 内容
Imager Mode 6K 3:2/6K 1.85:1/6K 17:9/ 

6K 2.39:1/5.7K 16:9/ 
4K 6:5/4K 4:3/4K 4:3 
Surround View/4K 17:9/ 
4K 17:9 Surround View/ 
4K 2.39:1/3.8K 16:9/3.8K 
16:9 Surround View

有効画サイズを設定する。

[ご注意]

ˎˎ 6K 3:2/6K 1.85:1/6K 17:9はフルフレームライセ
ンスインストール時のみ表示されます。
ˎˎ 4K 6:5/4K 4:3/4K 4:3 Surround Viewはアナモ
フィックライセンスインストール時のみ表示され
ます。

Project Frame Rate 23.98/24/25/29.97/47.95/ 
50/59.94

プロジェクトフレームレートを設定する。

Input Color Space S-Gamut3.Cine/SLog3 / 
S-Gamut3/SLog3 /  
HLG(Natural) / HLG(Live) / 
Rec.2020/User Gamma / 
Rec.709/User Gamma

色域を設定する。

［ご注意］

ˎˎ HLG(Natural) / HLG(Live) / Rec.2020/User 
Gamma / Rec.709/User Gammaは、Technical
メニュー > System Configuration > RM/RCP 
Paint Control（81ページ）がOnに設定されて
いる場合のみ選択できます。
ˎˎ HLG(Natural)はHLG BT.2100と同等です。

AXS Rec Format1)

（AXS-R7装着時のみ）
Rec Off/X-OCN XT/ 
RAW SQ/X-OCN ST/ 
X-OCN LT

AXS-R7接続時にAXSメモリーカードに記録す
るフォーマットを設定する。

SxS Rec Format1) Rec Off/XAVC 4K Class480/
XAVC 4K Class300/ 
XAVC QFHD Class480/ 
XAVC QFHD Class300/ 
MPEG HD P/MPEG HD i/
ProRes 4444 HD P/ 
ProRes 422 HQ HD P/ 
ProRes 422 HQ HD i/ 
ProRes 422 HD P/ 
ProRes 422 HD i/ 
ProRes Proxy HD P/ 
ProRes Proxy HD i

SxSメモリーカードにメインとして記録する
フォーマットを設定する。

［ご注意］

ˎˎ ProRes 4444 HD Pは、以下の有効画サイズにの
み対応しています。

 – 5.7K 16:9
 – 4K 6:5
 – 4K 4:3
 – 3.8K 16:9

ˎˎ Input Color SpaceがHLG(Natural)、 HLG(Live)
またはRec.2020/User Gammaに設定されている
場合、ProRes 4444 HD Pは選択できません。

項目 設定値 内容
Sub Rec Format1) Rec Off/MPEG HD P/MPEG 

HD i/ProRes 422 Proxy HD 
P/ProRes 422 Proxy HD i

SxSメモリーカードにサブとして記録する
フォーマットを設定する。

Project Details
（ITEMキー 6）

フルメニューのProjectメニュー（67ペー
ジ）の内容が表示されます。

1) 有効画サイズやプロジェクトフレームレートの組み合わせによって、設定可能な記録フォーマットは異なります。「記
録フォーマット設定表」（53ページ）を参照し、設定してください。

TC/Mediaカテゴリー

太字とアンダーラインで表示されている設定値は、出荷時の設定です。

項目 設定値 内容
TC Mode Preset F-Run (Ext-Lk)/

Preset R-Run/Int Regen
タイムコードの歩進モードを設定す
る。
Preset F-Run (Ext-Lk)：記録に関係な
く設定された状態から常に歩進する。
Preset R-Run：記録時のみ設定された
状態から歩進する。
Int Regen：前のクリップのタイムコー
ドに続けて歩進する。

TC Display Timecode/Duration タイムデータの表示を切り換える。

TC Setting
（別画面に移行して
設定）

Setting 
(H、M、S、F)

タイムコードを任意の値に設定する。

Reset タイムコードを00:00:00:00にリ
セットする。

TC Format DF/NDF タイムコードのフォーマットを設定す
る。
DF：ドロップフレーム
NDF：ノンドロップフレーム

TC Source Internal/External 表示のみ。

Cam ID A～ Z クリップ名の生成時のカメラIDを設定
する。
クリップ名：Camera ID + Reel 
Number + Shot Number + 年月日 + 
ランダム文字列
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項目 設定値 内容
Reel# 001～ 999 クリップ名の生成時のReel Number

の数字部分を設定する。
クリップ名：Camera ID + Reel 
Number + Shot Number + 年月日 + 
ランダム文字列

Camera Position C/L/R クリップ名の生成時のShot Number
の先頭文字部分を設定する。
クリップ名：Camera ID + Reel 
Number + Shot Number + 年月日 + 
ランダム文字列

Format Media
（別画面に移行して
実行）

AXS Slot A スロットAのAXSメモリーカードを初
期化する。

AXS Slot B スロットBのAXSメモリーカードを初
期化する。

SxS Slot A スロットAのSxSメモリーカードを初
期化する。

SxS Slot B スロットBのSxSメモリーカードを初期
化する。

SD Card SDカードを初期化する。
Media Details
（ITEMキー 6）

フルメニューのTC/Mediaメニュー
（71ページ）の内容が表示されます。

Monitoringカテゴリー

太字とアンダーラインで表示されている設定値は、出荷時の設定です。

[ご注意]

ˎˎ 本機では、Status InfoとFrame Lineの2種類を系統別に設定できます。AとBの出力映像の表示情報は、Monitoring
メニュー（72ページ）で設定してください。
ˎˎ Output Formatの設定によってInfoおよびFrame Lineが表示できない場合があります。その際は「-」が表示され、設
定値の変更ができません。

項目 設定値 内容
VF Status Info Info A/Info B/Off ビューファインダーの映像に重畳して

表示する情報を選択する。
Frame Line Line A/Line B/Off ビューファインダーの映像に重畳して

表示するフレームラインを選択する。

項目 設定値 内容
SDI 1/2 Output 

Format
Imager Mode、プロジェク
トフレームレート、SxS記録
フォーマットの設定に応じ
て変わる。

SDI 1/2出力フォーマットを選択す 
る。1)

Status Info － SDI 1/2出力には情報表示は重畳され
ません。

Frame Line Line A/Line B/Off SDI 1/2出力に重畳して表示するフ
レームラインを選択する。

[ご注意]
出力フォーマットが4K/QFHD以外のときは
フレームラインは重畳されません。

SDI 3/4

[ご注意]
SDI 1/2のOutput 
Formatの設定に
よっては、SDI 3/4
のOutput Format、
Info、Frame Lineが
空欄となり、設定値の
変更ができません。

Output 
Format

SDI 1/2の設定に応じて変
わる。

SDI 3/4出力フォーマットを選択す 
る。1)

Status Info Info A/Info B/Off SDI 3/4出力に重畳して表示する情報
を選択する。

Frame Line Line A/Line B/Off SDI 3/4出力に重畳して表示するフ
レームラインを選択する。

Monitor Output 
Format

SDI 1/2の設定に応じて変
わる。

Monitor出力フォーマットを選択す
る。2)

Status Info Info A/Info B/Off Monitor出力に重畳して表示する情報
を選択する。

Frame Line Line A/Line B/Off Monitor出力に重畳して表示するフ
レームラインを選択する。

HDMI Output 
Format

SDI 1/2の設定に応じて変
わる。

HDMI出力フォーマットを選択する。2)

Moni. Details
（ITEMキー 6）

フルメニューのMonitoringメニュー
（72ページ）の内容が表示されます。

1) 選択可能なフォーマットは「SDI OUT端子の出力フォーマット」（119ページ）を参照してください。
2) 選択可能なフォーマットは「MONITOR OUT端子/HDMI OUT端子の出力フォーマット」（123ページ）を参照してく
ださい。
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Audioカテゴリー

太字とアンダーラインで表示されている設定値は、出荷時の設定です。

項目 設定値 内容
Source Switch LINE / AES/EBU / MIC CH1とCH-2の入力源を設定するAUDIO INス

イッチ（10ページ）の位置が表示される。
CH-1 Audio Level Auto/Manual

－99～±0～＋99
Autoにすると、録音レベルは自動調整される。
Manualを選択時、手動で録音レベルを調整す
る。

CH-2 Audio Level Auto/Manual
－99～±0～＋99

Autoにすると、録音レベルは自動調整される。
Manualを選択時、手動で録音レベルを調整す
る。

MIC Reference －60dB/－50dB/－40dB マイクの基準入力レベルを選択する。

Monitor CH Monitor Output CH Pairが
CH-1/CH-2の場合

CH-1/CH-2、CH-1、
CH-2

Monitor Output CH Pairが
CH-3/CH-4の場合

CH-3/CH-4、CH-3、
CH-4

ヘッドホンおよびスピーカーに出力する音声
チャンネルを選択する。

Monitor Level 0～ 99 モニター音量を調整する。

CH1 Level Meter － CH1のレベルメーターが表示される。

CH2 Level Meter － CH2のレベルメーターが表示される。

CH3 Level Meter － CH3のレベルメーターが表示される。

CH4 Level Meter － CH4のレベルメーターが表示される。

Audio Details
（ITEMキー 6）

フルメニューのAudioメニュー（78ページ）
の内容が表示されます。

Infoカテゴリーで本機の状態を確認する

Infoカテゴリーでは、メディアやバッテリーなどの状態や、発生している警告やエラーの内容を確
認できます。本機の状態の変化に応じて、表示内容がリアルタイムに更新されます。
Infoカテゴリーは、次の7種類の情報ページで構成されています。MENUダイヤルを回すと、ページ
を移動できます。

No. ページ 内容
1 Camera Condition 警告メッセージとエラーメッセージが表示されます。何

もメッセージがないときは、一番上の表示エリアに「All 
Systems are OK」が表示されます。

2 Firmware 本機のシリアルナンバーやファームウェアバージョン、本
機に装着したAXS-R7のシリアルナンバーやファームウェア
バージョンが表示されます。

3 License 本機のオプションのライセンス名称とインストール状態また
は期限が表示されます。オプションを追加していないときは、
インストール状態表示は「Not Installed」または「Expired」と
なります。

4 System 次のシステム情報が表示されます。
ˎˎ 設定日時
ˎˎ ファン回転速度
ˎˎ センサー検出温度
ˎˎ アワーズメーター
ˎˎ IP Address

［ご注意］

ˎˎ センサー検出温度は、検出温度が65℃以上のときはHigh Tempの
警告状態となります。
ˎˎ IPアドレスを取得できない場合は「0.0.0.0」が表示されます。

5 Battery 次のバッテリー情報が表示されます。
ˎˎ 検出されたバッテリーの品名または種類
ˎˎ 残容量（パーセント）
ˎˎ 予想残時間
ˎˎ 残容量（Ah）
ˎˎ 電圧（V）
ˎˎ 充電を行った回数
ˎˎ 電源供給源
ˎˎ 供給電源電圧

6 Media SxSメモリーカード、AXSメモリーカード（AXS-R7装着時）、
SDカードの残量と記録可能時間、寿命データが表示されます。
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No. ページ 内容
7 Lens 本機に装着されている次のレンズ情報が表示されます。

ˎˎ レンズの型名
ˎˎ アイリスのT値

 ［ご注意］
T値が取得できない場合など、T値ではなくF値が表示される場合
があります。

ˎˎ 焦点距離
ˎˎ フォーカス距離
ˎˎ 被写界深度
ˎˎ シリアルナンバー

8 Network 次のネットワーク接続の設定情報が表示されます。
ˎˎ 設定状態（LAN/Wireless Access Point/Wireless Station/
Off）
ˎˎ IP Address
ˎˎ SSID
ˎˎ MAC Address

［ご注意］
IPアドレスを取得できない場合は「0.0.0.0」が表示されます。
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記録フォーマット設定表

有効画サイズやプロジェクトフレームレートの組み合わせによって、以下の記録フォーマットの設定が可能です。
太字とアンダーラインで表示されている値を選択した場合、記録される映像信号にLogまたはLUT設定が適用可能になります。

AXS Rec FormatとSxS Rec Formatの組み合わせ

有効画サイズ（Imager Mode） メイン記録フォーマット Project Frame Rate
AXS Rec Format SxS Rec Format 23.98 24.00 25.00 29.97 47.95 50.00 59.94 

6K 3:2
（6048x4032）

X-OCN XT
X-OCN ST
X-OCN LT

None ○ ○ ○ ○ ○ ○ ○
4K XAVC-I Class480 ○ ○ ○ ○ － － －
4K XAVC-I Class300 ○ ○ ○ ○ － ○ ○
MPEG HD422 P ○ － ○ ○ － － －
MPEG HD422 i － － － － － ○ ○
FHD ProRes 422 HQ P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 Proxy P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 Proxy i － － － － － ○ ○

6K 1.85:1
（6054x3272）

X-OCN XT
X-OCN ST
X-OCN LT

None ○ ○ ○ ○ ○ ○ ○
4K XAVC-I Class480 ○ ○ ○ ○ － － －
4K XAVC-I Class300 ○ ○ ○ ○ － ○ ○
MPEG HD422 P ○ － ○ ○ － － －
MPEG HD422 i － － － － － ○ ○
FHD ProRes 422 HQ P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 Proxy P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 Proxy i － － － － － ○ ○
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有効画サイズ（Imager Mode） メイン記録フォーマット Project Frame Rate
AXS Rec Format SxS Rec Format 23.98 24.00 25.00 29.97 47.95 50.00 59.94 

6K 17:9
（6054x3192）

X-OCN XT
X-OCN ST
X-OCN LT

None ○ ○ ○ ○ ○ ○ ○
4K XAVC-I Class480 ○ ○ ○ ○ － － －
4K XAVC-I Class300 ○ ○ ○ ○ － ○ ○
MPEG HD422 P ○ － ○ ○ － － －
MPEG HD422 i － － － － － ○ ○
FHD ProRes 422 HQ P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 Proxy P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 Proxy i － － － － － ○ ○

6K 2.39:1
（6048x2534）

X-OCN XT
X-OCN ST
X-OCN LT

None ○ ○ ○ ○ ○ ○ ○
4K XAVC-I Class480 ○ ○ ○ ○ － － －
4K XAVC-I Class300 ○ ○ ○ ○ － ○ ○
MPEG HD422 P ○ － ○ ○ － － －
MPEG HD422 i － － － － － ○ ○
FHD ProRes 422 HQ P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 Proxy P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 Proxy i － － － － － ○ ○

5.7K 16:9
（5674x3192）

X-OCN XT
X-OCN ST
X-OCN LT

None ○ ○ ○ ○ － － －
QFHD XAVC-I Class480 ○ － ○ ○ － － －
QFHD XAVC-I Class300 ○ － ○ ○ － － －
MPEG HD422 P ○ － ○ ○ － － －
FHD ProRes 422 HQ P ○ ○ ○ ○ － － －
FHD ProRes 422 P ○ ○ ○ ○ － － －
FHD ProRes 422 Proxy P ○ ○ ○ ○ － － －

4K 6:5
（4096x3432）

X-OCN XT
X-OCN ST
X-OCN LT

None ○ ○ ○ ○ － － －
4K XAVC-I Class480 ○ ○ ○ ○ － － －
4K XAVC-I Class300 ○ ○ ○ ○ － － －
MPEG HD422 P ○ － ○ ○ － － －
FHD ProRes 422 HQ P ○ ○ ○ ○ － － －
FHD ProRes 422 P ○ ○ ○ ○ － － －
FHD ProRes 422 Proxy P ○ ○ ○ ○ － － －
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有効画サイズ（Imager Mode） メイン記録フォーマット Project Frame Rate
AXS Rec Format SxS Rec Format 23.98 24.00 25.00 29.97 47.95 50.00 59.94 

4K 4:3
（4096x3024）

X-OCN XT
X-OCN ST
X-OCN LT

None ○ ○ ○ ○ ○ ○ ○
4K XAVC-I Class480 ○ ○ ○ ○ － － －
4K XAVC-I Class300 ○ ○ ○ ○ － ○ ○
MPEG HD422 P ○ － ○ ○ － － －
MPEG HD422 i － － － － － ○ ○
FHD ProRes 422 HQ P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 Proxy P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 Proxy i － － － － － ○ ○

4K 4:3 Surround
（4096x3024）
撮像画サイズ
（4552x3360）

X-OCN XT
X-OCN ST
X-OCN LT

None ○ ○ ○ ○ － － －
MPEG HD422 P ○ － ○ ○ － － －
FHD ProRes 422 HQ P ○ ○ ○ ○ － － －
FHD ProRes 422 P ○ ○ ○ ○ － － －
FHD ProRes 422 Proxy P ○ ○ ○ ○ － － －

4K 17:9
（4096x2160）

X-OCN XT
RAW SQ
X-OCN ST
X-OCN LT

None ○ ○ ○ ○ ○ ○ ○
4K XAVC-I Class480 ○ ○ ○ ○ － － －
4K XAVC-I Class300 ○ ○ ○ ○ － ○ ○
MPEG HD422 P ○ － ○ ○ － － －
MPEG HD422 i － － － － － ○ ○
FHD ProRes 422 HQ P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 HQ i － － － － － ○ ○
FHD ProRes 422 P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 i － － － － － ○ ○
FHD ProRes 422 Proxy P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 Proxy i － － － － － ○ ○

4K 17:9 Surround
（4096x2160）
撮像画サイズ
（4552x2400）

X-OCN XT
RAW SQ
X-OCN ST
X-OCN LT

None ○ ○ ○ ○ － － －
MPEG HD422 P ○ － ○ ○ － － －
FHD ProRes 422 HQ P ○ ○ ○ ○ － － －
FHD ProRes 422 P ○ ○ ○ ○ － － －
FHD ProRes 422 Proxy P ○ ○ ○ ○ － － －

4K 4096x1716 2.39:1 X-OCN XT
X-OCN ST
X-OCN LT

None ○ ○ ○ ○ ○ ○ ○
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有効画サイズ（Imager Mode） メイン記録フォーマット Project Frame Rate
AXS Rec Format SxS Rec Format 23.98 24.00 25.00 29.97 47.95 50.00 59.94 

3.8K (QFHD) 16:9
（3840x2160）

X-OCN XT
RAW SQ
X-OCN ST
X-OCN LT

None ○ ○ ○ ○ － ○ ○
QFHD XAVC-I Class480 ○ － ○ ○ － － －
QFHD XAVC-I Class300 ○ － ○ ○ － ○ ○
MPEG HD422 P ○ － ○ ○ － － －
MPEG HD422 i － － － － － ○ ○
FHD ProRes 422 HQ P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 HQ i － － － － － ○ ○
FHD ProRes 422 P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 i － － － － － ○ ○
FHD ProRes 422 Proxy P ○ ○ ○ ○ － ○ ○
FHD ProRes 422 Proxy i － － － － － ○ ○

3.8K (QFHD) 16:9 Surround
（3840x2160）
撮像画サイズ
（4268x2400）

X-OCN XT
RAW SQ
X-OCN ST
X-OCN LT

None ○ ○ ○ ○ － － －
MPEG HD422 P ○ － ○ ○ － － －
FHD ProRes 422 HQ P ○ ○ ○ ○ － － －
FHD ProRes 422 P ○ ○ ○ ○ － － －
FHD ProRes 422 Proxy P ○ ○ ○ ○ － － －

SxS Rec FormatとSub Rec Formatの組み合わせ

有効画サイズ（Imager Mode） 記録フォーマット Project Frame Rate
SxSメイン記録フォーマット 
（SxS Rec Format）1）

SxSサブ記録フォーマット 
（Sub Rec Format）2）

23.98 24.00 25.00 29.97 47.95 50.00 59.94

6K 3:2
（6048x4032）

4K XAVC-I Class480 None － － － － － － －
4K XAVC-I Class300 None － － － － － － －
MPEG HD422 P None － － － － － － －
FHD ProRes 422 HQ P None － － － － － － －
FHD ProRes 422 P None － － － － － － －
FHD ProRes 422 Proxy P None － － － － － － －
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有効画サイズ（Imager Mode） 記録フォーマット Project Frame Rate
SxSメイン記録フォーマット 
（SxS Rec Format）1）

SxSサブ記録フォーマット 
（Sub Rec Format）2）

23.98 24.00 25.00 29.97 47.95 50.00 59.94

6K 1.85:1
（6054x3272）

4K XAVC-I Class480 None ○ ○ ○ ○ － － －
MPEG HD422 P ○ － ○ ○ － － －
ProRes 422 Proxy P ○ ○ ○ ○ － － －

4K XAVC-I Class300 None ○ ○ ○ ○ － ○ ○
MPEG HD422 P ○ － ○ ○ － － －
MPEG HD422 i － － － － － ○ ○
ProRes 422 Proxy P ○ ○ ○ ○ － － －
ProRes 422 Proxy i － － － － － ○ ○

MPEG HD422 P None ○ － ○ ○ － － －
MPEG HD422 i None － － － － － ○ ○
FHD ProRes 422 HQ P None ○ ○ ○ ○ － ○ ○
FHD ProRes 422 P None ○ ○ ○ ○ － ○ ○

6K 17:9
（6054x3192）

4K XAVC-I Class480 None ○ ○ ○ ○ － － －
MPEG HD422 P ○ － ○ ○ － － －
ProRes 422 Proxy P ○ ○ ○ ○ － － －

4K XAVC-I Class300 None ○ ○ ○ ○ － ○ ○
MPEG HD422 P ○ － ○ ○ － － －
MPEG HD422 i － － － － － ○ ○
ProRes 422 Proxy P ○ ○ ○ ○ － － －
ProRes 422 Proxy i － － － － － ○ ○

6K 2.39:1
（6048x2534）

4K XAVC-I Class480 None ○ ○ ○ ○ － － －
MPEG HD422 P ○ － ○ ○ － － －
ProRes 422 Proxy P ○ ○ ○ ○ － － －

4K XAVC-I Class300 None ○ ○ ○ ○ － ○ ○
MPEG HD422 P ○ － ○ ○ － － －
MPEG HD422 i － － － － － ○ ○
ProRes 422 Proxy P ○ ○ ○ ○ － － －
ProRes 422 Proxy i － － － － － ○ ○

MPEG HD422 P None ○ － ○ ○ － － －
MPEG HD422 i None － － － － － ○ ○
FHD ProRes 422 HQ P None ○ ○ ○ ○ － ○ ○
FHD ProRes 422 P None ○ ○ ○ ○ － ○ ○
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有効画サイズ（Imager Mode） 記録フォーマット Project Frame Rate
SxSメイン記録フォーマット 
（SxS Rec Format）1）

SxSサブ記録フォーマット 
（Sub Rec Format）2）

23.98 24.00 25.00 29.97 47.95 50.00 59.94

5.7K 16:9
（5674x3192）

QFHD XAVC-I Class480 None ○ － ○ ○ － － －
MPEG HD422 P ○ － ○ ○ － － －
ProRes 422 Proxy P ○ － ○ ○ － － －

QFHD XAVC-I Class300 None ○ － ○ ○ － － －
MPEG HD422 P ○ － ○ ○ － － －
ProRes 422 Proxy P ○ － ○ ○ － － －

MPEG HD422 P None ○ － ○ ○ － － －
FHD ProRes 4444 P None ○ ○ ○ ○ － － －
FHD ProRes 422 HQ P None ○ ○ ○ ○ － － －
FHD ProRes 422 P None ○ ○ ○ ○ － － －

4K 6:5
（4096x3432）

4K XAVC-I Class480 None ○ ○ ○ ○ － － －
MPEG HD422 P ○ － ○ ○ － － －
ProRes 422 Proxy P ○ ○ ○ ○ － － －

4K XAVC-I Class300 None ○ ○ ○ ○ － － －
MPEG HD422 P ○ － ○ ○ － － －
ProRes 422 Proxy P ○ ○ ○ ○ － － －

MPEG HD422 P None ○ － ○ ○ － － －
FHD ProRes 4444 P (Anamorphic: None) None ○ ○ ○ ○ － － －
FHD ProRes 422 HQ P None ○ ○ ○ ○ － － －
FHD ProRes 422 P None ○ ○ ○ ○ － － －

4K 4:3
（4096x3024）

4K XAVC-I Class480 None ○ ○ ○ ○ － － －
MPEG HD422 P ○ － ○ ○ － － －
ProRes 422 Proxy P ○ ○ ○ ○ － － －

4K XAVC-I Class300 None ○ ○ ○ ○ － ○ ○
MPEG HD422 P ○ － ○ ○ － － －
MPEG HD422 i － － － － － ○ ○
ProRes 422 Proxy P ○ ○ ○ ○ － － －
ProRes 422 Proxy i － － － － － ○ ○

MPEG HD422 P None ○ － ○ ○ － － －
MPEG HD422 i None － － － － － ○ ○
FHD ProRes 4444 P None ○ ○ ○ ○ － － －
FHD ProRes 422 HQ P None ○ ○ ○ ○ － ○ ○
FHD ProRes 422 P None ○ ○ ○ ○ － ○ ○
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有効画サイズ（Imager Mode） 記録フォーマット Project Frame Rate
SxSメイン記録フォーマット 
（SxS Rec Format）1）

SxSサブ記録フォーマット 
（Sub Rec Format）2）

23.98 24.00 25.00 29.97 47.95 50.00 59.94

4K 4:3 Surround
（4096x3024）
撮像画サイズ
（4552x3360）

MPEG HD422 P None ○ － ○ ○ － － －
FHD ProRes 422 HQ P None ○ ○ ○ ○ － － －
FHD ProRes 422 P None ○ ○ ○ ○ － － －

4K 17:9
（4096x2160）

4K XAVC-I Class480 None ○ ○ ○ ○ － － －
MPEG HD422 ○ － ○ ○ － － －
ProRes 422 Proxy P ○ ○ ○ ○ － － －

4K XAVC-I Class300 None ○ ○ ○ ○ － ○ ○
MPEG HD422 P ○ － ○ ○ － － －
MPEG HD422 i － － － － － ○ ○
ProRes 422 Proxy P ○ ○ ○ ○ － － －
ProRes 422 Proxy i － － － － － ○ ○

3.8K (QFHD) 16:9
（3840x2160）

QFHD XAVC-I Class480 None ○ － ○ ○ － － －
MPEG HD422 P ○ － ○ ○ － － －
ProRes 422 Proxy P ○ － ○ ○ － － －

QFHD XAVC-I Class300 None ○ － ○ ○ － ○ ○
MPEG HD422 P ○ － ○ ○ － － －
MPEG HD422 i － － － － － ○ ○
ProRes 422 Proxy P ○ － ○ ○ － － －
ProRes 422 Proxy i － － － － － ○ ○

MPEG HD422 P None ○ － ○ ○ － － －
MPEG HD422 i None － － － － － ○ ○
FHD ProRes 4444 P None ○ ○ ○ ○ － － －
FHD ProRes 422 HQ P None ○ ○ ○ ○ － ○ ○
FHD ProRes 422 HQ i None － － － － － ○ ○
FHD ProRes 422 P None ○ ○ ○ ○ － ○ ○
FHD ProRes 422 i None － － － － － ○ ○

3.8K (QFHD) 16:9 Surround 
（3840x2160）
撮像画サイズ 
（4268x2400）

MPEG HD422 P None ○ － ○ ○ － － －
FHD ProRes 422 HQ P None ○ ○ ○ ○ － － －
FHD ProRes 422 P None ○ ○ ○ ○ － － －

1) SxSメイン記録フォーマットがXAVC設定のときは、XAVC記録のLUT設定はオフ固定になります。
2) SxS記録フォーマットがMPEGまたはProResのときは、LogまたはLookのいずれかを選択可能です（FHDのみ）。
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フルメニューの操作方法
MENUボタンを2秒以上長押しすると、撮影や
再生に必要な各種設定を行うフルメニューがサ
ブディスプレイに表示されます。

メニュー構成

Shootingメニュー

撮影に関する設定をするときに使用するメ
ニューです。

Projectメニュー

プロジェクトの基本的な設定をするときに使用
するメニューです。

TC/Mediaメニュー

タイムコードと記録メディアに関する設定をす
るときに使用するメニューです。

Monitoringメニュー

ビデオ出力やビューファインダー出力に関する
設定をするときに使用するメニューです。

Audioメニュー

オーディオに関する設定をするときに使用する
メニューです。

Paintメニュー

ペイント機能に関する設定をするときに使用す
るメニューです。
Technicalメニュー > System Configuration > 
RM/RCP Paint Control（81ページ）がOnに

設定されている場合のみ、Paintメニューを表示・
選択できます。

Technicalメニュー

技術的な内容の設定をするときに使用するメ
ニューです。

Maintenanceメニュー

時計や言語設定などの機器設定をするときに使
用するメニューです。

操作部

MENUボタン（9ページ）
2秒以上長押しすると、サブディスプレイにフ
ルメニューが表示されます。

SEL/SET ダイヤル（MENUダイヤル） 
（9ページ）
回すとカーソルが上下に移動して、設定項目や
設定値を選択できます。
MENUダイヤルを押すと、選択している項目を
決定します。

BACKボタン（10ページ）
1つ前の階層に戻ります。確定前の変更はキャ
ンセルされます。

メニューを設定する

MENUダイヤルを回して設定したい項目にカー
ソルを合わせ、MENUダイヤルを押して決定し
ます。

ˎˎ 選択項目が表示される選択肢エリアは最大9
行表示です。選択肢が1度に表示できない場
合は、カーソルを上下に移動すると表示がス
クロールします。

ˎˎ 選択肢の範囲が大きい項目の場合（例：–99
～ +99）は、選択肢エリアは表示されません。
文字がハイライト表示になり設定変更が可能
な状態であることを示します。

ˎˎ 実行項目でExecuteを選択した場合は、対応
する機能が実行されます。

ˎˎ 実行前に確認が必要な項目を選択すると、確
認メッセージが表示されます。メッセージに
従って、実行するかキャンセルするかを選択
してください。
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フルメニュー一覧
各メニュー項目の機能および設定値は次のとおりです。

Shootingメニュー

太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Shooting > FPS
撮像フレームレートを設定します。

［ご注意］
Projectメニュー > Basic Setting > SxS Rec Formatの設定がInterlace記録またはProRes 4444記録の場合は、FPSを
設定できません。この場合、Fixed/Variable Selectの設定はFixedに変更されます。

メニュー項目 設定値 内容
Fixed/Variable 
Select

Fixed/Variable FPS設定を等速撮影にするか、可変速撮影する
かを選択する。

FPS Select Fixed/Variable SelectがFixed
の場合、次のいずれかの値が表
示されます。

Fixed 23.98/Fixed 24.00/
Fixed 25.00/Fixed 29.97/
Fixed 47.95/Fixed 50.00/
Fixed 59.94

撮像フレームレートを選択する。
Project Frame Rateの設定によって初期値が次
のように異なります。

Project 
Frame 
Rate

Fixed/Variable 
Selectが
Variableの場合
の初期値

Fixed/Variable 
SelectがFixed
の場合の表示値

59.94 60 Fixed 59.94

50 50 Fixed 50.00

47.95 48 Fixed 47.95

29.97 30 Fixed 29.97

25 25 Fixed 25.00

24 24 Fixed 24.00

23.97 24 Fixed 23.98

Shooting > Shutter
電子シャッターに関する設定を行います。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnで、RM-B170などのリモー
トコントロールユニット接続時は、Shutterはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Shutter Select Shutter Mode（81ページ）

がSpeedの場合
工場出荷時の選択肢

1/24、1/25、1/30、
1/48、1/50、1/60、
1/100、1/120、
1/250、1/500、
1/1000、1/20001)

Shutter Mode（81ページ）
がAngleの場合
工場出荷時の選択肢

360.0/180.0/172.8/ 
144.0/90.0/45.0/22.5/ 
11.2/5.6

Step/Cont. Selectで
Continuousを選択すると、
360.0～ 4.2（Angleの場合）
または1/241）～ 1/80002）

（Speedの場合）の範囲からの
選択となります。

電子シャッターの開角度またはスピードを選択
する。
スピードの初期値はProject Frame Rate
（67ページ）の設定によって次のようになり
ます。

23.98/24：1/24
25：1/25
29.97：1/30
47.95：1/48
50：1/50
59.94：1/60

Step/Cont. Select Step/Continuous 電子シャッターの値をステップ単位で選択する
か、連続的に選択するかを設定する。

Add/Change Step Shutter SelectのStepでの選択肢を追加または
変更する。
追加できる選択肢は最大16個になります。

Delete Step Shutter SelectのStepでの選択肢の1つを削除
する。

Shooting > ND
NDフィルターのポジションを設定します。

メニュー項目 設定値 内容
ND Position Clear/0.3/0.6/0.9/1.2/1.5/1.8/ 

2.1/2.4
NDフィルターの濃度を選択する。
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Shooting > Exposure Index
EI値を設定します。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnに設定されている場合は、
Exposure Indexはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
EI Select Projectメニュー > Basic 

Setting > Base ISO（67
ページ）の設定によって、設定
値が次のように異なります。
ISO 500：

125EI/160EI/200EI/250EI/
320EI/400EI/500EI/ 
640EI/800EI/1000EI/ 
1250EI/1600EI/2000EI

ISO 2500：
640EI/800EI/1000EI/ 
1250EI/1600EI/2000EI/ 
2500EI/3200EI/4000EI/ 
5000EI/6400EI/8000EI/ 
10000EI

EI値を選択する。

［ご注意］
Technicalメニュー > System Configuration > RM/
RCP Paint Control（81ページ）がOnに設定されて
いる場合は、設定値が以下のように固定されます。
Base ISOがISO500のとき：500EI
Base ISOがISO2500のとき：2500EI

Shooting > Gain
ゲインに関する設定を行います。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOffに設定されている場合、ま
たはRM-B170などのリモートコントロールユニットが接続されている場合は、Gainの設定を変更できません。

メニュー項目 設定値 内容
Gain Select －6dB/－3dB/0dB/3dB/6dB/

9dB/12dB/15dB/18dB
基準感度を設定する。

Shooting > White Balance
ホワイトバランスに関する設定を行います。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnで、RM-B170などのリモー
トコントロールユニット接続時は、White Balanceはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Color Temp. Select 3200K+00/4300K+00/ 

5500K+00
および追加された選択肢（計16
個まで）

ホワイトバランスの色温度／色合いを表示およ
び選択する。

Add/Change Step ホワイトバランスのColor TempとTint値を変
更して、選択肢を追加または変更する。

Delete Step 追加された選択肢の1つを選択肢から削除する。
Auto White Balance Execute/Cancel オートホワイトバランスを実行する（Execute

で実行）。

Shooting > LUT Select
各種出力映像に適用するLUTに関する設定を行います。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）の設定によって各メニュー項目
の設定値が異なります（SDR Gainを除く）。

メニュー項目 設定値 内容
SDI 1/2 RM/RCP Paint ControlがOffの

とき：
Log

SDI 1/2出力映像にはLUTを適用できないため
表示のみ。

RM/RCP Paint ControlがOnの
とき：

Log/HLG(Natural)/
HLG(Live)/User Gamma

SDI 1/2出力映像の設定値は、Projectメニュー 
> Basic Setting > Input Color Space（67
ページ）の設定で決まるため表示のみ。

SDI 3/4 RM/RCP Paint ControlがOffの
とき：

Log/Look/---

SDI 3/4出力映像に適用するLUTを選択する。

RM/RCP Paint ControlがOnの
とき：

Log/HLG(Natural)/
HLG(Live)/User Gamma

SDI 3/4出力映像の設定値は、Projectメニュー 
> Basic Setting > Input Color Space（67
ページ）の設定で決まるため表示のみ。
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Shooting > LUT Select
各種出力映像に適用するLUTに関する設定を行います。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）の設定によって各メニュー項目
の設定値が異なります（SDR Gainを除く）。

メニュー項目 設定値 内容
Monitor RM/RCP Paint ControlがOffの

とき：
Output Format > SDI1/2が
2K/HDのとき：

Log/s709/R709(800%)
Output Format > SDI1/2が
4K/QFHDのとき：

Log/Look

Monitor出力映像に適用するLUTを選択する。

RM/RCP Paint ControlがOnの
とき、Projectメニュー > Basic 
Setting > Input Color Space
（67ページ）の設定によって、
設定値が次のように異なりま
す。
S-Gamut3.Cine/SLog3または
S-Gamut3/SLog3：

Log/R709(800%)
HLG(Natural)：

HLG(Natural)/
R709(800%)

HLG(Live)：
HLG(Live)/R709(800%)

Rec.2020/User Gamma：
User Gamma/R709-Like

Rec.709/User Gamma：
User Gamma

Monitor出力映像の種類を選択する。

Shooting > LUT Select
各種出力映像に適用するLUTに関する設定を行います。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）の設定によって各メニュー項目
の設定値が異なります（SDR Gainを除く）。

メニュー項目 設定値 内容
HDMI RM/RCP Paint ControlがOffの

とき：
Log/s709/R709(800%)/
Look

HDMI出力映像に適用するLUTを表示する。

RM/RCP Paint ControlがOnの
とき（4K/QFHD出力時）：

Log /HLG(Natural)/
HLG(Live)/User Gamma

HDMI出力映像の設定値はSDI 1/2と同じため
表示のみ。

RM/RCP Paint ControlがOnの
とき（2K/HD出力時）：

Log /HLG(Natural)/
HLG(Live)/User Gamma/
R709(800%)/R709-Like

HDMI出力映像の設定値はMonitorと同じため
表示のみ。
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Shooting > LUT Select
各種出力映像に適用するLUTに関する設定を行います。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）の設定によって各メニュー項目
の設定値が異なります（SDR Gainを除く）。

メニュー項目 設定値 内容
VF LUT RM/RCP Paint ControlがOffの

とき：
Log/s709/R709(800%)

ビューファインダー・モニター画面出力映像に
適用するLUTを選択する。

［ご注意］
ビューファインダー・モニター画面出力映像にはSDR
ゲイン値（－12dB）が反映されます。

RM/RCP Paint ControlがOnの
とき、Projectメニュー > Basic 
Setting > Input Color Space
（67ページ）の設定によって、
設定値が次のように異なりま
す。
S-Gamut3.Cine/SLog3または
S-Gamut3/SLog3：

Log/R709(800%)
HLG(Natural)：

HLG(Natural)/
R709(800%)

HLG(Live)：
HLG(Live)/R709(800%)

Rec.2020/User Gamma：
User Gamma/R709-Like

Rec.709/User Gamma：
User Gamma

ビューファインダー・モニター画面出力映像の
種類を選択する。

SxS Rec RM/RCP Paint ControlがOffの
とき：

Log/Look

SxS Mainクリップ記録映像に適用するLUTを選
択する。

RM/RCP Paint ControlがOnの
とき：

Log/HLG(Natural)/
HLG(Live)/User Gamma

SxS Mainクリップ記録映像の設定値は、
Projectメニュー > Basic Setting > Input 
Color Space（67ページ）の設定で決まるた
め表示のみ。

Shooting > LUT Select
各種出力映像に適用するLUTに関する設定を行います。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）の設定によって各メニュー項目
の設定値が異なります（SDR Gainを除く）。

メニュー項目 設定値 内容
Sub Rec RM/RCP Paint ControlがOffの

とき：
Log/Look

SxS Subクリップ記録映像に適用するLUTを選
択する。

RM/RCP Paint ControlがOnの
とき：

Log/HLG(Natural)/
HLG(Live)/User Gamma

SxS Subクリップ記録映像の設定値は、Project
メニュー > Basic Setting > Input Color 
Space（67ページ）の設定で決まるため表示
のみ。

SDR Gain －15dB ～ 0dB（－12dB）
（1 dB刻み）

HDRモード時のSDR出力ゲインを設定する。
R709(800％ )またはR709-Likeに設定されてい
るMonitorまたはビューファインダーの出力ゲ
インを変更することができます。

［ご注意］
Technicalメニュー > System Configuration > RM/
RCP Paint Control（81ページ）がOnに設定されて
いる場合に設定できます。
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Shooting > Look
Preset Lookに関する設定を行います。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnに設定されている場合は、
Lookはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Category Preset Look/ACES/User 3D 

LUT
LUTのカテゴリーを選択する。

［ご注意］
「ACES」は、Projectメニュー > Basic Setting > 
Input Color Space（67ページ）がS-Gamut3/
SLog3に設定されている場合のみ選択できます。

Preset Look Select s709/R709(800%) / 
S-Gamut3.Cine/SLog3 / 
S-Gamut3/SLog3

Preset Lookを選択する。
カラーグレーディングの開始点に適した映像や
プリントフィルムに近づけた映像を出力する。
s709：シネマ色
R709(800%)：忠実色
S-Gamut3/SLog3：広い色域
S-Gamut3.Cine/SLog3：デジタルシネマを考
慮した色域

［ご注意］

ˎˎ CategoryがPreset Lookに設定されている場合のみ
設定できます。
ˎˎ「S-Gamut3/SLog3」は、Projectメニュー > Basic 

Setting > Input Color Space（67ページ）が
S-Gamut3/SLog3に設定されている場合のみ選択
できます。

ACES Select ACESproxy/ACEScct/ACES 
1.0 Output-Rec.709

ACES規格のLookの種類を選択する。
ACESproxy：アカデミーにより規定されてい
る広色域（AP1）のLogカーブです。

ACEScct：ACESproxyにコントラストを抑え
たToe特性を持たせた広色域（AP1）のLog
カーブです。

ACES 1.0 Output-Rec.709：アカデミーによ
り規定されているRec.709のリファレンス
ルックです。

［ご注意］
CategoryがACESに設定されている場合のみ設定でき
ます。

Shooting > Look
Preset Lookに関する設定を行います。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnに設定されている場合は、
Lookはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
User 3D LUT Select 内部メモリーに保存されている

User 3D LUTのファイル名（01
～ 16）

User 3D LUTファイルを選択する。

［ご注意］
CategoryがUser 3D LUTに設定されている場合のみ
設定できます。
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Shooting > Look
Preset Lookに関する設定を行います。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnに設定されている場合は、
Lookはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
ASC CDL Process CDL Off/Look-> CDL/CDL -> 

Look
出力映像にASC CDL を適用するかを設定する。
適用する場合、ASC CDLの処理の順番を指定
する。
CDL Off：出力映像にASC CDLを適用しない。
CDL->Look：CDLをLook適用処理の前に適用
する。

Look->CDL：CDLをLook適用処理の後に適用
する。

［ご注意］

ˎˎ ASC CDLは、Shootingメニュー > LUT Select（62
ページ）でLookが選択された出力に有効です。
ˎˎ ASC CDL Processの各選択肢が有効になる条件は
以下のとおりです。

Shooting > Look > Project > Basic 
Setting > Input 
Color Space

ASC CDL 
Processの有
効選択肢

Category Preset Look 
Select

ACES 
Select

User 
3D LUT 
Select

Preset 
Look

s709 － － S-Gamut3/SLog3
S-Gamut3.Cine/
SLog3

CDL Off
Look -> CDL
CDL->Look

R709(800%)
S-Gamut3/
SLog3
S-Gamut3.
Cine/SLog3

－ － S-Gamut3/SLog3
S-Gamut3.Cine/
SLog3

CDL Off
Look -> CDL

ACES － ACESproxy 
ACEScct 
ACES 1.0 
Output-
Rec.709

－ S-Gamut3/SLog3 CDL Off
CDL->Look

User 
3D LUT

－ － s709xxx.
cube

S-Gamut3/SLog3
S-Gamut3.Cine/
SLog3

CDL Off
Look -> CDL
CDL->Look

Shooting > Look
Preset Lookに関する設定を行います。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnに設定されている場合は、
Lookはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
ASC CDL Select No File/Not Selected 本機に登録されたASC CDLを選択する。
ASC CDL 
Information

ASC CDL Selectで選択したASC CDLの情報を
表示する。

Shooting > Look File
User 3D LUTファイルを本機に読み込みます。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnに設定されている場合は、
Look Fileはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Load User 3D LUT SDカードに保存されているUser 3D LUTファ

イルを本機に読み込む。
Reset User 3D LUT 任意のUser 3D LUTデータ設定をリセットす

る。
Reset All User 3D 
LUTs

Execute/Cancel すべてのUser 3D LUTデータ設定をリセットす
る（Executeで実行）。

Load ASC CDL ASC CDLデータをSDカードから読み込む。
Reset ASC CDL 任意のASC CDLデータ設定をリセットする。
Reset All ASC CDLs Execute/Cancel すべてのASC CDLデータ設定をリセットする

（Executeで実行）。

1) プロジェクトフレームレートが59.94の場合は1/60以降の値、50.0の場合は1/50以降の値、29.97の場合は
1/30以降の値、25.0の場合は1/25以降の値が選択肢となります。

2) プロジェクトフレームレートが50.0または25.0の場合は1/7000までの値、24.0または23.98の場合は1/6000
までの値が選択肢となります。
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Projectメニュー

太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Project > Basic Setting
画サイズやプロジェクトフレームレートに関する設定を行います。

メニュー項目 設定値 内容
Imager Mode 6K 3:2/6K 1.85:1/6K 17:9/6K 

2.39:1/5.7K 16:9/4K 6:5/4K 
4:3/4K 4:3 Surround View/4K 
17:9/4K 17:9 Surround 
View/4K 2.39:1/3.8K 16:9/3.8K 
16:9 Surround View

有効画サイズを選択する。

[ご注意]

ˎˎ 6K 3:2/6K 1.85:1/6K 17:9はフルフレームライ
センスインストール時のみ表示されます。
ˎˎ 4K 6:5/4K 4:3/4K 4:3 Surround Viewはアナモ
フィックライセンスインストール時のみ表示されま
す。

Project Frame Rate 23.98/24/25/29.97/47.95/ 
50/59.94

プロジェクトフレームレートを選択する。

Input Color Space S-Gamut3.Cine/SLog3 / 
S-Gamut3/SLog3 /  
HLG(Natural) / HLG(Live) / 
Rec.2020/User Gamma / 
Rec.709/User Gamma

色域を設定する。

［ご注意］

ˎˎ HLG(Natural) / HLG(Live) / Rec.2020/User 
Gamma / Rec.709/User Gammaは、Technicalメ
ニュー > System Configuration > RM/RCP Paint 
Control（81ページ）がOnに設定されている場合
のみ選択できます。
ˎˎ HLG(Natural)はHLG BT.2100と同等です。

AXS Rec Format
（AXS-R7装着時のみ）

Rec Off/X-OCN XT/RAW SQ/
X-OCN ST/X-OCN LT

AXS-R7に挿入されたAXSメモリーカードに記
録するビデオフォーマットを選択する。

SxS Rec Format Rec Off/XAVC 4K Class480/
XAVC 4K Class300/XAVC 
QFHD Class480/XAVC QFHD 
Class300/MPEG HD P/MPEG 
HD i/ProRes 4444 HD P/
ProRes 422 HQ HD P/ProRes 
422 HQ HD i/ProRes 422 HD 
P/ProRes 422 HD i/ProRes 
422 Proxy HD P/ProRes 422 
Proxy HD i

SxSメモリーカードに記録するビデオフォー
マットを選択する。

［ご注意］

ˎˎ ProRes 4444 HD Pは、以下の有効画サイズにのみ
対応しています。

 – 5.7K 16:9
 – 4K 6:5
 – 4K 4:3
 – 3.8K 16:9

ˎˎ Input Color SpaceがHLG(Natural)、 HLG(Live)ま
たはRec.2020/User Gammaに設定されている場
合、ProRes 4444 HD Pは選択できません。

Sub Rec Format Rec Off/MPEG HD P/MPEG 
HD i/ProRes 422 Proxy HD P/
ProRes 422 Proxy HD i

SxSにサブとして記録するフォーマットを選択
する。

Project > Basic Setting
画サイズやプロジェクトフレームレートに関する設定を行います。

メニュー項目 設定値 内容
Base ISO ISO 500/ISO 2500 基準感度を設定する。
SxS/Output De-
Squeeze

Off(1.0x)/1.25x/1.3x/1.5x/ 
1.65x/1.8x/2.0x

SxS記録信号およびビデオ出力信号のデスク
イーズ変換処理を行うかを設定する。
アナモフィックライセンスがインストールされ
ていて、Imager Modeの設定が4K 4:3/4K 4:3 
Surround View/4K 6:5/4K 17:9/4K 17:9 
Surround View、またはアナモフィックライセ
ンスとフルフレームライセンスがインストール
されていて、Imager Modeの設定が6K 3:2/6K 
17:9のときに設定できます。ただし、画サイ
ズによって選択肢が異なります。

Imager Mode SxS/Output De-Squeeze
Off(1.0x) 1.25x 1.3x 1.5x 1.65x 1.8x 2.0x

6K 3:2 ○ ○ ○ ○ ○ ○ ○
6K 1.85:1 ○ － － － － － －
6K 17:9 ○ ○ ○ － ○ ○ ○
6K 2.39:1 ○ － － － － － －
5.7K 16:9 ○ － － － － － －
4K 6:5 ○ － － － － － ○
4K 4:3 Surround ○ － ○ － ○ ○ ○
4K 4:3 ○ － ○ － ○ ○ ○
4K 17:9 Surround ○ ○ ○ － ○ ○ ○
4K 17:9 ○ ○ ○ － ○ ○ ○
4K 2.39:1 ○ － － － － － －
3.8K 16:9 Surround ○ － － － － － －
3.8K 16:9 ○ － － － － － －
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Project > Basic Setting
画サイズやプロジェクトフレームレートに関する設定を行います。

メニュー項目 設定値 内容

RGB出力するHD ProRes 4444では対応する有
効画サイズに制限があるため、設定可能な選択
肢は以下のとおりとなります。

Imager Mode SxS/Output De-Squeeze
Off(1.0x) 1.25x 1.3x 1.5x 1.65x 1.8x 2.0x

5.7K 16:9 ○ － － － － － －
4K 6:5 ○ － － － － － －
4K 4:3 ○ － ○ － － － －
3.8K 16:9 ○ － － － － － －

Project > Special Recording
ピクチャーキャッシュレックに関する設定を行います。

メニュー項目 設定値 内容
Cache Rec Select On/Off ピクチャーキャッシュ機能をオン／オフする。

以下のピクチャーキャッシュ非対応設定時は
Offに設定されグレーアウトされます。
ˎˎ XAVC-I Class480（4K, QFHD）の記録フォー
マット設定時
ˎˎ 有効画サイズ、システム周波数設定の組み合
わせによってピクチャーキャッシュ非対応設
定となる場合
ˎˎ AXS Rec FormatとSxS Rec Formatが共に
Rec Offの場合
ˎˎ AXSとSxSの同時記録設定時

Project > Special Recording
ピクチャーキャッシュレックに関する設定を行います。

メニュー項目 設定値 内容
Max Cache Rec 
Duration

2sec/4sec/6sec/8sec/10sec/
15sec/24sec/30sec

ピクチャーキャッシュメモリーに画像を蓄積す
るときの再生時間長を設定する。
各メモリーカードに設定可能な最大値は以下の
とおりです。

SxSメモリーカードに記録するとき
SxS Rec Format Project Frame Rate

23.98 24 25 29.97 47.95 50 59.94
4K/QFHD XAVC-I 
Class480

－ － － － － － －

4K/QFHD XAVC-I 
Class300

2 2 2 2 － － －

FHD ProRes 4444  
HQ P

2 2 2 2 － － －

2K/FHD ProRes 422 
HQ P

2 2 2 2 － － －

2K/FHD ProRes 422 
HQ i

－ － － － － 2 2

2K/FHD ProRes 422 P 6 6 6 6 － 2 2
2K/FHD ProRes 422 i － － － － － 6 6
MPEG HD422 P 15 － 15 15 － － －
MPEG HD422 i － － － － － 15 15
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Project > Special Recording
ピクチャーキャッシュレックに関する設定を行います。

メニュー項目 設定値 内容
AXSメモリーカードに記録するとき
Imager 
Mode

AXS Rec 
Format

Project Frame Rate
23.98 24 25 29.97 47.95 50 59.94

6K 3:2 X-OCN 
XT

4 4 2 2 － － －

X-OCN ST 8 8 8 6 － － －
X-OCN LT 15 15 15 15 6 6 4

6K 1.85:1 X-OCN 
XT

6 6 6 4 － － －

X-OCN ST 10 10 10 8 2 2 －
X-OCN LT 24 24 24 15 10 10 6

6K 17:9 X-OCN 
XT

6 6 6 4 － － －

X-OCN ST 10 10 10 8 4 2 2
X-OCN LT 24 24 24 15 10 10 8

6K 2.39:1 X-OCN 
XT

10 10 10 6 2 2 －

X-OCN ST 15 15 15 10 6 6 4
X-OCN LT 30 30 30 24 15 15 10

5.7K 16:9 X-OCN 
XT

6 6 6 4 － － －

X-OCN ST 10 10 10 8 － － －
X-OCN LT 24 24 24 15 － － －

4K 6:5 X-OCN 
XT

10 10 10 8 － － －

X-OCN ST 15 15 15 15 － － －
X-OCN LT 30 30 30 30 － － －

4K 4:3 X-OCN 
XT

15 15 10 10 4 4 2

X-OCN ST 24 24 24 15 8 8 6
X-OCN LT 30 30 30 30 15 15 15

Project > Special Recording
ピクチャーキャッシュレックに関する設定を行います。

メニュー項目 設定値 内容

Imager 
Mode

AXS Rec 
Format

Project Frame Rate
23.98 24 25 29.97 47.95 50 59.94

4K 4:3 
Surround

X-OCN 
XT

15 15 10 10 － － －

X-OCN ST 24 24 24 15 － － －
X-OCN LT 30 30 30 30 － － －

4K 17:9 RAW SQ 24 24 24 15 8 8 6
X-OCN 
XT

24 24 24 15 8 8 6

X-OCN ST 30 30 30 30 15 15 10
X-OCN LT 30 30 30 30 30 30 24

4K 17:9 
Surround

RAW SQ 24 24 24 15 － － －
X-OCN 
XT

24 24 24 15 － － －

X-OCN ST 30 30 30 30 － － －
X-OCN LT 30 30 30 30 － － －

4K 2.39:1 X-OCN 
XT

30 30 30 24 10 10 10

X-OCN ST 30 30 30 30 15 15 15
X-OCN LT 30 30 30 30 30 30 30

3.8K(QFHD) 
16:9

X-OCN 
XT

24 24 24 15 － 8 6

X-OCN ST 30 30 30 30 － 15 10
X-OCN LT 30 30 30 30 － 30 24

3.8K(QFHD) 
16:9 
Surround

X-OCN 
XT

24 24 24 15 － － －

X-OCN ST 30 30 30 30 － － －
X-OCN LT 30 30 30 30 － － －
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Project > Assignable Button
アサイナブルボタンに機能を割り当てます。

 ˜ 機能の割り当てについて詳しくは、「ユーザー機能画面」（43ページ）をご覧ください。

メニュー項目 設定値 内容
<1> 43ページ アサイナブル1ボタンに機能を割り当てる。
<2> 43ページ アサイナブル2ボタンに機能を割り当てる。
<3> 43ページ アサイナブル3ボタンに機能を割り当てる。
<4> 43ページ アサイナブル4ボタンに機能を割り当てる。
<VF A> 43ページ ビューファインダー（DVF-EL200）のアサイナ

ブルAボタンに機能を割り当てる。
<VF B> 43ページ ビューファインダー（DVF-EL200）のアサイナ

ブルBボタンに機能を割り当てる。
<VF C> 43ページ ビューファインダー（DVF-EL200）のアサイナ

ブルCボタンに機能を割り当てる。
<User 1> 43ページ ITEMキー 1に機能を割り当てる。
<User 2> 43ページ ITEMキー 2に機能を割り当てる。
<User 3> 43ページ ITEMキー 3に機能を割り当てる。
<User 4> 43ページ ITEMキー 4に機能を割り当てる。
<User 5> 43ページ ITEMキー 5に機能を割り当てる。

Project > All File
Allファイルに関する設定を行います。

メニュー項目 設定値 内容
Load SD Card Allファイルの設定をSDカードから読み出す。
Save SD Card Allファイルの設定をSDカードに保存する。
File ID AllファイルのFile IDを表示し、編集する。
Format SD Card SD Cardをフォーマットする。

Project > Scene File
Sceneファイルに関する設定を行います。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnに設定されている場合のみ、
Scene Fileを表示・選択できます。

メニュー項目 設定値 内容
Recall Internal 
Memory

Sceneファイルの設定を内蔵メモリーから読み
出す。

Store Internal 
Memory

Sceneファイルの設定を内蔵メモリーに保存す
る。

Project > Scene File
Sceneファイルに関する設定を行います。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnに設定されている場合のみ、
Scene Fileを表示・選択できます。

メニュー項目 設定値 内容
Load SD Card Sceneファイルの設定をSDカードから読み出

す。
Save SD Card Sceneファイルの設定をSDカードに保存する。
File ID SceneファイルのFile IDを表示し、編集する。

Project > User Gamma
ユーザーガンマファイルに関する設定を行います。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnに設定されている場合のみ、
User Gammaを表示・選択できます。

メニュー項目 設定値 内容
Current Settings 内蔵メモリー上の、現在のユーザーガンマファ

イル名を表示する。
Load SD Card SDカード内のユーザー作成によるガンマテー

ブルデータ（ユーザーガンマファイル）を内蔵メ
モリーに読み込む。
Raw Viewerで作成されたユーザーガンマファ
イルを本機で使用する際には、SDカードの以
下の階層に保存してください。
PRIVATE¥SONY¥PRO¥CAMERA¥MPC3610

Reset 1/2/3/4/5/All 内蔵メモリー上のユーザーガンマファイルを初
期値に戻す。
1～ 5：個別
All：全部
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TC/Mediaメニュー

太字とアンダーラインで表示されている設定値は、出荷時の設定です。
TC/Media > Timecode
タイムコードに関する設定を行います。

メニュー項目 設定値 内容
Mode Preset F-Run (Ext-Lk)/Preset 

R-Run/Int Regen
タイムコードの歩進モードを選択する。
Preset F-Run (Ext-Lk)：設定された状態から歩
進し、外部入力TCに同期する。

Preset R-Run：記録時のみ設定された状態から
歩進する。

Int Regen：前のクリップのタイムコードに続
けて歩進する。

Manual Setting 00:00:00:00～ 23:59:59:29 任意のタイムコード値を設定する。
Reset Execute/Cancel タイムコードを00:00:00:00にリセットする

（Executeで実行）
TC Format DF/NDF タイムコードのフォーマットを選択する。

DF：ドロップフレーム
NDF：ノンドロップフレーム

TC Source Internal/External TCGの同期元を表示する。
Time Data Display Timecode/Duration 表示するタイムデータを選択する。

TC/Media > Clip Name Format
クリップ名を設定します。（クリップ名：Camera ID + Reel Number + Shot Number + 年月日 + 
ランダム文字列）

メニュー項目 設定値 内容
Camera ID A～ Z クリップ名の生成時のカメラIDを設定する。
Reel Number 001～ 999 クリップ名の生成時のReel Numberの数字部

分を設定する。
Camera Position C/L/R クリップ名の生成時のShot Numberの先頭文

字部分を選択する。

TC/Media > Clip Name Format
クリップ名を設定します。（クリップ名：Camera ID + Reel Number + Shot Number + 年月日 + 
ランダム文字列）

メニュー項目 設定値 内容
SxS Root Folder 
Name

XDROOT/Cam ID + Reel# SxSカードのボリュームラベル名とルートフォ
ルダー名の命名規則を設定する。
XDROOT：ルートフォルダー名が「XDROOT」
になります。

Cam ID + Reel#：ボリュームラベル名とルー
トフォルダー名がCam ID形式になります。

［ご注意］

ˎˎ 設定を変更した場合は、MPC-3610とPMW-PZ1以
外のソニー製カムコーダーおよびVTRでは再生でき
ません（PMW-PZ1は設定変更が必要です）。
ˎˎ ボリュームラベル名とルートフォルダ名の変更は記
録開始操作時に行われます。
ˎˎ ルートフォルダ名が一度Camera ID形式になっ
たメディアは、　本設定でルートフォルダ名を
「XDROOT」に戻すことができません。
ˎˎ メディアをフォーマットした際のルートフォルダ
は、「XDROOT」になります。
ˎˎ Camera ID形式のルートフォルダ名で記録した
メディアをCamera ID形式メディア非対応機器
（Venice V2.0以前を含む）に挿入すると、Camera 
ID形式のルートフォルダが認識できないため、
XDROOTフォルダが生成されルートフォルダとし
て認識されます。

TC/Media > Format Media
メディアをフォーマットします。

メニュー項目 設定値 内容
AXS Slot A
（AXS-R7装着時のみ）

Execute/Cancel スロットAのAXSメモリーカードを初期化する
（Executeで実行）。

AXS Slot B
（AXS-R7装着時のみ）

Execute/Cancel スロットBのAXSメモリーカードを初期化する
（Executeで実行）。

SxS Slot A Execute/Cancel スロットAのSxSメモリーカードを初期化する
（Executeで実行）。

SxS Slot B Execute/Cancel スロットBのSxSメモリーカードを初期化する
（Executeで実行）。

SD Card Execute/Cancel SDカードを初期化する（Executeで実行）。
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TC/Media > Update Media
メディア内の管理ファイルを更新します。

メニュー項目 設定値 内容
AXS Slot A
（AXS-R7装着時のみ）

Execute/Cancel AXS-R7のスロットAのAXSメモリーカード内の
管理ファイルを更新する（Executeで実行）。

AXS Slot B
（AXS-R7装着時のみ）

Execute/Cancel AXS-R7のスロットBのAXSメモリーカード内の
管理ファイルを更新する（Executeで実行）。

SxS Slot A Execute/Cancel スロットAのSxSメモリーカード内の管理ファ
イルを更新する（Executeで実行）。

SxS Slot B Execute/Cancel スロットBのSxSメモリーカード内の管理ファ
イルを更新する（Executeで実行）。

Monitoringメニュー

太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Monitoring > Output Format
出力フォーマットに関する設定を行います。

メニュー項目 設定値 内容
SDI 1/2 Imager Mode、プロジェクト

フレームレート、SxS記録フォー
マットの設定に応じて変わる。

SDI 1/2の出力フォーマットを選択する。
記録フォーマットにより設定値が異なる（119
ページ）。

SDI 3/4 SDI 1/2の設定に応じて変わる。 SDI 3/4の出力フォーマットを選択する。
記録フォーマットにより設定値が異なる（119
ページ）。

Monitor SDI 1/2の設定に応じて変わる。 Monitorの出力フォーマットを選択する。
記録フォーマットにより設定値が異なる（123
ページ）。

HDMI SDI 1/2の設定に応じて変わる。 HDMIの出力フォーマットを選択する。
記録フォーマットにより設定値が異なる（123
ページ）。

Monitoring > OSD Appearance
各種出力信号に重畳する情報やフレームラインに関する設定を行います。
On/Offの設定はチェックボックスで行います（Frame Line on Playbackを除く）。
On：チェックを付ける
Off：チェックを外す

メニュー項目 設定値 内容
VF Status Info（On/Off、Info. A/

Info. B）
ビューファインダー・モニター画面出力映像に
重畳して表示する情報を選択する。

Frame Line（On/Off、Line A/
Line B）

ビューファインダー・モニター画面出力映像に
重畳して表示するフレームラインを選択する。

SDI
SDI 1/2
SDI 3/4

［ご注意］
Output FormatのSDI 
1/2とSDI 3/4の設定に
よって表示が切り換わり
ます。

Status Info（On/Off、Info. A/
Info. B）

SDI3/4出力信号に重畳して表示する情報を選択
する。

Frame Line（On/Off、Line A/
Line B）

SDI3/4出力信号に重畳して表示するフレームラ
インを選択する。
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Monitoring > OSD Appearance
各種出力信号に重畳する情報やフレームラインに関する設定を行います。
On/Offの設定はチェックボックスで行います（Frame Line on Playbackを除く）。
On：チェックを付ける
Off：チェックを外す

メニュー項目 設定値 内容
Monitor Status Info（On/Off、Info. A/

Info. B）
Monitor出力信号に重畳して表示する情報を選
択する。

Frame Line（On/Off、Line A/
Line B）

Monitor出力信号に重畳して表示するフレーム
ラインを選択する。

HDMI Same as SDI/ Same as 
Monitor

HDMI出力信号に重畳して表示する情報の設定
が、SDI出力と同じか、Monitorと同じかを表
示する。

Status Info A/B 
Setup

Project
Info. A（On/Off）
Info. B（On/Off）

Status Info AおよびStatus Info Bに設定した出
力情報にプロジェクト情報を表示するかを選択
する。

Timecode
Info. A（On/Off）
Info. B（On/Off）

Status Info AおよびStatus Info Bに設定した出
力情報にタイムコード情報を表示するかを選択
する。

Audio Level Meter
Info. A（On/Off）
Info. B（On/Off）

Status Info AおよびStatus Info Bに設定した出
力情報にオーディオレベルメーターを表示する
かを選択する。

Look Status
Info. A（On/Off）
Info. B（On/Off）

Status Info AおよびStatus Info Bに設定した出
力情報に選択されているLOOKの種類を表示す
るかを選択する。

Output LUT
Info. A（On/Off）
Info. B（On/Off）

Status Info AおよびStatus Info Bに設定した
出力情報に出力LUT情報を表示するかを選択す
る。

Recording LUT
Info. A（On/Off）
Info. B（On/Off）

Status Info AおよびStatus Info Bに設定した
出力情報に記録LUT情報を表示するかを選択す
る。

VF Status
Info. A（On/Off）
Info. B（On/Off）

Status Info AおよびStatus Info Bに設定した出
力情報にビューファインダーの情報を表示する
かを選択する。

Lens Status
Info. A（On/Off）
Info. B（On/Off）

Status Info AおよびStatus Info Bに設定した出
力情報にレンズ情報を表示するかを選択する。

Remote Control Status
Info. A（On/Off）
Info. B（On/Off）

Status Info AおよびStatus Info Bに設定した出
力情報にリモート設定情報を表示するかを選択
する。

Monitoring > OSD Appearance
各種出力信号に重畳する情報やフレームラインに関する設定を行います。
On/Offの設定はチェックボックスで行います（Frame Line on Playbackを除く）。
On：チェックを付ける
Off：チェックを外す

メニュー項目 設定値 内容
Level Gauge

Info. A（On/Off）
Info. B（On/Off）

Status Info AおよびStatus Info Bに設定した出
力情報に水準器状態の情報をグラフィカル表示
するかを選択する。

［ご注意］
本機にCBK-3610XSが接続されている場合は、Level 
Gaugeはグレーアウトされ設定を変更できません。

Roll/Tilt Value
Info. A（On/Off）
Info. B（On/Off）

Status Info AおよびStatus Info Bに設定した出
力情報に水準器状態の情報を数値表示するかを
選択する。

［ご注意］
本機にCBK-3610XSが接続されている場合は、Roll/
Tilt Valueはグレーアウトされ設定を変更できません。

Frame Line A/B 
Setup

Center Marker
Line A（On/Off）
Line B（On/Off）
Option（Cross/Open 
Cross/Dot）

Frame Line A およびFrame Line Bに設定した
出力情報にセンターマーカーを表示するかを選
択する。
センターマーカーの表示形態（Cross/Open 
Cross/Dot）を選択する。

Aspect Ratio
Line A（On/Off）
Line B（On/Off）
Option（17:9/16:9/15:9/ 
14:9/13:9/4:3/1.43:1/ 
1.66:1/1.85:1/2:1/2.35:1/ 
2.39:1）

Frame Line A およびFrame Line Bに設定した
出力情報にアスペクトマーカーを表示するかを
選択する。
アスペクトマーカーを表示するときのモード 
（17:9/16:9/15:9/14:9/13:9/4:3/1.43:1/1.66:1/
1.85:1/2:1/2.35:1/2.39:1）を設定する。

Aspect Safety Zone
Line A（On/Off）
Line B（On/Off）
Option
（80%/90%/92.5%/95%）

Frame Line A およびFrame Line Bに設定した
出力情報にアスペクトセーフティーゾーンを表
示するかを選択する。
アスペクトセーフティーゾーンマーカーの大き
さ（画面全体に対する比率）を選択する。

Picture Area
Line A（On/Off）
Line B（On/Off）

Frame Line A およびFrame Line Bに設定した
出力情報にピクチャーエリアを表示するかを選
択する。
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Monitoring > OSD Appearance
各種出力信号に重畳する情報やフレームラインに関する設定を行います。
On/Offの設定はチェックボックスで行います（Frame Line on Playbackを除く）。
On：チェックを付ける
Off：チェックを外す

メニュー項目 設定値 内容
Safety Zone

Line A（On/Off）
Line B（On/Off）
Option
（80%/90%/92.5%/95%）

Frame Line A およびFrame Line Bに設定した
出力情報にセーフティーゾーンを表示するかを
選択する。
セーフティーゾーンの範囲
（80%/90%/92.5%/95%）を選択する。

User Frame Line
Line A（On/Off）
Line B（On/Off）
Option
（Preset/Variable）

Frame Line A およびFrame Line Bに設定した
出力情報にユーザーフレームラインを表示する
かを選択する。
ユーザーフレームラインを任意に設定した表示
にするか、固定のアスペクト比を表示するかを
選択する。

Color
Option（White/Yellow/
Cyan/Green/Magenta/
Red/Blue）

フレームラインの表示色を設定する。

Surround View Type
Option（Line/Mask/
Line&Mask）

サラウンドビューマーカーの表示形態を選択す
る。
Line：記録領域を線で表示する。
Mask：記録領域外側部のビデオ信号レベルを
落として表示する。

Line&Mask：記録領域外側部のビデオ信号レベ
ルを落として、記録領域を線で表示する。

Aspect Ratio Type
Option（Line/Mask/
Line&Mask）

アスペクトマーカーの表示形態を選択する。
Line：Colorで設定されている色の線で表示す
る。

Mask：マーカー範囲外のビデオ信号レベルを
下げて表示する。

Line&Mask：マーカー範囲外のビデオ信号レベ
ルを下げて、Colorで設定されている色の
線で表示する。

Mask Level
Option（0 ～ 15（12））

Aspect Ratio TypeまたはSurround View 
TypeがMaskのとき、マーカーの外側の映像の
明るさを選択する。

Frame Line on Playback
Option（On/Off）

再生時にフレームラインを重畳する機能をオン
／オフする。

Monitoring > Monitor Display
モニターの表示に関する設定を行います。

メニュー項目 設定値 内容
Focus Distance 
Format

Meter/Feet フォーカスポジション表示の単位を選択する。

Monitor Magnifier 
Ratio

x2.0 / x4.0 / x2.0/x4.0 Monitor出力映像の拡大フォーカス機能の拡大
率を選択する。

［ご注意］
Project Frame Rate（67ページ）が59.94または50
のときは、x2.0のみ選択可能です。

Monitoring > Frame Line
出力映像に表示するラインやマーカーに関する設定を行います。

メニュー項目 設定値 内容
Center Marker Cross/Open Cross/Dot センターマーカーの表示形態を選択する。
Aspect Ratio 17:9/16:9/15:9/14:9/13:9/4:3/

1.43:1/1.66:1/1.85:1/2:1/ 
2.35:1/2.39:1

アスペクトマーカーを表示するときのモードを
選択する。

Aspect Safety Zone 80%/90%/92.5%/95% アスペクトセーフティーゾーンマーカーの大き
さ（画面全体に対する比率）を選択する。

Safety Zone 80%/90%/92.5%/95% セーフティーゾーンの範囲を選択する。
Color White/Yellow/Cyan/Green/

Magenta/Red/Blue
フレームラインの表示色を選択する。

Surround View Type Line/Mask/Line&Mask サラウンドビューマーカーの表示形態を選択す
る。
Line：記録領域を線で表示する。
Mask：記録領域外側部のビデオ信号レベルを
落として表示する。

Line&Mask：記録領域外側部のビデオ信号レベ
ルを落として、記録領域を線で表示する。

Aspect Ratio Type Line/Mask/Line&Mask アスペクトマーカーの表示形態を選択する。
Line：Colorで設定されている色の線で表示す
る。

Mask：マーカー範囲外のビデオ信号レベルを
下げて表示する。

Line&Mask：マーカー範囲外のビデオ信号レベ
ルを下げて、Colorで設定されている色の
線で表示する。

Mask Level 0 ～ 15（12） Aspect Ratio TypeまたはSurround View 
TypeがMaskのとき、マーカーの外側の映像の
明るさを選択する。
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Monitoring > Frame Line
出力映像に表示するラインやマーカーに関する設定を行います。

メニュー項目 設定値 内容
Frame Line on 
Playback

On/Off 再生時にフレームラインを重畳する機能をオン
／オフする。

Monitoring > User Frame Line
ユーザーフレームラインに関する設定を行います。

メニュー項目 設定値 内容
Select Preset/Variable ユーザーフレームラインを任意に設定した表示

にするか、固定のアスペクト比を表示するかを
選択する。
Preset：Preset Aspect Ratio、Scaling、

Preset Aspect Ratio Typeで設定したアス
ペクト比を表示する。

Variable：Width、Height、H Position、V 
Position、Variable Aspect Typeで設定し
た任意の矩形枠を表示する。

Preset Aspect Ratio 17:9/16:9/15:9/14:9/13:9/4:3
/1.43:1/1.66:1/1.85:1/2:1/2.35
:1/2.39:1/1.90:1 (W34)*
* 1.43:1設定時の水平画サイズを維
持したフレームラインです。6K 
3:2モードのときは、水平画サイ
ズが約34 mmとなります。

固定のアスペクト比を表示するときのモードを
選択する。

［ご注意］
SelectがPresetに設定されている場合のみ設定できま
す。

Scaling 1%～ 100%/--- 固定のアスペクト比の拡大･縮小率を設定する。

［ご注意］

ˎˎ SelectがPresetに設定されている場合のみ設定でき
ます。
ˎˎ Preset Aspect Ratioが1.90:1 (W34)に設定されて
いる場合は、「---」が表示され設定できません。

Preset Aspect Ratio 
Type

Line/Mask/Line&Mask 固定のアスペクト比の表示形態を選択する。
Line：線で表示する。
Mask：マーカー範囲外のビデオ信号レベルを
下げて表示する。

Line&Mask：マーカー範囲外のビデオ信号レベ
ルを下げて線で表示する。

［ご注意］
SelectがPresetに設定されている場合のみ設定できま
す。

Monitoring > User Frame Line
ユーザーフレームラインに関する設定を行います。

メニュー項目 設定値 内容
Aspect Ratio(Pixels) アスペクト比（画素数、アナモ

フィック倍率）
有効画サイズに対するユーザーフレームライン
のアスペクト比、画素数、アナモフィック倍率
を表示する。

［ご注意］
画素数はデアナモ変換する前の有効画サイズに対して
の値になります。

Width 3 ～ 480（240） ユーザーフレームラインの幅（中心から左右端
までの距離）を設定する。

［ご注意］
SelectがVariableに設定されている場合のみ設定でき
ます。

Height 3 ～ 270（135） ユーザーフレームラインの高さ（中心から上下
端までの距離）を設定する。

［ご注意］
SelectがVariableに設定されている場合のみ設定でき
ます。

H Position 最大－477 ～ 477（±0） ユーザーフレームラインの中心の水平位置を設
定する。
Widthを3より大きくした分だけ設定可能範囲
は狭くなります。

［ご注意］
SelectがVariableに設定されている場合のみ設定でき
ます。

V Position 最大－267 ～ 267（±0） ユーザーフレームラインの中心の垂直位置を設
定する。
Heightを3より大きくした分だけ設定可能範囲
は狭くなります。

［ご注意］
SelectがVariableに設定されている場合のみ設定でき
ます。

Variable Aspect 
Type

Line 任意に設定するユーザーフレームライン表示の
種類を表示する。

［ご注意］
SelectがVariableに設定されている場合のみ表示され
ます。
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Monitoring > False Color
フォルスカラーに関する設定を行います。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnに設定されている場合は、
False Colorはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Level Preset/Manual ビューファインダーおよびモニター出力のフォ

ルスカラーの各色のオン／オフと閾値をプリ
セットにするか手動にするかを設定する。
Manualにすると、これ以降の項目を設定でき
ます。

Red On/Off 赤色の表示のオン／オフを設定する。
Red Upper Limit 0.0% ～ 109.0%（96.1%）

（0.1%刻み）
赤色で表示する上限値を設定する。

Red Lower Limit 0.0% ～ 109.0%（93.4%）
（0.1%刻み）

赤色で表示する下限値を設定する。

Yellow On/Off 黄色の表示のオン／オフを設定する。
Yellow Upper Limit 0.0% ～ 109.0%（93.4%）

（0.1%刻み）
黄色で表示する上限値を設定する。

Yellow Lower Limit 0.0% ～ 109.0%（91.3%）
（0.1%刻み）

黄色で表示する下限値を設定する。

Orange On/Off オレンジ色の表示のオン／オフを設定する。
Orange Upper Limit 0.0% ～ 109.0%（90.6%）

（0.1%刻み）
オレンジ色で表示する上限値を設定する。

Orange Lower Limit 0.0% ～ 109.0%（87.7%）
（0.1%刻み）

オレンジ色で表示する下限値を設定する。

Pink On/Off ピンク色の表示のオン／オフを設定する。
Pink Upper Limit 0.0% ～ 109.0%（58.0%）

（0.1%刻み）
ピンク色で表示する上限値を設定する。

Pink Lower Limit 0.0% ～ 109.0%（54.3%）
（0.1%刻み）

ピンク色で表示する下限値を設定する。

Light Pink On/Off ライトピンク色の表示のオン／オフを設定す
る。

Light Pink Upper 
Limit

0.0% ～ 109.0%（50.8%）
（0.1%刻み）

ライトピンク色で表示する上限値を設定する。

Light Pink Lower 
Limit

0.0% ～ 109.0%（47.8%）
（0.1%刻み）

ライトピンク色で表示する下限値を設定する。

Cyan On/Off シアン色の表示のオン／オフを設定する。

Monitoring > False Color
フォルスカラーに関する設定を行います。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnに設定されている場合は、
False Colorはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Cyan Upper Limit 0.0% ～ 109.0%（46.5%）

（0.1%刻み）
シアン色で表示する上限値を設定する。

Cyan Lower Limit 0.0% ～ 109.0%（43.8%）
（0.1%刻み）

シアン色で表示する下限値を設定する。

Green On/Off 緑色の表示のオン／オフを設定する。
Green Upper Limit 0.0% ～ 109.0%（42.2%）

（0.1%刻み）
緑色で表示する上限値を設定する。

Green Lower Limit 0.0% ～ 109.0%（38.9%）
（0.1%刻み）

緑色で表示する下限値を設定する。

Light Blue On/Off ライトブルー色の表示のオン／オフを設定す
る。

Light Blue Upper 
Limit

0.0% ～ 109.0%（34.4%）
（0.1%刻み）

ライトブルー色で表示する上限値を設定する。

Light Blue Lower 
Limit

0.0% ～ 109.0%（24.6%）
（0.1%刻み）

ライトブルー色で表示する下限値を設定する。

Blue On/Off 青色の表示のオン／オフを設定する。
Blue Upper Limit 0.0% ～ 109.0%（5.6%）（0.1%

刻み）
青色で表示する上限値を設定する。

Blue Lower Limit 0.0% ～ 109.0%（3.5%）（0.1%
刻み）

青色で表示する下限値を設定する。

Purple On/Off 紫色の表示のオン／オフを設定する。
Purple Upper Limit 0.0% ～ 109.0%（3.5%）（0.1%

刻み）
紫色で表示する上限値を設定する。

Purple Lower Limit －7.3% ～ 109.0%（－7.3%）
（0.1%刻み）

紫色で表示する下限値を設定する。

Reset Execute/Cancel 各色のオン／オフと閾値を初期値にする
（Executeで実行）。
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Monitoring > VF Display
ビューファインダーの表示に関する設定を行います。

メニュー項目 設定値 内容
VF LUT Technicalメニュー > System 

Configuration > RM/RCP 
Paint Control（81ページ）が
Offのとき：

Log/s709/R709(800%)

ビューファインダー・モニター画面出力映像に
適用するLUTを選択する。

RM/RCP Paint ControlがOnの
とき、Projectメニュー > Basic 
Setting > Input Color Space
（67ページ）の設定によって、
設定値が次のように異なりま
す。
S-Gamut3.Cine/SLog3または
S-Gamut3/SLog3：

Log/R709(800%)
HLG(Natural)：

HLG(Natural)/
R709(800%)

HLG(Live)：
HLG(Live)/R709(800%)

Rec.2020/User Gamma：
User Gamma/R709-Like

Rec.709/User Gamma：
User Gamma

ビューファインダー・モニター画面出力映像の
種類を選択する。

Status Info Info. A/Info. B/Off ビューファインダー・モニター画面出力映像に
重畳して表示する情報を選択する。

Frame Line Frame Line A/Frame Line B/
Off

ビューファインダー・モニター画面出力映像に
重畳して表示するフレームラインを選択する。

VF Magnifier Ratio x2.0 / x4.0 / x2.0/x4.0 ビューファインダーの拡大フォーカス機能の拡
大率を選択する。

Color －99 ～±0 ～＋99 ビューファインダー映像の色の濃さを調整す
る。

Monitoring > VF Display
ビューファインダーの表示に関する設定を行います。

メニュー項目 設定値 内容
SDR Gain －15dB ～ 0dB（－12dB）

（1 dB刻み）
HDRモード時のSDR出力ゲインを設定する。
R709(800％ )またはR709-Likeに設定されてい
るMonitorまたはビューファインダーの出力ゲ
インを変更することができます。

［ご注意］
Technicalメニュー > System Configuration > RM/
RCP Paint Control（81ページ）がOnに設定されて
いる場合に設定できます。

Monitoring > VF Function
ビューファインダーの機能に関する設定を行います。

メニュー項目 設定値 内容
Double Speed Scan On/Off ビューファインダー倍速駆動機能をオン／オフ

する。
Peaking Frequency Normal/High 通常のピーキング時のピーキング周波数を、標

準にするか高くするかを選択する。

［ご注意］
ピーキングレベルはビューファインダーメニューで設
定します。

Zebra On/Off ゼブラ機能をオン／オフする。
Zebra Select 1/2/Both ゼブラ表示の種類（ゼブラ1、ゼブラ2、または

両方）を選択する。
Zebra1 Level 0% ～ 107%（41%） ゼブラ1を表示するレベルを設定する。
Zebra1 Aperture 
Level

1% ～ 20%（10%） ゼブラ1のアパーチャーレベルを設定する。

Zebra2 Level 0% ～ 109%（61%） ゼブラ2を表示するレベルを設定する。
Assign<VF A> 43ページ ビューファインダー（DVF-EL200）のアサイナ

ブルAボタンに機能を割り当てる。
Assign<VF B> 43ページ ビューファインダー（DVF-EL200）のアサイナ

ブルBボタンに機能を割り当てる。
Assign<VF C> 43ページ ビューファインダー（DVF-EL200）のアサイナ

ブルCボタンに機能を割り当てる。
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Audioメニュー

太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Audio > Audio Input
録音レベルに関する設定を行います。

［ご注意］
AES/EBU信号が選択されている場合の録音レベルは固定になります。

メニュー項目 設定値 内容
CH-1 Audio Select Auto/Manual Autoにすると、録音レベルは自動調整される。
CH-2 Audio Select Auto/Manual Autoにすると、録音レベルは自動調整される。
CH-1 Audio Level －99～±0～＋99 CH-1 Audio SelectでManualを選択時、録音

レベルを調整する。
CH-2 Audio Level －99～±0～＋99 CH-2 Audio SelectでManualを選択時、録音

レベルを調整する。
MIC Reference －60dB/－50dB/－40dB マイクの基準入力レベルを選択する。

Audio > Audio Monitor
音声モニターに関する設定を行います。

メニュー項目 設定値 内容
Monitor CH Monitor Output CH Pairが

CH-1/CH-2の場合
CH-1/CH-2 、CH-1、
CH-2

Monitor Output CH Pairが
CH-3/CH-4の場合

CH-3/CH-4 、CH-3、
CH-4

ヘッドホンおよびスピーカーに出力する音声
チャンネルを選択する。
CH-1/CH-2（CH-3/CH-4）：チャンネル1、2
（チャンネル3、4）

CH-1（CH-3）：チャンネル1（チャンネル3）の
み

CH-2（CH-4）：チャンネル2（チャンネル4）の
み

Monitor Level 0～ 99 モニター音量を調整する。

Audio > Audio Configuration
音声の入出力に関する設定を行います。

メニュー項目 設定値 内容
Alarm Level 0～ 99 アラームの音量を調整する。

［ご注意］
Technicalメニュー > Switch & Rec Light > Rec 
Start/Stop BeepをOnにした場合は、記録開始・終了
操作時のビープ音量も連動します。

Audio > Audio Configuration
音声の入出力に関する設定を行います。

メニュー項目 設定値 内容
Input Limiter Mode Off/－6dB/－9dB/－12dB/ 

－15dB/－17dB
オーディオ入力レベルの手動調整時、大きな入
力信号に対するリミッター特性（飽和レベル）を
選択する。リミッターを使用しない場合はOff
を選択する。

AGC Level －6dB/－9dB/－12dB/ 
－15dB/－17dB

AGCの特性（飽和レベル）を選択する。

AGC Mono/Stereo Mono/Stereo チャンネル1、2に記録するアナログオーディオ
信号の入力レベルの自動調整を、各チャンネル
で独立して行うか（Mono）、ステレオモードで
行うか（Stereo）を選択する。

MIC Input Mono/
Stereo

Mono/Stereo フロントマイクをモノラル（Mono）にするか、
ステレオ（Stereo）にするかを選択する。

Phantom Power 
+48V

On/Off マイクに外部電源（ファントム電源）+48Vを供
給する機能をオン／オフする。

Monitor Output CH 
Pair

CH-1/CH-2、CH-3/CH-4 音声出力をチャンネル1と2にするか、チャン
ネル3と4にするかを選択する。

Headphone Mono/
ST

Mono/Stereo ヘッドホンをモノラル（Mono）にするか、ステ
レオ（Stereo）にするかを選択する。
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Paintメニュー

［ご注意］
Paintメニューの各項目を設定するには、Technicalメニュー > System Configuration > RM/RCP Paint Control（81
ページ）がOnに設定されている必要があります。

太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Paint > Black
ブラックレベルに関する設定を行います。

メニュー項目 設定値 内容
Master Black －99 ～±0 ～＋99 マスターブラックレベルを設定する。
R Black －99 ～±0 ～＋99 Rブラックレベルを設定する。
B Black －99 ～±0 ～＋99 Bブラックレベルを設定する。

Paint > Flare
フレア補正に関する設定を行います。

メニュー項目 設定値 内容
Setting On/Off フレア補正機能をオン／オフする。
Master Flare －99 ～±0 ～＋99 本体に起因するフレア補正のマスターフレアの

ユーザー調整値を設定する。
R Flare －99 ～±0 ～＋99 本体に起因するフレア補正のRフレアのユー

ザー調整値を設定する。
G Flare －99 ～±0 ～＋99 本体に起因するフレア補正のGフレアのユー

ザー調整値を設定する。
B Flare －99 ～±0 ～＋99 本体に起因するフレア補正のBフレアのユー

ザー調整値を設定する。

Paint > Gamma
ガンマ補正に関する設定を行います。

メニュー項目 設定値 内容
Setting On/Off ガンマ補正機能をオン／オフする。
Gamma Category S-Log3/HLG(Natural)/

HLG(Live)/User
ガンマカテゴリーの設定値は、Projectメニュー 
> Basic Setting > Input Color Space（67
ページ）の設定で決まるため表示のみ。

Paint > Gamma
ガンマ補正に関する設定を行います。

メニュー項目 設定値 内容
Gamma Select Gamma CategoryがS-Log3の

とき：
S-Log3

Gamma Categoryが
HLG(Natural)のとき：

HLG(Natural)
Gamma Categoryが
HLG(Live)のとき：

HLG(Live)
Gamma CategoryがUserのと
き：

User 1/User 2/User 3/
User 4/User 5

ガンマ補正に使用するガンマテーブルを選択す
る。

Paint > Black Gamma
ブラックガンマ補正に関する設定を行います。

［ご注意］
Projectメニュー > Basic Setting > Input Color Space（67ページ）がS-Gamut3.Cine/SLog3またはS-Gamut3/
SLog3に設定されている場合は、Black Gammaはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Setting On/Off ブラックガンマ補正機能をオン／オフする。
Range Low/L.Mid/H.Mid ブラックガンマ補正の有効範囲を選択する。

Low：0%～ 3.6%
L.Mid：0%～ 7.2%
H.Mid：0%～ 14.4%

Master Black 
Gamma

－99 ～±0 ～＋99 マスターブラックガンマレベルを設定する。

Paint > Knee
ニー補正に関する設定を行います。

［ご注意］
Projectメニュー > Basic Setting > Input Color Space（67ページ）がS-Gamut3.Cine/SLog3またはS-Gamut3/
SLog3に設定されている場合は、Kneeはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Setting On/Off ニー補正機能をオン／オフする。
Point －99 ～±0 ～＋99 ニーポイントを設定する。
Slope －99 ～±0 ～＋99 ニースロープを設定する。



000 3章　カメラ操作：フルメニュー一覧80

Paint > White Clip
ホワイトクリップ調整に関する設定を行います。

［ご注意］
Projectメニュー > Basic Setting > Input Color Space（67ページ）がS-Gamut3.Cine/SLog3またはS-Gamut3/
SLog3に設定されている場合は、White Clipはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Setting On/Off ホワイトクリップ調整機能をオン／オフする。
Level 60.0%～ 108.0%～ 109.0% ホワイトクリップレベルを設定する。

Paint > Detail
ディテール調整に関する設定を行います。

メニュー項目 設定値 内容
Setting On/Off ディテール調整機能をオン／オフする。
Level －99 ～±0 ～＋99 ディテールレベルを設定する。
H/V Ratio －99 ～±0 ～＋99 HディテールレベルとVディテールレベルの

ミックス比を設定する。
Crispening －99 ～±0 ～＋99 クリスプニングレベルを設定する。
Level Depend On/Off レベルディペンド調整機能をオン／オフする。
Level Depend Level －99 ～±0 ～＋99 レベルディペンドのレベルを設定する。
Frequency －99 ～±0 ～＋99 Hディテール信号の中心周波数を設定する。（値

を大きくするほどディテールは細くなる。）
Knee Aperture On/Off ニーアパーチャー補正機能をオン／オフする。
Knee Aperture Level －99 ～±0 ～＋99 ニーアパーチャーレベルを設定する。
Limit －99 ～±0 ～＋99 白側、黒側両方向のディテールリミッターを設

定する。
White Limit －99 ～±0 ～＋99 白側のディテールリミッターを設定する。
Black Limit －99 ～±0 ～＋99 黒側のディテールリミッターを設定する。

Paint > Matrix
マトリクス補正に関する設定を行います。

メニュー項目 設定値 内容
Setting On/Off マトリクス補正機能をオン／オフする。
User Matrix On/Off ユーザーマトリクス補正機能をオン／オフす

る。
User Matrix R-G －99 ～±0 ～＋99 マトリクス係数を個別に設定し、映像全域の色

相を微調整する。User Matrix R-B －99 ～±0 ～＋99
User Matrix G-R －99 ～±0 ～＋99
User Matrix G-B －99 ～±0 ～＋99
User Matrix B-R －99 ～±0 ～＋99
User Matrix B-G －99 ～±0 ～＋99

Paint > Multi Matrix
マルチマトリクス補正に関する設定を行います。

［ご注意］
MatrixがOffに設定されている場合は、Multi Matrixはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Setting On/Off 16軸の色相（ヒュー）空間で飽和度（サチュレー

ション）を設定するマルチマトリクス補正をオ
ン／オフする。

Area Indication On/Off 画面上のマルチマトリクス補正の対象となる色
の部分にゼブラパターンを表示する機能をオン
／オフする。

Reset Execute/Cancel 各軸の[Hue]と[Saturation]をすべて初期値に
する（Executeで実行）。

Axis B/B+/MG-/MG/MG+/R/R+/
YL-/YL/YL+/G-/G/G+/CY/
CY+/B-

マルチマトリクス補正の対象となる色（16軸
モード）を設定する。

Hue －99 ～±0 ～＋99 マルチマトリクス補正の対象となる色の色相
（ヒュー）を16軸ごとに設定する。

Saturation －99 ～±0 ～＋99 マルチマトリクス補正の対象となる色の飽和度
（サチュレーション）を16軸ごとに設定する。
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Technicalメニュー

太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Technical > Test Signals
カラーバーに関する設定を行います。

メニュー項目 設定値 内容
Color Bars On/Off カラーバーをオン／オフする。

［ご注意］
RM-B170などのリモートコントロールユニット接続
時は、リモートコントロールユニットからの設定値が
表示され、グレーアウトされます。

Color Bars Type ARIB/SMPTE カラーバーの種類を選択する。
1kHz Tone on Color 
Bars

On/Off カラーバーモード時に1kHzのテスト信号を出
力する機能をオン／オフする。

Test Saw On/Off テスト信号をオン／オフする。
Test Type Saw/Step テスト信号の種類を選択する。

Saw：テスト信号としてSaw波形を出力する。
Step：テスト信号としてStep波形を出力する。

Technical > Switch & Rec Light
RECボタンに関する設定を行います。

メニュー項目 設定値 内容
Lock Operator Side without Rec Button/with 

Rec Button
オペレーターサイドのLOCKスイッチによって
ロックされるボタンにRECボタンを含めるかど
うかを設定する。

Lock Assistant Side without Rec Button/with 
Rec Button

アシスタントサイドのLOCKスイッチによって
ロックされるボタンにRECボタンを含めるかど
うかを設定する。

Rec Light On/Off RECランプをオン／オフする。
Rec Start/Stop Beep On/Off 記録開始・終了操作時にビープ音を出力する機

能をオン／オフする。

Technical > System Configuration
本機の制御に関する設定を行います。

メニュー項目 設定値 内容
Fan Control Auto / Max / Off in Rec/Auto / 

Off in Rec/Max
ファンの制御モードを選択する。
Auto：常時内部温度に応じて自動制御する。
Max：常時最大回転数で動作する。
Off in Rec/Auto：録画中は静音状態で動作し、
録画中以外は内部温度に応じて自動制御す
る。

Off in Rec/Max：録画中は静音状態で動作し、
録画中以外は最大回転数で動作する。

RM/RCP Paint 
Control

On/Off RM-B170などのリモートコントロールユニッ
トのペイント機能をオン／オフする。

［ご注意］
RM/RCP Paint Controlの設定を変更すると、本機の
すべての設定が初期化されます。ただし、RM/RCP 
Paint Controlやネットワークの設定など一部初期化
されない設定があります。

SDI Rec Remote 
Trigger

Off / HD SDI Remote I/F / 
Parallel Rec

SDIリモート制御方式を選択する。
Off：リモート制御しない。
HD SDI Remote I/F：制御方式をHD SDI 

Remoteにする。
Parallel Rec：制御方式をValid Flagにする。

SD HDMI On/Off HDMI出力信号をSDフォーマットにする機能を
オン／オフする。

Shutter Mode Speed/Angle 電子シャッターの動作モードを選択する。
Media Near Full 
Alarm

1min/3min/5min メディア残量が少なくなったことを知らせるア
ラームの閾値を設定する。

Technical > Special Configuration
画面反転やノイズリダクション機能に関する設定を行います。

メニュー項目 設定値 内容
Flip Image Normal/Horizontal Flip/

Vertical Flip/H & V Flip
撮影モード時、画像反転のオン／オフとオンの
ときの画像の反転状態を設定する。

［ご注意］

ˎˎ AXS記録画像は反転されずに記録されます。
ˎˎ Vertical Flip/H&V Flip選択時は、映像信号と音声
信号共に撮像フレームレートで内部の処理が約1 
Frame遅延します。
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Technical > Special Configuration
画面反転やノイズリダクション機能に関する設定を行います。

メニュー項目 設定値 内容
Audio/Video Delay Off/1frame 映像信号と音声信号を遅延させて画像反転して

いる他の機器と同期する機能をオン／オフす
る。
Off：遅延制御をしない
1frame：映像信号と音声信号、メタデータ（タ
イムコードを含む）を約1 Frame遅延させ
る。

［ご注意］
Flip ImageがVertical FlipまたはH & V Flipに設定され
ている場合は1frame固定になります。

NR(4K 17:9/16:9 
AXS)

On/Off 4K 17:9/16:9 AXS記録画像のノイズリダクショ
ンのオン／オフを設定する。

［ご注意］
以下の機能が有効のときはオフ固定になります。
ˎˎ Select FPS
ˎˎ SxS/Output De-Squeeze：Off(1.0x)以外
ˎˎ Flip Image：Normal以外

Level Gauge Adjust Execute/Cancel 水準器のゼロ調整を実行する（Executeで実
行）。

Level Gauge Reset Execute/Cancel 水準器のゼロ調整値をリセットする（Execute
で実行）。

Technical > Lens Configuration
レンズに関する設定を行います。

メニュー項目 設定値 内容
PL-Mt Interface 
Position

Top/Side/Off 接続するレンズの種類に応じて、接続前にあら
かじめレンズインターフェースを設定する。

［ご注意］
レンズを装着した状態で設定を変更した場合は、電源
を再投入してください。

Lens 12pin On/Off レンズIF 12pinをオン／オフする。

［ご注意］
レンズを装着した状態で設定を変更した場合は、電源
を再投入してください。

E-Mount Shading 
Comp.

Auto/Off 対応レンズが装着されている場合に周辺光量落
ちを補正するかを設定する。

Technical > Lens Configuration
レンズに関する設定を行います。

メニュー項目 設定値 内容
E-Mt Chro. Aber. 
Comp.

Auto/Off 対応レンズが装着されている場合に倍率色収差
を補正するかを設定する。

Technical > Authentication
ネットワークの基本認証に関する設定を行います。

メニュー項目 設定値 内容
User Name （現在のユーザー名を表示） アクセス認証に使用する任意のユーザー名を設

定する。
出荷時はadminに設定されています。

Password （*******） アクセス認証に使用するパスワードを設定する
（8文字以上で英数字をそれぞれ1文字以上）。
パスワード入力時、サブディスプレイのITEM
キー 1を押している間、「*」（アスタリスク）を
入力した文字に変更して表示する。

［ご注意］
本機のファームウェアを5.0未満から5.0以降にバー
ジョンアップした場合、パスワード設定はリセットさ
れます。この場合はパスワードを再設定してください。

Technical > Network
ネットワークに関する設定を行います。

メニュー項目 設定値 内容
Setting LAN/Wireless/Off ネットワーク接続ををオン／オフする。

［ご注意］
Technicalメニュー > Authentication > Password
（82ページ）が設定されていない場合は、グレーア
ウトされ設定できません。

LAN DHCP（On/Off） DHCPを設定する。
Onにすると、自動的に本機にIPアドレスを割
り当てる。手動で本機のIPアドレスを入力する
場合は、Offにする。

IP Address（DHCP/On：
自動取得、DHCP/Off：
192.168.2.50）

本機のIPアドレスを入力する。
DHCPがOffのときに有効。

Subnet Mask（DHCP/On：
自動取得、DHCP/Off：
255.255.255.0）

本機のサブネットマスクを入力する。
DHCPがOffのときに有効。
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Technical > Network
ネットワークに関する設定を行います。

メニュー項目 設定値 内容
Wireless Network Mode（Access 

Point/Station）
ワイヤレス接続する際のネットワークモードを
設定する。

Scan Networks（Execute/
Cancel）

接続先のアクセスポイントの自動検出を実行す
る（Executeで実行）。

［ご注意］
Network ModeがStationに設定されている場合のみ
設定できます。

SSID Network ModeがAccess Pointの場合
本機のワイヤレス接続用のSSIDを表示す
る。

Network ModeがStationの場合
接続先のアクセスポイントのSSIDを設定・
表示する。

［ご注意］
表示または入力できる文字は以下のとおりです。
アルファベット（A～ Z、a～ z）
数字（0 ～ 9-.@ ̶ _()）
記号（!"#$%&'*+,/:;<=>?[\]^`{|}~）

Password Network ModeがAccess Pointの場合
本機のワイヤレス接続用のパスワードを表
示する。

Network ModeがStationの場合
接続先のアクセスポイントのパスワードを
設定する。
パスワード入力時、サブディスプレイの
ITEMキー 1を押している間、「*」（アスタ
リスク）を入力した文字に変更して表示す
る。

［ご注意］
表示または入力できる文字は以下のとおりです。
アルファベット（A～ Z、a～ z）
数字（0 ～ 9-.@ ̶ _()）
記号（!"#$%&'*+,/:;<=>?[\]^`{|}~）

WPS（Execute/Cancel） WPSによる接続設定を開始する（Executeで実
行）。

Technical > Network
ネットワークに関する設定を行います。

メニュー項目 設定値 内容
Channel（Auto(5GHz)/Auto/
CH1/CH2/CH3/CH4/CH5/
CH6/CH7/CH8/CH9/CH10/
CH11）

アクセスポイントのチャンネルを設定する。

［ご注意］

ˎˎ Network ModeがAccess Pointに設定されている
場合のみ設定できます。
ˎˎ Auto(5GHz)は、ご使用になるワイヤレスLANモ
ジュールにより、表示されない場合があります。ワ
イヤレスLANモジュールが、ご使用になる国／地域
に対応しているかご確認ください。詳しくは、ワイ
ヤレスLANモジュールの取扱説明書をご覧くださ
い。

DHCP（On/Off） DHCPを設定する。
Onにすると、自動的に本機にIPアドレスを割
り当てる。手動で本機のIPアドレスを入力する
場合は、Offにする。

［ご注意］
Network ModeがStationに設定されている場合のみ
設定できます。

IP Address（DHCP/On：
自動取得、DHCP/Off：
192.168.1.50）

本機のIPアドレスを入力する。
DHCPがOffのときに有効。

［ご注意］
Network ModeがStationに設定されている場合のみ
設定できます。

Subnet Mask（DHCP/On：
自動取得、DHCP/Off：
255.255.255.0）

本機のサブネットマスクを入力する。
DHCPがOffのときに有効。

［ご注意］
Network ModeがStationに設定されている場合のみ
設定できます。

MAC Address 本機に接続されているワイヤレスLANアダプ
ターのMACアドレスを表示する。

Regenerate Password
（Execute/Cancel）

パスワードの再生成を実行する（Executeで実
行）。

［ご注意］
Network ModeがAccess Pointに設定されている場
合のみ実行できます。
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Technical > APR
APR（Auto Pixel Restoration：イメージセンサーの自動調整）を実行します。

メニュー項目 設定値 内容
APR Execute/Cancel 自動欠陥補正（自動ピクセルノイズリダクショ

ン）機能を実行する（Executeで実行）。
Reset Execute/Cancel APRの実行によって追加登録された白点データ

を削除する（Executeで実行）。

Technical > Battery
バッテリーに関する設定を行います。

メニュー項目 設定値 内容
Near End:Info 
Battery

5%～ 100%（5%刻み） インフォバッテリー使用時にバッテリー残量表
示が点滅するしきい値を設定する。

End:Info Battery 0%～ 5% インフォバッテリー使用時に「Battery End」を
表示するしきい値を設定する。

Near End:Sony 
Battery

11.5V～ 17V （0.1V刻み） ソニー製の非インフォバッテリー使用時にバッ
テリー残量表示が点滅するしきい値を設定す
る。

End:Sony Battery 11.0V～ 11.5V （0.1V刻み） ソニー製の非インフォバッテリー使用時に
「Battery End」を表示するしきい値を設定する。

Near End:Other 
Battery

11.5V～ 17V（11.8V）（0.1V刻
み）

ソニー製以外のバッテリー使用時にバッテリー
残量表示が点滅するしきい値を設定する。

End:Other Battery 11.0V～ 14V （0.1V刻み） ソニー製以外のバッテリー使用時に「Battery 
End」を表示するしきい値を設定する。

Detected Battery Sony Info Battery/Sony 
Battery/Other Battery/DC IN 
(12V)/DC IN (24V)

バッテリーの種類を自動判別した結果を表示す
る。

Technical > DC Voltage Alarm
外部DC電源電圧に関するアラームを設定します。

メニュー項目 設定値 内容
DC Low Voltage1 11.5V～ 17V （0.1V刻み） DC IN端子に外部電源を接続している場合に入

力電圧の低下警告を表示するしきい値を設定す
る。

DC Low Voltage2 11.0V～ 14V （0.1V刻み） DC IN端子に外部電源を接続している場合に入
力電圧の不足警告を表示するしきい値を設定す
る。

DC(24V) Low 
Voltage1

22.5V～ 34.0V （0.1V刻み） DC IN端子に24V外部電源を接続している場合
に入力電圧の低下警告を表示するしきい値を設
定する。

Technical > DC Voltage Alarm
外部DC電源電圧に関するアラームを設定します。

メニュー項目 設定値 内容
DC(24V) Low 
Voltage2

22.0V～ 28.0V （0.1V刻み） DC IN端子に24V外部電源を接続している場合
に入力電圧の不足警告を表示するしきい値を設
定する。

Technical > Control Display
ディスプレイに関する設定を行います。

メニュー項目 設定値 内容
Brightness level High/Mid/Low/Minimum サブディスプレイとミニディスプレイの明るさ

を調整する。

Technical > Genlock
ゲンロックに関する設定を行います。

メニュー項目 設定値 内容
Input Source HD SDI/Analog ゲンロック入力信号を選択する。

HD SDI：デジタル
Analog：アナログ

Reference Lock Type Internal/External(HD)/
External(SD)

ゲンロックの状態を表示する。ゲンロックがか
かっている場合は信号の種別を表示する。
Internal：かかっていない。
External(HD)：HD信号でかかっている。
External(SD)：SD信号でかかっている。
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Maintenanceメニュー

太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Maintenance > Clock Set
内蔵時計に関する設定を行います。

メニュー項目 設定値 内容
Time Zone UTC +14:00～ UTC 

Greenwich ～ UTC -12:00（30
分単位）

UTC（グリニッジ標準時）からの時差を30分単
位で選択する。

Date Mode YYMMDD/MMDDYY/
DDMMYY

年月日の表示方式を選択する。
YYMMDD：年月日の順
MMDDYY：月日年の順
DDMMYY：日月年の順

Date 現在の日付を設定する（Setを押して決定）。
Time 現在の時刻を設定する（Setを押して決定）。

Maintenance > Language
メニューとメッセージの表示言語を選択します。

メニュー項目 設定値 内容
Select English/中文(简) フルメニューとメッセージの表示言語を選択す

る。

Maintenance > Hours Meter
積算時間を表示します。

メニュー項目 設定値 内容
Camera(System) 本機の積算使用時間（リセット不可）を表示す

る。
R7 Recorder 
(System)
（AXS-R7装着時のみ）

本機に接続したAXS-R7の積算使用時間（リセッ
ト不可）を表示する。

Camera(Resettable) 本機の積算使用時間(リセット可)を表示する。
R7 Recorder 
(Resettable)
（AXS-R7装着時のみ）

本機に接続したAXS-R7の積算使用時間（リセッ
ト可）を表示する。

Reset-Cam 
(Resettable)

Execute/Cancel 本機のCamera(Resettable)表示を0にリセット
する（Executeで実行）。

Reset-R7 
(Resettable)
（AXS-R7装着時のみ）

Execute/Cancel 本機に接続したAXS-R7のR7 Recorder 
(Resettable)表示を0にリセットする（Execute
で実行）。

Maintenance > Reset to Default
本機を工場出荷状態に戻します。

メニュー項目 設定値 内容
Reset Execute/Cancel 本機のすべての設定を初期化する（Executeで

実行）。

Maintenance > Network Reset
ネットワーク関連設定を工場出荷状態に戻します。

メニュー項目 設定値 内容
Reset Execute/Cancel ネットワーク関連の設定を初期化する

（Executeで実行）。

Maintenance > License Options
ソフトウェアオプションをインストールします。

メニュー項目 設定値 内容
Install: 「対象ライセン
ス」

Execute/Cancel ソフトウェアオプションをインストールする
（Executeで実行）。

Anamorphic Permanent License Installed/
XXdays Remaining (YY keys)/
Expired/Not Installed

アナモフィックオプションが有効かどうかを表
示する。
Permanent License Installed：永久ライセン
スインストール済み
XXdays Remaining (YY keys)：時限ライセン
ス期限内
Expired：時限ライセンス期限切れ
Not Installed：未インストール

Full-Frame Permanent License Installed/
XXdays Remaining (YY keys)/
Expired/Not Installed

フルフレームオプションが有効かどうかを表示
する。
Permanent License Installed：永久ライセン
スインストール済み
XXdays Remaining (YY keys)：時限ライセン
ス期限内
Expired：時限ライセンス期限切れ
Not Installed：未インストール

High Frame Rate Permanent License Installed/
XXdays Remaining (YY keys)/
Expired/Not Installed

ハイフレームレートオプションが有効かどうか
を表示する。
Permanent License Installed：永久ライセン
スインストール済み
XXdays Remaining (YY keys)：時限ライセン
ス期限内
Expired：時限ライセンス期限切れ
Not Installed：未インストール
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Maintenance > License Options
ソフトウェアオプションをインストールします。

メニュー項目 設定値 内容
Unique Device ID ソフトウェアオプションのライセンスキーの発

行手続きに使用するIDを表示する。

Maintenance > Firmware
本機とAXS-R7のバージョン表示および本機のバージョンアップを実行します。

メニュー項目 設定値 内容
Camera 本機のファームウェアバージョンを表示する

（Vx.xx）。
AXS
（AXS-R7装着時のみ）

本機に接続したAXS-R7のファームウェアバー
ジョンを表示する（Vx.xx）。

FW Update-camera Execute/Cancel 本機をバージョンアップする（Executeで実行
する）。

FW Update-AXS-R7 Execute/Cancel 本機に接続したAXS-R7のファームウェアバー
ジョンアップを実行する（Executeで実行）。
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サブディスプレイのクリップ操作
クリップ操作は、クリップリスト画面と再生画面の2つの画面で構成されています。サブディスプ
レイに表示されるクリップリスト画面から再生するクリップを選択して、クリップを再生できます。
メニューのProjectカテゴリーにあるAXS Rec Formatの設定がRec Offではない場合はAXSメディア
が再生可能となり、SxS Rec FormatがRec Off以外の場合はSxSメディアが再生可能となります。

クリップリスト画面

アシスタントサイドのCLIPSボタン（10ページ）を押すと、サブディスプレイに再生可能なメディ
アのクリップリスト画面が表示されます。

5

4

13
12
11
10

9
8
7
6

1. メディア切り換えボタン
SxSとAXS双方のメディアが再生可能な場合
は「SxS/AXS」と表示され、ITEMキー 1を押
すと再生メディアを切り換えることができ
ます。

2. 上方向カーソル移動ボタン
ITEMキー 2を押して、クリップ一覧から再
生するクリップを選択します。

3. 再生開始ボタン
ITEMキー 3を押すと、再生画面（15ペー
ジ）が表示され、再生が開始されます。

4. クリップ一覧
再生アクティブメディア内のクリップ一覧
が表示されます。また、クリップの状態が
アイコンで表示されます。

アイコン 意味
サブクリップが生成されている
クリップ
書き込み禁止されているクリッ
プ

5. 下方向カーソル移動ボタン
ITEMキー 5を押して、クリップ一覧から再

生するクリップを選択します。

6. 再生メディア内のクリップ位置
カーソルがあるクリップのクリップ番号/総
数が表示されます。

7. 作成日時
カーソルがあるクリップの作成日時が表示
されます。

8. フォーマット（コーデック）
カーソルがあるクリップのフォーマット
（コーデック）が表示されます。

9. 画サイズ表示
カーソルがあるクリップを記録したときの
有効画サイズが表示されます。

［ご注意］
再生メディアがSxSのときは表示されません。

10. プロジェクトフレームレート／特殊記録表
示
カーソルがあるクリップのプロジェクトフ
レームレートと特殊記録が表示されます。

11. デュレーション（Dur）
カーソルがあるクリップのデュレーション
が表示されます。

12. タイムコード（TCR）
カーソルがあるクリップの先頭フレームの
タイムコードが表示されます。

13. 再生アクティブメディア
表示しているリストの再生アクティブメ
ディアが表示されます。
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再生画面

クリップリスト画面で再生するクリップを選択し、MENUダイヤルまたはPlayボタン（ITEMキー 3）
を押すと、再生画面が表示されます。

機能表示部

1 2 3

4 5 6

1. F Revボタン
逆方向に高速再生します。

2. Play/Pauseボタン
クリップの再生または再生を一時停止しま
す。

3. F Fwdボタン
順方向に高速再生します。

4. Prevボタン
逆方向にクリップの頭出しをします。

5. Stop/Clipsボタン
再生を停止し、クリップ一覧画面に戻りま
す。

6. Nextボタン
順方向にクリップの頭出しをします。

ステータス表示部

1 2 3 4

8 7

510

6

9

1. タイムデータ表示
再生位置のタイムコードが表示されます。

2. クリップ番号
再生中のクリップ番号／再生可能なクリッ
プ総数が表示されます。

3. フレームレート／イメージャーモード表示
プロジェクトフレームレートと画サイズが
表示されます。

［ご注意］
再生メディアがSxSのとき、画サイズは表示されませ
ん。

4. 特殊記録表示
再生クリップの特殊記録情報が表示されま
す。

5. 音声レベルメーター
再生音声レベルが表示されます。

6. 再生クリップフォーマット（コーデック）表
示
再生クリップのフォーマット（コーデック）
が表示されます。

7. アイコン表示
クリップの状態がアイコンで表示されます。

アイコン 意味
サブクリップが生成されているク
リップ
書き込み禁止されているクリップ

8. クリップ名
クリップ名が表示されます。

9. メディア表示
再生しているメディアが表示されます。

10. 再生状態
再生状態が表示されます。
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再生
本機が記録停止中（Stby）のときは、記録したク
リップを再生することができます。

［ご注意］
各再生項目はITEMキー 1～ 6（9ページ）にそれぞれ
対応しています。ITEMキーを押すと、対応する項目の操
作ができます。

1	再生するSxSメモリーカードを入れる。

2	アシスタントサイドのCLIPSボタン
（10ページ）を押す。
サブディスプレイに再生アクティブなメ
ディアのクリップリスト画面が表示されま
す。

3	  ボタン（ITEMキー 2）、  ボタン（ITEM
キー 5）またはMENUダイヤルで再生するク
リップを選択する。

4	 MENUダイヤルまたはPlayボタン（ITEM
キー 3）を押す。
ビューファインダー・モニター画面に再生
画面が表示されます。

再生操作について

再生操作はサブディスプレイのボタンで行いま
す（88ページ）。
Play/Pauseボタン：再生を一時停止します。も
う一度押すと再生モードに戻ります。

F Fwdボタン /F Revボタン：高速再生します。
Play/Pauseボタンを押すと標準再生に戻り
ます。

Stop/Clipsボタン：再生を停止し、クリップリ
スト画面になります。

音声を聞く

標準再生モードでは、記録されている音声を内
蔵スピーカー（8ページ）またはヘッドホ
ンでモニターできます。
ヘッドホン端子（8ページ）にヘッドホンを
つなぐと、内蔵スピーカーはオフになります。
モニターするチャンネルの選択および音量の調
整は、メニューのAudioカテゴリー > Monitor 
CHおよびMonitor Level（51ページ）で行い
ます。

頭出しする

クリップの先頭から再生するにはサブディスプ
レイ（88ページ）のPrevボタンを押して頭出
しします。
PrevボタンまたはNextボタンを複数回押すこと
で、クリップを飛ばして頭出しすることができ
ます。

SxSメモリーカードを切り換える

SxSメモリーカードが2枚装着されているとき
は、SLOT SELECTボタン（9ページ）を押
して切り換えます。

［ご注意］
再生中にSxSメモリーカードを切り換えることはできませ
ん。またスロットAからスロットBへの連続再生はできま
せん。

AXSメモリーカードに切り換える

AXS-R7に挿入したAXSメモリーカードに記録
された映像を、簡易現像して再生することがで
きます。
AXSメモリーカードに切り換えるには、サブディ
スプレイのITEMキー 1（87ページ）を押し
ます。

本機で再生できないケースについて

以下の条件でAXS記録したクリップは本機で再
生できません。RAW ViewerなどのPCアプリ
ケーションで再生してください。

ˎˎ Imager Modeが6K 3:2、6K 1.85:1、6K 17:9
または6K 2.39:1で、かつProject Frame Rate
が59.94P、50Pまたは47.95P
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ミニディスプレイのホーム画面の操作方法
ミニディスプレイのホーム画面では、本機の状
態の確認や基本的な項目を設定できます。

1
2
3
4
5

1. FPS
撮像フレームレートの設定

2. Shutter
電子シャッターの開角度／スピードの表示
／設定

3. ND Filter
NDフィルターの濃度の表示／設定

4. Exposure Index/Gain
Exposure Indexの表示／設定またはRM-
B170などのリモートコントロールユニット
で設定したゲイン値（dB単位）の表示／設定

 [ご注意]
ゲイン値は、Technicalメニュー > System 
Configuration > RM/RCP Paint Control（81ペー
ジ）がOnに設定されている場合のみ表示されます。

5. WB（White Balance）
ホワイトバランスの表示／設定

RM/RCP Paint Control有効時の表示
と動作について

ˎˎ Technicalメニュー > System Configuration 
> RM/RCP Paint Control（81ページ）が
Onに設定されている場合は、Exposure 
Indexの代わりにゲイン値が表示されます。
この場合、EI値は変更できませんが、ゲイン

値を変更できます。

ˎˎ Technicalメニュー > System Configuration 
> RM/RCP Paint Control（81ページ）が
Onで、RM-B170などのリモートコントロー
ルユニット接続時は、以下の項目は操作でき
ません。リモートコントロールユニットで設
定してください（109ページ）。
ˎˎ Shutter
ˎˎ WB（White Balance）

操作部

HOMEボタン（8ページ）
ホーム画面に戻ります。確定前の変更はキャン
セルされます。

ITEMキー 1（ ）（8ページ）
ホーム画面の項目を選びます。

ITEMキー 2（ ）（8ページ）
選択している項目を決定します。

ITEMキー 3（ ）（8ページ）
ホーム画面の項目を選びます。

基本操作

1	 ITEMキー 1、2、3のいずれかを押す。
カーソルが表示されます。

2	  ボタン（ITEMキー 1）、  ボタン（ITEM
キー 3）で設定したい項目を選ぶ。

3	  ボタン（ITEMキー 2）を押す。
選んだ項目の設定値の選択画面が表示され
ます。

 [ご注意]

 は現在の設定値を示しています。

4	  ボタン（ITEMキー 1）、  ボタン（ITEM
キー 3）で、選択項目または設定値にカーソ
ルを合わせる。

5	  ボタン（ITEMキー 2）を押して決定する。

6	 HOMEボタンを押してカーソルを消す。
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ミニディスプレイのホーム画面設定項目一覧

各項目名称と設定内容は次のとおりです。
太字とアンダーラインで表示されている設定値は、出荷時の設定です。

項目 内容
FPS 撮像フレームレートを設定する。

Fixed/Variable：サブディスプレイのホーム画面（40ページ）で等速撮影と
可変速撮影を切り換えます。
「Fixed」を選択した場合、メニューのProjectカテゴリー > Project Frame 
Rate（49ページ）の設定で値が決まります。

Project Frame Rate 表示

23.98 Fix 23.98

24 Fix 24.00

25 Fix 25.00

29.97 Fix 29.97

47.95 Fix 47.95

50 Fix 50.00

59.94 Fix 59.94

「Variable」を選択した場合、Projectカテゴリー > Imager Mode（67ペー
ジ）の設定によって、設定値が次のように異なります。

Imager Mode 設定値

3.8K 16:9
4K 17:9
4K 2.39:1

1～ 60 FPS

4K 17:91) 1 ～ 60、66、72、75、88、90、96、100、
110 FPS

3.8K 16:9 Surround View
4K 17:9 Surround View
4K 4:3

1～ 48 FPS

4K 4:31) 1 ～ 60、66、72、75 FPS

4K 2.39:11) 1 ～ 60、66、72、75、88、90、96、100、
110、120 FPS

項目 内容

Imager Mode 設定値

4K 4:3 Surround View
4K 6:5
5.7K 16:9
6K 2.39:1
6K 17:9
6K 1.85:1

1～ 30 FPS

6K 2.39:11) 1 ～ 60、66、72、75、90 FPS
6K 17:91)

6K 1.85:11)
1 ～ 60、66、72 FPS

6K 3:2 1～ 25 FPS

6K 3:21) 1 ～ 60 FPS

Exposure Index EI値を設定する。Projectメニュー > Basic Setting > Base ISO（67ページ）
の設定によって、設定値が次のように異なります。
ISO 500：

125EI/160EI/200EI/250EI/320EI/400EI/500EI/640EI/800EI/1000EI/ 
1250EI/1600EI/2000EI

ISO 2500：
640EI/800EI/1000EI/1250EI/1600EI/2000EI/2500EI/3200EI/4000EI/ 
5000EI/6400EI/8000EI/10000EI

Gain 基準感度を設定する。
－6dB/－3dB/0dB/3dB/6dB/9dB/12dB/15dB/18dB

［ご注意］
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）
がOnで、RM-B170などのリモートコントロールユニットが接続されていない場合のみ
設定できます。

Shutter 電子シャッターの開角度／スピードを設定する。
ステップシャッターとして登録されているプリセット値から選択する。

[ご注意]
電子シャッター動作をContinuousにしているときは操作できません。

フルメニューのTechnical > System Configuration > Shutter Mode
（81ページ）の設定によって次のように選択肢が表示される。
Angle（Δ）：開角度表示

360.0/180.0/172.8/144.0/90.0/45.0/22.5/11.2/5.62)

Speed（SS）：スピード表示
1/24、1/25、1/30、1/48、1/50、1/60、1/100、1/120、1/250、
1/500、1/1000、1/20002)
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項目 内容
ND Filter NDフィルターの濃度を設定する。設定値は以下のとおりです。

Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4
WB（White Balance） ホワイトバランスの色温度を設定する。

WBステップとして登録されているプリセット値から選択します。
3200K+00/4300K+00/5500K+002)

1） ハイフレームレートライセンス有効時のみ。
2） 選択肢はサブディスプレイのホーム画面でStep Editから変更することができます。
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ミニディスプレイのクリップ操作
ミニディスプレイに表示されるクリップ画面か
ら再生するクリップを選択して、クリップを再
生できます。
メニューのProjectカテゴリーにあるAXS Rec 
Formatの設定がRec Offではない場合はAXSメ
ディアが再生可能となり、SxS Rec Formatが
Rec Off以外の場合はSxSメディアが再生可能と
なります。
AXS/SxS両方のメディアが再生可能な場合
は、サブディスプレイのクリップリスト画面
（87ページ）でアクティブメディアの選択が
できます。

クリップ画面

オペレーターサイドのCLIPSボタン（8ペー
ジ）を押すと、ミニディスプレイに再生可能な
メディアのクリップ画面が表示されます。

7

6

5

1
2
3
4

1.  再生状態表示
クリップの再生状態が表示されます。

2. 再生アクティブメディア
選択しているクリップの再生アクティブメ
ディアが表示されます。

3. クリップ名
選択しているクリップのクリップ名が表示
されます。

4. 再生メディア内のクリップ位置
選択しているクリップのクリップ番号/総数
が表示されます。

5. F Fwd/Nextボタン
再生一時停止中にITEMキー 3（ ）を押すと
次のクリップに移動します。
再生中にITEMキー 3（ ）を押すと順方向に
クリップの頭出しをします。

6. Play/Pauseボタン
ITEMキー 2（ ）を押すとクリップの再生を
します。または再生を一時停止します。

7. F Rev/Prevボタン
再生一時停止中にITEMキー 1（ ）を押すと
1つ前のクリップに移動します。
再生中にITEMキー 1（ ）を押すと逆方向に
クリップの頭出しをします。

再生する

本機が記録停止中（Stby）のときは、記録したク
リップを再生することができます。

1	再生するSxSメモリーカードを入れる。

2	オペレーターサイドのCLIPSボタン（8
ページ）を押す。
ミニディスプレイに再生アクティブなク
リップが表示されます。

3	 Prevボタン（ITEMキー 1）またはNextボタ
ン（ITEMキー 3）で再生するクリップを選択
する。

4	 Play/Pauseボタン（ITEMキー 2）を押す。
ビューファインダー・モニター画面に再生
画面が表示されます。

再生操作について

再生操作はミニディスプレイのボタンで行いま
す（93ページ）。
Play/Pause ボタン：再生を一時停止します。も
う一度押すと再生モードに戻ります。
F Fwd ボタン/F Rev ボタン：高速再生します。
Play/Pause ボタンを押すと標準再生に戻りま
す。

音声を聞く

標準再生モードでは、記録されている音声を内
蔵スピーカー（8ページ）またはヘッドホ
ンでモニターできます。
ヘッドホン端子（8ページ）にヘッドホンを
つなぐと、内蔵スピーカーはオフになります。
モニターするチャンネルの選択および音量の調
整は、メニューのAudioカテゴリー > Monitor 
CHおよびMonitor Level（51ページ）で行い
ます。

SxSメモリーカードを切り換える

SxSメモリーカードが2枚装着されているとき
は、SLOT SELECTボタン（9ページ）を押

して切り換えます。

［ご注意］
再生中にSxSメモリーカードを切り換えることはできませ
ん。またスロットAからスロットBへの連続再生はできま
せん。
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ネットワークの設定方法と操作方法
本機をネットワークに接続すると、コンピュー
ターやスマートフォン、タブレットなどのデバ
イスから本機の各種機能を制御したり、本機の
各種情報を表示することができます。

ネットワーク機能の概要

本機とデバイスを有線LANまたは無線LAN接続
し、デバイスのブラウザーから本機にアクセス
すると、Webリモコンが表示され、次の各種操
作を行うことができます。

ˎˎ 本機の記録制御（97ページ）
ˎˎ 本機の再生制御（97ページ）
ˎˎ 本機の撮影設定（98ページ）
ˎˎ 本機のレンズ制御（98ページ）
ˎˎ 本機のアサイナブルボタンの設定および操作
（98ページ）

Webリモコンを使用すると、記録の開始／停止
や撮影設定を遠隔操作で調整できるため、本機
を離れた場所に固定する場合や、本機をクレー
ンに装着して使用する場合などに有効です。

対応デバイスについて

本機の設定や操作にはコンピューターやスマー
トフォン、タブレットを使用することができま
す。使用できるデバイス、OS、ブラウザーは次
のとおりです。

デバイス OS ブラウザー
コンピュー
ター

Microsoft Windows 
8.1/Microsoft 
Windows 10

Chrome

macOS 10.14/10.15 Safari
スマート
フォン

Android 8.x/9.0 Chrome
iOS 12.x/13.x Safari

タブレット Android 8.x/9.0 Chrome
iOS 12.x
iPadOS 13.x

Safari

［ご注意］
使用するブラウザーのバージョンによっては、正常に描写
できない場合があります。確認済みのブラウザーのバー
ジョンは次のとおりです
Safari：11, 12
Chrome：V69

本機とデバイスを有線
LAN接続する

本機のネットワーク端子を使用して、有線LAN
接続により直接デバイスに接続、またはルーター
経由で接続することができます。

1	本機ネットワーク端子（8ページ）とコ
ンピューターをLANケーブルで接続する。
または、本機ネットワーク端子とルーター
をLANケーブルで接続する。

2	 Technicalメニュー > Network > Setting
（82ページ）をLANにする。

3	本機の設定をする。
自動的に本機にIPアドレスを割り当てる場
合：

Technicalメニュー > Network > LAN > 
DHCP（82ページ）をOnにして、Setを
選択して確定する。
接続先のIPアドレスを手動で入力する場合：
Technicalメニュー > Network > LAN > 
DHCP をOffにし、LAN > IP Addressで指
定のIPアドレスを入力後、Setを選択して確
定する。

［ご注意］
Technicalメニュー > Network > LANの設定画面で
Setを選択してください。Setを選択しなかった場合は
設定した内容が反映されません。

有線LAN接続が有効になると、ビューファ
インダー・モニター画面にネットワーク接
続状態表示（14ページ）のLANアイコン
が点灯します。

本機とデバイスを無線
LAN接続する

本機にワイヤレスLANアダプター CBK-WA02
（別売り）を取り付けると、本機とデバイスを無
線LANで接続することができます。

CBK-WA02を取り付ける

［ご注意］
CBK-WA02の取り付けは、本機の電源を切った状態で行っ
てください。

1	 USB延長アダプターを下図の位置に取り付
け、固定ネジを時計方向に回して固定する。

固定ネジ

USB 延長アダプター

USB延長アダプターは、図に示す範囲で取
り付け位置を調節することができます。

2	 USB延長アダプターのUSB端子に保護
キャップ（付属）を取り付ける。

3	外部機器接続端子のカバーを開け、USB延
長アダプターのUSB 端子を外部機器接続端
子に差し込む。
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4	 CBK-WA02 をUSB 延長アダプターのUSB 
端子に差し込む。

アクセスポイントモードで接続する

本機をアクセスポイントとしてデバイスと無線
LAN接続します。

スマートフォン／
タブレット

コンピューター

WPS機能搭載のデバイスで接続する
デバイスがWPSをサポートしている場合には、
WPSでの接続が可能です。

1	 Technicalメニュー > Network > Setting
（82ページ）をWirelessにする。

2	 Technicalメニュー > Network > Wireless 
> Network Mode（83ページ）を
Access Pointにする。

3	 Technicalメニュー > Network > Wireless 
> WPS（83ページ）を選択する。

4	 MENUダイヤルを回してExecuteを選択し、
MENUダイヤルを押す。

5	デバイスのNetwork設定／Wi-Fi設定を開
き、Wi-FiをOnにする。

6	デバイスのNetwork設定/Wi-Fi設定の詳細
設定からWPS Push Buttonを押す。

［ご注意］
使用する機器によっては、操作が異なる場合があります。

デバイスでSSID、パスワードを入力して
接続する
デバイス側でSSIDとパスワードを入力して接続
します。

1	 Technicalメニュー > Network > Setting
（82ページ）をWirelessにする。

2	 Technicalメニュー > Network > Wireless 
> Network Mode（83ページ）を
Access Pointにする。

3	デバイスのNetwork設定／Wi-Fi設定を開
き、Wi-FiをOnにする。

4	 Wi-Fi NetworkのSSID一覧から、本機の
SSIDを選択し、パスワードを入力して接続
する。
本機のSSIDおよびパスワードについては、
Technicalメニュー > Network > Wireless 
> SSIDとPassword（83ページ）をでご
確認ください。

［ご注意］
使用する機器によっては、操作が異なる場合があります。

ステーションモードで接続する

本機をクライアントとして既存の無線LANのア
クセスポイントに接続します。
デバイスとはアクセスポイント経由で接続しま
す。

スマートフォン／
タブレット

コンピューター

アクセス 
ポイント

WPS機能を使ってアクセスポイントに接
続する
アクセスポイントがWPS機能対応の場合は、簡
単な設定で接続することができます。

1	アクセスポイントの電源を入れる。

2	本機の電源を入れる。

3	 Technicalメニュー > Network > Setting
（82ページ）をWirelessにする。
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4	 Technicalメニュー > Network > Wireless 
> Network Mode（83ページ）をStation
にする。

5	 Technicalメニュー > Network > Wireless 
> WPS（83ページ）を選択する。

6	 MENUダイヤルを回してExecuteを選択し、
MENUダイヤルを押す。

7	アクセスポイントのWPS ボタンを押す。
WPSボタンの操作については、アクセスポ
イントの取扱説明書をご覧ください。

［ご注意］
接続に失敗した場合は手順1からやり直してください。

SSID、パスワードを入力して接続する
本機でSSIDとパスワードを入力して接続しま
す。

1	 Technicalメニュー > Network > Setting
（82ページ）をWirelessにする。

2	 Technicalメニュー > Network > Wireless 
> Network Mode（83ページ）を
Stationにする。

3	 Technicalメニュー > Network > Wireless
（83ページ）の以下の項目を設定する。
ˎˎ SSID
ˎˎ Password
ˎˎ DHCP
ˎˎ IP Address
ˎˎ Subnet Mask

4	 Setを選択して確定する。

［ご注意］
必ずSetで確定してください。Setで確定しなかった場合は
設定した内容が反映されません。

アクセスポイントを自動検出して接続す
る
接続先のアクセスポイントを自動検出して、
SSIDを手動入力しないで接続することができま
す。

1	 Technicalメニュー > Network > Setting
（82ページ）をWirelessにする。

2	 Technicalメニュー > Network > Wireless 
> Network Mode（83ページ）を
Stationにする。

3	 Technicalメニュー > Network > Wireless 
> Scan Networks（83ページ）を選択す
る。

4	 MENUダイヤルを回してExecuteを選択し、
MENUダイヤルを押す。
本機が接続先のアクセスポイントの自動検
出を開始します。自動検出が終了すると、
接続可能なネットワークがリスト表示され
ます。

5	 MENUダイヤルを回して接続するネット
ワークを選択し、MENUダイヤルを押す。

6	 Setを選択して確定する。
パスワードの入力画面が表示されます。

7	パスワードを入力してDoneを選択する。
Wireless設定詳細画面が表示されます。

8	 Technicalメニュー > Network > Wireless
の以下の項目を入力した後、Setを選択して
確定する。

ˎˎ DHCP
ˎˎ IP Address
ˎˎ Subnet Mask

［ご注意］
必ずSetで確定してください。Setで確定しなかった場合は
設定した内容が反映されません。

Webリモコンを表示する

デバイスのブラウザーから本機にアクセスして
Webリモコンを表示します。Webリモコン画面
は、デバイスの画面サイズに応じて自動で切り
換わります。

1	「本機とデバイスを有線LAN接続する」また
は「本機とデバイスを無線LAN接続する」の
手順に従って、本機とデバイスを接続する。

2	デバイスでブラウザーを起動し、「http://本
機のIPアドレス/rm.html」にアクセスする。
本機のIPアドレスは、Infoカテゴリー > 
SystemのIP Address（51ページ）で確
認できます。
例：IPアドレスが「192.168.1.1」の場合
は、アドレスバーに「http://192.168.1.1/
rm.html」と入力します。

3	ブラウザー画面に、ユーザー名とパスワー
ド（Technicalメニュー > Authentication
（82ページ））を入力する。
接続が完了すると、デバイスにWebリモコ
ン画面が表示されます。

［ご注意］
スマートフォン等でモバイル用ページ表示設定にしている
場合、正しく表示されないことがあります。デスクトップ
用ページ表示設定に変更してください。

Webリモコン画面

Global Menu

Webリモコン画面左上の  を選択すると
Global Menuが表示されます。設定したい項目
を選択します。

Camera Control画面

Camera Control画面は、Camera画面とLens
画面で構成されています。Cameraタブを選択
するとCamera画面が、Lensタブを選択すると
Lens画面が表示されます。
Camera Control画面では、各種表示項目と操
作ボタンが配置されています（Camera画面／
Lens画面／再生画面共通）。
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ˎˎ ネットワーク接続状態（Connected/
Disconnected）
ˎˎ Camera ID*
ˎˎ Recボタン
ˎˎ アサイナブルボタン（1～ 4、A ～ C）

* Camera IDの文字色は、Frame Line A/B Setupの
Colorと同じ色になります。

Camera画面

Camera画面では、サブディスプレイのホーム
画面と同じ内容が表示され各種設定ができます。

［ご注意］
サブディスプレイ画面と同様に、Technicalメニュー > 
System Configuration > RM/RCP Paint Control（81
ページ）がOnに設定されている場合は、EI表示がGain表
示に切り換わり、操作項目に制限がかかります（35ペー
ジ）。

ˎˎ 撮影設定（33ページ） 
FPS、EI、Shutter、ND、LUT、WB
ˎˎ カメラステータス表示（33ページ） 
動作状態、タイムデータ、音声レベルメーター、
クリップ名、記録フォーマット、メディア状
態／残量、電源電圧／バッテリー残量

Lens画面

Lens画面では、ズーム、フォーカス、アイリス
の各レンズコントロールが表示されます。

Full Menu画面

Global MenuでFull Menuを選択すると、フル
メニューの設定画面が表示され、各項目を設定
できます（61ページ）。

［ご注意］
Webリモコンでは一部設定できない項目があります。

OSS(Open Source Software) 
Information画面

Global MenuでOSS Informationを選択すると
オープンソースソフトウェアの情報が表示され
ます。

再生画面

再生画面では、クリップの再生機能の操作を行
うことができます。また画面には再生している
クリップの情報がステータス表示部に表示され
ます。

ˎˎ 機能表示（88ページ） 
F Rev、Play/Pause、F Fwd、Prev、Stop/
Clips、Next
ˎˎ 再生ステータス表示（88ページ） 
タイムデータ表示、クリップ番号、フレーム
レート／再生クリップ画サイズ表示（AXSの
み）、特殊記録表示、音声レベルメーター、再
生クリップフォーマット（コーデック）表示、
アイコン表示（保護、サブクリップ）、クリッ
プ名、再生メディア表示、再生状態

HOMEボタン

HOMEボタンを押すと、Camera画面に切り換
わります。
本体が再生状態で、Webリモコン画面に再生画
面を表示していても、HOMEボタンを押すと、
カメラ撮像状態に戻ります。

CLIPSボタン

CLIPSボタンを押すと、再生画面に切り換わり
ます。（本体はクリップリスト画面に切り換わり

ます（87ページ）。）

記録する

Camera Control画面でRecボタンを押すと記録
が始まりRECランプが赤色に点灯し、もう一度
押すと記録が停止します。
Recボタン右下のREC ACTIVEランプが緑のとき
Recボタンを操作できます。

Recボタンをロックするには

Recボタン下のLockつまみを右にスライドする
と、Recボタンの操作を禁止することができま
す。

再生する

Camera画面でCLIPSボタンを押すと、再生画面
に切り換わり、本体が再生状態になります。（本
体のサブディスプレイはクリップリスト画面が
表示されます（87ページ）。）
再生画面で再生するクリップの選択、再生操作
を行うことができます。

再生メディアを切り換えるには

本機が再生状態のときはメディア切り換えボタ
ンが表示されます。SxSとAXS双方のメディア
が再生可能な場合は、メディア切り換えボタン
が有効になり、ボタンを押すと再生メディアを
切り換えることができます。
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撮影設定をする

Camera画面で、本機のサブディスプレイのホー
ム画面と同じ項目の設定と操作を行うことがで
きます。

［ご注意］
ShutterのStep Edit操作はできません。

操作方法はサブディスプレイのホーム画面と同
じです。

 ˜「サブディスプレイのホーム画面の操作方法」
（35ページ）

レンズを制御する

Lens画面で、Eマウントレンズ設定（ズーム、
フォーカス、アイリス）の状態を確認したり、
制御可能なレンズを装着していた場合はスライ
ダー操作でズーム、フォーカス、アイリスを制
御できます。
Lens画面で、PLマウントCookeレンズ通信制御
が可能です。
また、Lens画面で、12pinレンズ通信制御が可
能です。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP 
Paint Control（81ページ）がOnで、RM-B170などのリ
モートコントロールユニット接続時は、スライダーはグ
レーアウトされ操作できません。フォーカスとズームのス
ライダーは、フォーカスまたはズームのリモート操作を有
効にした場合にグレーアウトされます。

アサイナブルボタンを 
設定／操作する

Camera Control画面には、アサイナブル1 ～ 4
ボタンとビューファインダーアサイナブルA ～ 
Cボタンが配置されています。
本機のアサイナブル1 ～ 4ボタンおよびDVF-
EL200のアサイナブルA ～ Cボタンを操作した
ときと同様に、アサイナブルボタンを押すと、
割り当てられた機能のOn（有効）とOff（無効）
を切り換えたり、割り当てられた機能を起動し
たりできます。
アサイナブルボタンの機能名を選択すると、切
り換え可能な選択肢がプルダウン表示され、選
択肢を選択することにより、アサイナブルボタ
ンに割り当てる機能を変更できます。

 ˜「アサイナブル1～ 4ボタンに割り当て可能な機能」
（45ページ）

 ˜「ビューファインダー（DVF-EL200）アサイナブルA ～ 
Cボタンに割り当て可能な機能」（46ページ）

［ご注意］
アサイナブルボタンに割り当てた機能が、ボタンを押して
いる間だけ有効になる機能、またはボタンを長押しして有
効になる機能だった場合、Webリモコンのアサイナブル
ボタンからの操作は無効になります。対象となる機能は以
下のとおりです。

 – Press & Hold for SDI Log
 – Press & Hold for Monitor Log
 – Press & Hold for VF Log
 – Iris Open (1/16 stop)
 – Iris Close (1/16 stop)

Webリモコン画面をロッ
クする

Webリモコン画面右上のLockつまみを右にスラ
イドすると、Webリモコン画面の操作を禁止す
ることができます。
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基本操作
基本的な撮影は次の手順で行います。

1	必要な機器が取り付けられ、電源が供給さ
れていることを確認する。

2	電源スイッチ（8ページ）をONにする。
ビューファインダーに撮影画面が表示され
ます。

3	必要なメモリーカードを入れる。
AXSメモリーカードまたはSxSメモリーカー
ドは2枚入れておくと、1枚目がフルになっ
た時点で自動的に2枚目に切り換わります。

 ［ご注意］
同時記録中は、自動的には切り換わりません。

4	 RECボタン（8、10ページ）を押す。
RECランプが点灯して、記録が始まります。

 ［ご注意］
REC操作を受け付けた後、すぐに記録を開始できない
場合はRECランプが点滅に変わり、記録開始されると
点灯します。

5	記録を終了するときは、もう一度RECボタ
ンを押す。
記録が停止し、本機はSTBY（記録待機）モー
ドになります。
記録を停止すると、開始から停止までの画
像・音声と付随データが、ひとつのクリッ
プとして記録されます。

クリップ名について

Cam ID + Reel#形式のクリップ名で記録を行い
ます。以下の規則に従ってクリップ名が生成さ
れます。

ˎˎ 挿入されたSxSメモリーカードまたはAXSメ
モリーカードにCam ID + Reel#形式のクリッ
プ名が存在している場合は、最終クリップの
情報が継承されます。 
例：「B002C003_XXXXXXXX」がAXSメモ
リーカードに存在している場合 
次に生成されるクリップは「B002C004_
XXXXXXXX」になります。
ˎˎ 空のAXSメモリーカードを挿入した場合は、
前回記録したクリップのReel Numberに1だ
け追加されます。 
例：カード1で「D001CXXX_XXXXXXXX」
まで記録した後、空のカード2を入れて記録
を行った場合 
次に生成されるクリップは「D002C001_ 
XXXXXXXX」になり、記録開始までクリップ
名表示に下線が表示されます。

ˎˎ メニューのTC/MediaカテゴリーのCamera 
IDや、Reel Numberを設定した場合は、その
情報が有効になります。 
例：「E003CXXX_XXXXXXXX」まで記録し
たAXSメモリーカードのCamera IDとReel 
Numberをメニューから変更した場合 
Camera IDを「F」に、Reel Numberを「001」
に変更すると、次に記録されるクリップは
「F001CXXX_XXXXXXXX」になります。また、
Camera IDだけを変更すると、Reel Number
は「001」に変更されます。

クリップの最長時間

SxSメモリカードに記録できる単独クリップの
最長時間は6時間です。また、録画最大時間は、
24時間です。
録画時間がクリップの最長時間を超える場合、
クリップを跨いで記録を継続します。
録画時間が、24時間に達した場合、記録が停止
します。
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便利な機能
同時記録

1スロットのSxSメモリーカードに2つの画サイ
ズの映像を同時に記録したり、AXS-R7にRAW
フォーマットの映像・音声を記録しながら、本
体のSxSメモリーカードにHD信号を同時に記録
することができます。
「記録フォーマット設定表」（53ページ）に
従ってメニューのProjectカテゴリー > AXS 
Rec FormatとSxS Rec Format、もしくはSxS 
Rec FormatとSub Rec Formatを設定すること
で同時記録することができます。

1スロット同時記録を実施した際のXAVC 4K 
Class480/XAVC 4K Class300/XAVC QFHD 
Class480/XAVC QFHD Class300のクリップ
は、SxSメモリーカードのXDROOT/Clipディレ
クトリー下に記録されますが、MPEG2 1920
×1080のクリップは、SxSメモリーカードの
XDROOT/Subディレクトリー下に記録され、
クリップ名は末尾に「S02」のサフィックスが追
加されます。

［ご注意］
ProRes 4444 HD Pのビデオフォーマットでは、同時記録
はできません。

ユーザーフレームライン表
示

ユーザーフレームラインは任意に設定した表示
にするか、固定のアスペクト比を表示するかを
選択することができます。
任意に設定する場合は、Monitoringメニュー 
> User Frame Line > Select（75ページ）
でVariableを選択し、Width、Height、H 
Position、V Positionの各メニュー項目（75
ページ）で設定することができます。
固定のアスペクト比を設定する場合は、
Monotoringメニュー > User Frame Line > 
Select（75ページ）でPresetを選択し、Preset 
Aspect Ratio、Scaling、Preset Aspect Ratio 
Typeの各メニュー項目（75ページ）で設定す
ることができます。
任意の設定、固定のアスペクト比の設定ともに、
Aspect Ratio(Pixels)（75ページ）で、設定し
たユーザーフレームラインのアスペクト比、画
素数、アナモフィック倍率を確認することがで
きます。

［ご注意］
アナモフィック倍率を設定できない有効画サイズ（Imager 
Mode）設定のときは、アナモフィック倍率は表示されま
せん。

ピクチャーキャッシュレッ
ク

撮影している映像／音声データを、本機のメモ
リーに常時数秒間（最大30秒間）分蓄えておく
ことにより、記録を開始したとき、その数秒前
からの映像を記録することができます。
Projectメニュー > Special RecordingのCache 
Rec Select（68ページ）をオンにして記録
を開始すると、Projectメニュー > Special 
RecordingのMax Cache Rec Duration（68
ページ）で設定した蓄積時間にさかのぼって映
像を記録します。
Picture Cache Recを割り当てたアサイナブル
ボタンを押して、ピクチャーキャッシュレック
機能をオン／オフすることもできます。

［ご注意］

ˎˎ システム周波数や記録フォーマット、記録するメディ
アによってMax Cache Rec Durationの設定に制限が
あります。詳しくは68ページを参照してください。
ˎˎ 記録フォーマットなどのシステム設定を変更すると、
メモリーに蓄えられていた画像がクリアされます。変
更直後に記録を開始しても、変更前に撮影した映像は
記録されません。ピクチャーキャッシュモードは自動
的に解除されます。
ˎˎ ピクチャーキャッシュモードでは、1スロット同時記録
およびAXSとSxSの同時記録はできません。
ˎˎ 記録中にピクチャーキャッシュの設定を変更すること
はできません。
ˎˎ 低い撮像フレームレートでMPEG 422記録を行った場
合、記録停止やメモリーカードの切り換わり動作に時
間がかかることがあります。

レックレビュー

アサイナブル1～ 4ボタン（43ページ）のい
ずれかにRec Reviewを割り当てると、直前に
記録したクリップの映像を画面で確認（レック
レビュー）できます。
記録を停止し、Rec Reviewを割り当てたアサ
イナブルボタンを押すと、クリップの最初のフ
レームから1倍速で再生します。
クリップの終りまで再生すると、レックレビュー
は終了し、STBY（記録待機）モードに戻ります。
また、再生中にオペレーターサイドもしくはア
シスタントサイドのHOMEボタンを押すと、再
生が停止し記録可能な状態になります。
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高精細拡大フォーカス機能

ビューファインダー画面、またはMonitor出力
に対して、拡大表示することができます。
本機に装着されたビューファインダー（DVF-
EL200、DVF-L700）のFOCUS MAGボタンや、
VF Focus Magnifierを割り当てたアサイナブ
ルボタンを押すことによって、ビューファイン
ダーの画面中央部分が拡大表示され、フォーカ
スを合わせやすくなります。または、Monitor 
Focus Magnifierを割り当てたアサイナブルボ
タンを押すことによって、Monitor出力映像の
画面中央部分が拡大表示され、フォーカスを合
わせやすくなります。
拡大表示中は、記録映像やMonitor出力を除い
た他の出力信号に影響はありません。
通常の拡大フォーカスは、それまで表示されて
いる画の一部分を拡大するため解像度が荒くな
りますが、本機のx2倍フォーカスは、拡大した
部分が記録映像やMonitor出力を除いた他の出
力信号とは別に4K映像からの切り出しで表示さ
れるため解像度を保ったまま拡大フォーカス調
整することが可能です。
また、さらに4K切り出し映像からの拡大でx4倍
フォーカスも選択できます。
アサイナブルボタン（45ページ）に割り当て
ることができる拡大フォーカス機能は以下のと
おりです。
ビューファインダー画面の拡大フォーカス機能：

VF Focus Maginifier
Monitor出力の拡大フォーカス機能：Monitor 

Focus Magnifier

FOCUS MAGボタンや、拡大フォーカス機能を
割り当てたアサイナブルボタンの動作順は以下
の項目で設定できます。
ビューファインダー画面：Monitoringメニュ
ー > VF Display > VF Magnifier Ratio（77
ページ）

Monitor出力：Monitoringメニュー > 
Monitor Display > Monitor Magnifier 
Ratio（74ページ）

VF Magnifier Ratioをx2.0/x4.0に設定すると、
VF Focus Magnifierを割り当てたアサイナブル
ボタンを押すたびに、x2.0→x4.0→x1.0→x2.0
の順に拡大率が切り換わります。
同様にMonitor Magnifier Ratioをx2.0/x4.0に
設定すると、Monitor Focus Magnifierを割り
当てたアサイナブルボタンを押すたびに、拡大
率が切り換わります。

［ご注意］

ˎˎ 撮像フレームレートが61fps以上のハイフレームレート
モード時は、4K映像からの切り出し表示ができないた
め、x2/x4倍フォーカスの表示映像の解像度が下がりま
す。
ˎˎ Project Frame Rateが59.94または50のとき、Monitor
出力設定が1920x1080Pの場合、Monitor Magnifier 
Ratioはx4.0およびx2.0/x4.0には設定できません。ま
た、Monitor出力設定が1920x1080iの場合、Monitor 
Focus Magnifierは動作しません。
ˎˎ HDMI出力がMonitor出力と同じ出力フォーマットの
場合にMonitor Focus MagnifierはHDMI出力に対し
ても拡大表示されます。Monitoringメニュー > OSD 
Appearance > HDMI（73ページ）で設定を確認でき
ます。HDMIがSame as Monitorに設定されている場合、
HDMI出力はMonitor出力と同じです。

ハイライトクリップインジ
ケーター

高輝度のためクリップされた箇所を赤色にして
Monitor出力映像およびビューファインダー出
力映像に表示することができます。
Monitor Highlight Clip IndおよびVF 
Highlight Clip Indを割り当てたアサイナブル
ボタン（43ページ、45ページ）を押すと、
ハイライトクリップインジケーターのオン／オ
フを切り換えることができます。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP 
Paint Control（81ページ）がOnに設定されている場合
は、ハイライトクリップインジケーターは動作しません。

ハイ／ローキー

Monitor出力映像およびビューファインダー出
力映像を、高輝度の白飛び確認または低輝度の
暗部確認の状態にすることができます。
High Keyがオンになると、高輝度部分の差異が
見やすくなり、高輝度の白飛びを確認できます。
Low Keyがオンになると、低輝度部分の差異が
見やすくなり、低輝度の暗部を確認できます。
Monitor High/Low KeyおよびVF High/Low 
Keyを割り当てたアサイナブル1～ 4ボタン
（45ページ）を押すと、ハイ／ローキーの設定
を切り換えることができます。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP 
Paint Control（81ページ）がOnに設定されている場合
は、ハイ／ローキーは動作しません。

フォルスカラー表示

本機に装着されたビューファインダー 
（DVF-EL200）のB/False Colorボタン、または
ビューファインダー（DVF-L700）のSPAREボ
タンを押すことによって、ビューファインダー
内にフォルスカラー（偽色）表示を行うことが
できます。
また、モニター出力にもフォルスカラー表示を
行うことができます。

表示色 信号レベル
S-Log3 (初期値) S-Log2（PMW-F55

参考値）
赤 93.4%～ 96.1% 105.5%～

109.5%
黄 91.3%～ 93.4% 102.5%～

105.5%
オレンジ 87.7%～ 90.6% 97.4%～ 101.5%
ピンク 54.3%～ 58.0% 50.2%～ 55.2%
ライト 
ピンク

47.8%～ 50.8% 
(18%Gray+1stop)

41.5%～ 45.4% 
(18%Gray+1stop)

シアン 43.8%～ 46.5% 36.3%～ 39.6%
緑 38.9%～

42.2%(18%Gray)
30.4%～
34.4%(18%Gray)

ライト 
ブルー

24.6%～ 34.4% 15.5%～ 25.2%

青 3.5%～ 5.6% 3.0%～ 4.0%
紫 -7.3%～ 3.5% -7.3%～ 3.0％

ˎˎ Monitoring > False Color（76ページ）
でビューファインダーおよびモニター出力の
フォルスカラーの各色のオン／オフと閾値を
プリセットにするか手動にするかを設定でき
ます。

ˎˎ VF False Colorを割り当てたアサイナブルボ
タンを押すと、ビューファインダーに表示す
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るフォルスカラー機能をオン／オフできます。

ˎˎ Monitor False Colorを割り当てたアサイナブ
ルボタンを押すと、モニターに表示するフォ
ルスカラー機能をオン／オフできます。

［ご注意］

ˎˎ DVF-L700の場合、ビューファインダーに出力されてい
る映像信号のGammaがS-Log2のときのみ表示可能で
す。
ˎˎ Technicalメニュー > System Configuration > RM/

RCP Paint Control（81ページ）がOnに設定されてい
る場合は、フォルスカラー機能は動作しません。

ビューファインダー倍速駆
動機能

プロジェクトフレームレートが23.98P、24P、
25P、29.97Pの場合、フレーム周波数が低い
ため左右に振って撮影するような場合に映像が
ぶれて見にくい場合があります。
このような場合にビューファインダー倍速駆動
機能を有効にすることで、ビューファインダー
の映像のブレが軽減され、見やすくすることが
できます。
Monitoringメニュー > VF FunctionのDouble 
Speed Scan（77ページ）をOnに設定するこ
とで、機能を有効にすることができます。

［ご注意］

ˎˎ 本機能が有効なときは、電子シャッターは開角度換算
で180°以下に制限されます。
ˎˎ 可変速撮影時は本機能はOffになります
ˎˎ 本機能が有効になるイメージサイズとプロジェクトフ
レームレートは以下のとおりです。 
3.8K 16:9（23.98p、24p、25p、29.97p） 
4K 17:9（23.98p、24p、25p、29.97p） 
3.8K16:9 Surround（23.98p、24p） 
4K 17:9 Surround（23.98p、24p） 

4K 4:3（23.98p、24p） 
4K 2.39:1（23.98p、24p、25p、29.97p）

User 3D LUT

本機では、RAW ViewerやBlackmagic Design 
Pty. Ltd.製DaVinci Resolveで生成される17格
子または33格子のCUBEファイル（*.cube）をイ
ンポートすることができます（37ページ）。
CUBEファイル生成時のInput Color Spaceと本
機のInput Color Spaceは合わせてください。
S-Gamut3.Cine/SLog3で生成した場合は、本
機のProject > Basic SettingのInput Color 
Space（67ページ）をS-Gamut3.Cine/SLog3
に設定してください。
生成されたUser 3D LUTファイルは、SDカード
の以下の階層に保存してください。
PRIVATE\SONY\PRO\LUT\

ASC CDL

本機では、外部ツールで生成された
ASC CDL（The American Society of 
Cinematographers Color Decision List）ファ
イル（*.cdl）をインポートすることができます。
ASC CDLのパラメーターをLookに適用して撮
影を行うことができます。
生成されたASC CDLファイルは、SDカードの
以下の階層に保存してください。
PRIVATE\SONY\PRO\CDL\
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ユーザー設定データ
フルメニューの設定内容は、本機の内蔵メモリー
またはSDカードに保存／読み込みすることがで
きます。このデータを使って、適切なセットアッ
プ状態をすばやく再現できます。
設定データをSDカードに保存する場合は、あら
かじめ、書き込み可能なSDカード（27ページ）
をSDカードスロット（12ページ）に挿入して
おきます。
各ファイルに保存される設定値については、
「ファイルに保存される項目」（131ページ）を
ご覧ください。

Allファイル

全メニューの設定データを保存／読み込みしま
す。
SDカードに64個まで保存することができます。

［ご注意］
機器固有のデータ（機器ごとに調整が必要なシェーディン
グや出力レベルなど）は保存されません。

Sceneファイル

撮影シーンに合わせて設定したペイント項目の
設定値を保存／読み込みします。本機の内蔵メ
モリーに5個、SDカードに64個まで保存するこ
とができます。
次のデータをSceneファイルに保存できます。
ˎˎ Paintメニューを使用して設定した値
ˎˎ シャッター、NDフィルター、Gain、Base 
ISO、Input Color Space、NRの設定
ˎˎ ホワイトバランスのデータ

［ご注意］
Technicalメニュー > System Configuration > RM/RCP 
Paint Control（81ページ）がOffに設定されている場合、
設定値の保存／読み込みはできません。

ユーザーガンマ

ユーザーが作成したユーザーガンマファイルを
本機の内蔵メモリーに5個まで保存することが
できます。

［ご注意］
Technicalメニュー > System Configuration > RM/RCP 
Paint Control（81ページ）がOffに設定されている場合
は保存できません。
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Allファイル
設定データをAllファイル
として保存する

1	 Projectメニュー > All File > Save SD Card
（70ページ）を選択する。
Allファイルの保存先画面が表示されます。

2	 MENUダイヤルを回して保存先を選択し、
MENUダイヤルを押す。
File IDがNo Fileの行にファイルを保存する
ことができます。
File IDにFile IDが記載されている行を選択
すると、そのファイルに上書きされます。
File IDは自動的に付けられますが、変更す
ることもできます。

3	 MENUダイヤルを回して確認画面の
Executeを選択し、MENUダイヤルを押す。

ファイルの保存が実行されないとき
は

操作中または操作後に次のエラーメッセージが
表示されたときは、ファイルは保存されません。

エラー 
メッセージ

状況 対策

File Access 
NG

保存可能なSD
カードが挿入さ
れていない

保存可能なSD
カードを挿入す
る

File IDを変更する

1	 Projectメニュー > All File > File ID（70
ページ）を選択する。
File IDの編集画面が表示されます。

2	文字を選択してFile IDを入力する。

3	 MENUダイヤルを回してDoneを選択し、
MENUダイヤルを押す。
File IDの変更が完了します。

設定データを読み込む

1	 Projectメニュー > All File > Load SD Card
（70ページ）を選択する。
Allファイル一覧画面が表示されます。

2	 MENUダイヤルを回して読み込むファイル
を選択し、MENUダイヤルを押す。
確認画面が表示されます。

3	 MENUダイヤルを回してExecuteを選択し、
MENUダイヤルを押す。

［ご注意］

ˎˎ SDカードからファイルを読み込むと、本機内部に保存
されているデータは上書きれます。
ˎˎ ファイルを保存した機器より古いバージョンの機器で
は読み込まないでください。故障の原因となることが
あります。
ˎˎ 設定データを読み込むと、本機は自動的に再起動され
ます。

ファイルの読み込みが実行されない
ときは

操作中または操作後に次のエラーメッセージが
表示された場合は、ファイルの読み込みは行わ
れません。

エラー 
メッセージ

状況 対策

File Access 
NG

ˎˎ ファイルの読
み込みが異常
終了した
ˎˎ SDカードの該
当ファイルの
データが壊れ
ている

ˎˎ 読み込みを再
実行する
ˎˎ SDカードを再
挿入する
ˎˎ SDカードに正
常なファイル
を保存する

［ご注意］

ˎˎ AXS-R7を装着した本機で保存されたファイルは、
AXS-R7を装着していない本機に読み込むことはできま
せん。
ˎˎ 各ソフトウェアオプションをインストールした本機で
保存されたファイルは、該当ソフトウェアオプション
がインストールされていない本機に読み込むことはで
きません。
ˎˎ V3.0以前の本機で保存したファイルは、Technicalメ
ニュー > System Configuration > RM/RCP Paint 
Control（81ページ）をOffにして読み込んでくださ
い。

現在の設定値をすべて初期
値に戻す

1	 Maintenanceメニュー > Reset to Default
（85ページ）を選択する。
確認画面が表示されます。

2	 MENUダイヤルを回してExecuteを選択し、
MENUダイヤルを押す。

［ご注意］
実行後、本機は自動的に再起動されます。
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Sceneファイル
Sceneファイルを内蔵メモ
リーに保存する

1	 Projectメニュー > Scene File > Store 
Internal Memory（70ページ）を選択す
る。
Sceneファイル一覧画面が表示されます。
File IDがStandardの保存先にはあらかじめ
標準設定が保存されます。

2	 MENUダイヤルを回して保存先を選択し、
MENUダイヤルを押す。
選択した保存先にSceneファイルが上書き
されます。

3	 MENUダイヤルを回して確認画面の
Executeを選択し、MENUダイヤルを押す。

SceneファイルをSDカー
ドに保存する

1	 Projectメニュー > Scene File > Save SD 
Card（70ページ）を選択する。
Sceneファイル保存先画面が表示されます。

2	 MENUダイヤルを回して保存先を選択し、
MENUダイヤルを押す。
File IDがNo Fileの行にファイルを保存する
ことができます。
File IDにFile IDが記載されている行を選択
すると、そのファイルに上書きされます。
File IDは自動的に付けられますが、変更す
ることもできます。

3	 MENUダイヤルを回して確認画面の
Executeを選択し、MENUダイヤルを押す。

File IDを変更する

1	 Projectメニュー > Scene File > File ID
（70ページ）を選択する。
File IDの編集画面が表示されます。

2	文字を選択してFile IDを入力する。

3	 MENUダイヤルを回してDoneを選択し、
MENUダイヤルを押す。
File IDの変更が完了します。

Sceneファイルを内蔵メモ
リーから読み込む

1	 Projectメニュー > Scene File > Recall 
Internal Memory（70ページ）を選択す
る。
Sceneファイル一覧画面が表示されます。

2	 MENUダイヤルを回して読み込むファイル
を選択し、MENUダイヤルを押す。
確認画面が表示されます。

3	 MENUダイヤルを回してExecuteを選択し、
MENUダイヤルを押す。

SceneファイルをSDカー
ドから読み込む

1	 Projectメニュー > Scene File > Load SD 
Card（70ページ）を選択する。
Sceneファイル一覧画面が表示されます。

2	 MENUダイヤルを回して読み込むファイル
を選択し、MENUダイヤルを押す。
確認画面が表示されます。

3	 MENUダイヤルを回してExecuteを選択し、
MENUダイヤルを押す。



000 6章　ユーザー設定データの保存と読み込み106

ユーザーガンマ
RAW Viewer V3.4で作成
したユーザーガンマファイ
ルを使用する

RAW Viewer V3.4で作成したユーザーガンマ
ファイルを本機で使用することができます。
作成したデータを使用するにはSDカードの以下
の階層に保存してください。
PRIVATE/SONY/PRO/CAMERA/MPC3610
RAW Viewer V3.4について詳しくは、お買い上
げ店またはソニーのサービス窓口にお問い合わ
せください。

ユーザーガンマファイルの読み込みや確認、リ
セットなどの操作を行うには、Technicalメ
ニュー > System Configuration > RM/RCP 
Paint Control（81ページ）をOnに設定して、
ペイント機能をオンにします。

SDカードからユーザーガ
ンマファイルを読み込む

1	 Projectメニュー > User Gamma > Load 
SD Card（70ページ）を選択する。
ユーザーガンマファイル一覧画面が表示さ
れます。
ユーザーガンマファイル一覧画面では、5個
のファイルが一度に選択されます。

 ［ご注意］
読み込み操作は5個まとめて行われます。1個だけファ
イルを選択することはできません。

2	 MENUダイヤルを押す。
確認画面が表示されます。

3	 MENUダイヤルを回してExecuteを選択し、
MENUダイヤルを押す。
5個のファイルが内蔵メモリーに読み込まれ
ます。

現在の内蔵メモリーに保存
されているユーザーガンマ
ファイルを確認する

Projectメニュー > User Gamma > Current 
Settings（70ページ）を選択すると、現在本
機内蔵メモリーに保存されているユーザーガン
マファイル一覧画面が表示されます。

［ご注意］
SDカードからユーザーガンマファイルを読み込む前は、
Projectメニュー > Basic Setting > Input Color Space
（67ページ）がRec.709/User Gammaに設定されている
場合、Nameには初期値である「709(800%)」が表示され
ます。Rec.709/User Gamma以外に設定されている場合
は、「HLG(Natural)」が表示されます。

内蔵メモリーに保存した
ユーザーガンマファイルを
設定する

1	 Projectメニュー > Basic Setting > Input 
Color Space（67ページ）をRec.2020/
User GammaまたはRec.709/User Gamma
に設定する。

 ［ご注意］
Rec.2020/User GammaまたはRec.709/User 
Gammaは、Technicalメニュー > System 
Configuration > RM/RCP Paint Control（81ペー
ジ）がOnに設定されている場合のみ選択できます。

2	 Paintメニュー > Gamma > Gamma 
Select（79ページ）で、User 1～ User 5
のいずれかを選択する。

 ［ご注意］
Gamma Selectの選択肢User 1～User 5は、ユーザー
ガンマファイル一覧画面のNo.1～ 5に該当します。
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内蔵メモリーに保存されて
いるユーザーガンマファイ
ルを初期状態にリセットす
る

1	 Projectメニュー > User Gamma > Reset
（70ページ）を選択する。
リセットするガンマファイル番号の選択肢
画面が表示されます。

2	 MENUダイヤルを回してリセットするガン
マファイル番号（1～ 5）を選択する。
すべてのガンマファイルをリセットする場
合はAllを選択します。
確認画面が表示されます。

3	 MENUダイヤルを回してExecuteを選択し、
MENUダイヤルを押す。
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リモートコントロールユニットを接続する
リモートコントロールユニットRM-B170やリ
モートコントロールパネルRCP-1001/1501な
どのコントロールユニットを接続すると、それ
らの機器から本機の機能の一部をコントロール
することが可能です。

リモートコントロールユ
ニットを接続する

リモートケーブルを使って、本機のREMOTE端
子（8ピン）と、コントロールユニットのカメラ
端子を接続します。
接続後に本機の電源を入れると、本機はリモー
トコントロールモードになり、本機のメニュー
操作や撮影操作が可能となります。

［ご注意］

ˎˎ 本機の電源を入れたままコントロールユニットを接続
したり、接続を外さないでください。
ˎˎ リモートコントロールパネルRCP-1001/1501にはリ
モートケーブルは付属されていません。

リモートコントロールモー
ドを解除する

本機の電源を切り、コントロールユニットを取
り外します。

ペイント機能を設定する

ペイント機能を設定するには、Technicalメ
ニュー > System Configuration > RM/RCP 

Paint Control（81ページ）をOnに設定する必
要があります。
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RCP-1001/1501、RM-B170/B750で操作できる主な機能

表の見かた
操作表示の記号の意味は次のとおりです。
○：操作できる
―：操作できない
項目 小項目 細目 選択肢 RCP-1001 RCP-1501 RM-B170 RM-B750
Shooting FPS Fixed/Variable Select On/Off ― ○ ○1) ○

FPS Select 1FPS ～ 120FPS ― ○ ○1) ○
Shutter Select2) Shutter ON/OFF On/Off ― ○ ○ ○

ECS ON/OFF On/Off ― ○ ○ ○
Shutter Speed Step用に登録した任意の値。

以下の値を表示可能。
1/32
1/33
1/48
1/50
1/60
1/96
1/100
1/120
1/125
1/250
1/500
1/1000
1/2000
1/3000
1/4000
1/5000

― ○ ○ ○

ECS Frequency ― ― ○ ○ ○
ND ND Position 1：（CLEAR）

2：（濃度0.3）
3：（濃度0.6）
4：（濃度0.9）
5：（濃度1.2）
6：（濃度1.5）
7：（濃度1.8）
8：（濃度2.1）
9：（濃度2.4）

○ ○ ○ ○

Gain2) Gain(Step) －6dB/－3dB/0dB/3dB/6dB/9dB/12dB/15dB/18dB ○ ○ ○ ○
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項目 小項目 細目 選択肢 RCP-1001 RCP-1501 RM-B170 RM-B750
White Balance2) Color Temp 2000K ～ 15000K3) ― ○ ― ○

Color Temp Balance (Tint.相当) －99 ～ ±0 ～ +994) ― ○ ― ○
R Gain －99 ～ ±0 ～ +99 ○ ○ ○ ○
B Gain －99 ～ ±0 ～ +99 ○ ○ ○ ○
Auto White Balance ― ○ ○ ○ ○

Project Scene File2)5) ― ― ― ○ ― ○
Standard6) ― ― ○ ○ ― ○

Paint2) Switch Status Gamma On/Off ― ○ ○1) ○
Black Gamma7) On/Off ― ○ ○1) ○
Matrix On/Off ― ○ ― ○
Knee7) On/Off ― ○ ○1) ○
White Clip7) On/Off ― ○ ― ○
Detail On/Off ― ○ ― ○
Flare On/Off ― ○ ○1) ○
Test Saw8) On/Off ― ○ ○1) ○

Black Master Black －99 ～ ±0 ～ +99 ○ ○ ○ ○
R Black －99 ～ ±0 ～ +99 ○ ○ ○ ○
B Black －99 ～ ±0 ～ +99 ○ ○ ○ ○

Flare Setting On/Off ― ○ ○1) ○
Master Flare －99 ～ ±0 ～ +99 ― ○ ○1) ―
R Flare －99 ～ ±0 ～ +99 ― ○ ― ○
G Flare －99 ～ ±0 ～ +99 ― ○ ― ○
B Flare －99 ～ ±0 ～ +99 ― ○ ― ○

Gamma Setting On/Off ― ○ ○1) ○
Gamma Category（表示のみ）9) S-Log3/HLG/User ― ○ ― ○
Gamma Select User 1/User 2/User 3/User 4/User 5 ― ○ ― ○

Black Gamma7) Setting On/Off ― ○ ○1) ○
Range Low/L.Mid/H.Mid ― ○ ― ○
Master Black Gamma －99 ～ ±0 ～ +99 ― ○ ○1) ○

Knee7)10) Setting On/Off ○ ○ ○ ○
Point －99 ～ ±0 ～ +99 ○ ○ ○ ○
Slope －99 ～ ±0 ～ +99 ○ ○ ― ○

White Clip7) Setting On/Off ― ○ ― ○
Level －99 ～ ±0 ～ +99 ― ○ ― ○
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項目 小項目 細目 選択肢 RCP-1001 RCP-1501 RM-B170 RM-B750
Detail Setting On/Off ― ○ ― ○

Level －99 ～ ±0 ～ +99 ― ○ ― ○
H/V Ratio －99 ～ ±0 ～ +99 ― ○ ― ○
Crispening －99 ～ ±0 ～ +99 ― ○ ― ○
Level Depend On/Off ― ○ ― ○
Level Depend Level －99 ～ ±0 ～ +99 ― ○ ― ○
Frequency －99 ～ ±0 ～ +99 ― ○ ― ○
Knee Aperture On/Off ― ○ ― ○
Knee Aperture Level －99 ～ ±0 ～ +99 ― ○ ― ○
Limit －99 ～ ±0 ～ +99 ― ○ ― ○
White Limit －99 ～ ±0 ～ +99 ― ○ ― ○
Black Limit －99 ～ ±0 ～ +99 ― ○ ― ○

Matrix Setting On/Off ― ○ ― ○
User Matrix On/Off ― ○ ― ○
User Matrix R-G －99 ～ ±0 ～ +99 ― ○ ― ○
User Matrix R-B －99 ～ ±0 ～ +99 ― ○ ― ○
User Matrix G-R －99 ～ ±0 ～ +99 ― ○ ― ○
User Matrix G-B －99 ～ ±0 ～ +99 ― ○ ― ○
User Matrix B-R －99 ～ ±0 ～ +99 ― ○ ― ○
User Matrix B-G －99 ～ ±0 ～ +99 ― ○ ― ○

Multi Matrix Setting On/Off ― ○ ― ○
Area Indication On/Off ― ○ ― ○
Reset Execute/Cancel ― ○ ― ○
Axis B/B+/MG-/MG/MG+/R/R+/YL-/YL/YL+/G-/G/G+/

CY/CY+/B-
― ○ ― ○

Hue －99 ～ ±0 ～ +99 ― ○ ― ○
Saturation －99 ～ ±0 ～ +99 ― ○ ― ○

Technical Test Signals Color Bars On/Off On/Off ○ ○ ○ ○
Test Saw8) On/Off ― ○ ○1) ○

Rec ― ― ― ― ― ○ ○
Play ― ― ― ― ― ○ ○
Stop ― ― ― ― ― ○ ○
F.Rev ― ― ― ― ― ○ ○
F.Fwd ― ― ― ― ― ○ ○
Rec Review ― ― ― ― ― ○ ○
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項目 小項目 細目 選択肢 RCP-1001 RCP-1501 RM-B170 RM-B750
Next ― ― ― ― ― ○ ―
Prev. ― ― ― ― ― ○ ―
White Mode2) Preset ON/OFF ― On/Off ― ― ○ ○
Iris Iris Level ― （対象レンズの制御範囲） ○ ○ ○ ○

Close ― On/Off ○ ○ ― ○
Zoom11) Remote ― On/Off ― ○1) ○1) ―

Speed ― ― ― ― ― ―
Tele～Wide ― ― ― ○1) ○1) ―
Zoom Value[%] ― ― ― ○1) ○1) ―
Focal Length[mm] ― ― ― ○1) ○1) ―

Focus11) Remote ― On/Off ― ○1) ○1) ―
Focus Position ― ― ― ○1) ○1) ―
Focus Value[%] ― ― ― ○1) ○1) ―
Focus Length[m] ― ― ― ○1) ○1) ―

1) コントローラーの操作部に割り当てれば制御可能です。
2) Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnに設定されている場合のみ設定可能です。
3) Color Tempは、R/B Gain操作時に2000Kや15000Kでクリップされるため、R/B Gain値の正確なColor Temp値を表示できない場合があります。
4) Color Temp Balanceは±99で表示クリップされるため、R/B Gain値の正確なColor Temp Balance値を表示できない場合があります。
5) 本機に読み込み済みのScene File 1～ 5の選択および選択解除のみ可能です。
6) コントローラーからの操作で、本機の設定をScene Fileが読み込まれていない標準状態に戻すことができます。
7) Projectメニュー > Basic Setting > Input Color Space（67ページ）がHLG(Natural)、HLG(Live)、Rec.2020/User GammaまたはRec.709/User Gammaに設定されている場合のみ設定可能です。
8) オートホワイトバランスの実行中は、テスト信号のオン／オフを切り換えることはできません。
9) コントローラーの機種やバージョンによっては表示できないものもあります。
10) 本機では、通常のKneeコントロールによって、HDR Kneeと同等の高輝度Kneeを制御します。
11) Eマウントレンズ装着時、リモートコントロールユニットからのズームおよびフォーカスの駆動指示は無効になります。
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外部モニターや記録装置を接続する
記録・再生画像を外部モニターに表示させると
きは、本機の出力信号を選択し、接続するモニ
ターに応じた接続ケーブルを使用してください。
VTRなどの記録装置を接続して、本機の出力信
号を記録することもできます。
外部モニターにビューファインダーと同様の各
種ステータス情報やメニューなどを表示させる
ことができます。モニターに出力する信号に応
じて、Monitoringメニュー（72ページ）で
表示する内容を設定してください。

［ご注意］
FPSをVariableに設定しているとき、4K出力のみにおいて
水平方向の画ズレが発生する場合があります。これは、速
いFPS設定時に顕著な現象です。ただし、記録画には影響
がないため、再生画像は正しく表示できます。

SDI OUT端子（BNC型）

Monitoringメニュー（72ページ）で、出力
フォーマットを設定します。
接続には市販の75Ω同軸ケーブルを使用して
ください。

［ご注意］
本機と外部機器の間のアースが確実に接地されていること
を確認してから、電源を入れてください。（75Ω同軸ケー
ブルを接続した後に、本機と外部機器の電源を入れること
をお勧めします。）
やむを得ず、電源投入状態で外部機器を接続する場合は、
75Ω同軸ケーブルを外部機器に接続した後に、本機と接
続してください。

本機と同時に外部機器で記録を開始
するには

SDI信号出力時は、メニューのTechnical > 
System Configuration > SDI Rec Remote 

Trigger（81ページ）をHD SDI Remote I/F
またはParallel Recに設定すると、SDI OUT端子
に接続した外部機器にRECトリガー信号を出力
することによって、本機と同期した記録が可能
になります。

［ご注意］
接続した外部機器がRECトリガー信号に対応していない場
合は動作しません。

MONITOR OUT端子（BNC
型）

HD SDI信号を出力します。
Monitoringメニュー（72ページ）で出力
フォーマットを設定します。
接続には市販の75Ω同軸ケーブルを使用して
ください。

［ご注意］
音声とタイムコードは本出力には重畳されていません。

HDMI OUT端子（Type A
コネクター）

Monitoringメニュー（72ページ）で、出力
フォーマットを設定します。
接続には、市販のHDMI接続ケーブルを使用し
ます。
出力フォーマットがMONITOR OUT端子と同一
の解像度の場合は、同じ映像信号が出力されま
す。

12V OUT端子（DC OUT 
12V、Hirose 4ピン）

電源スイッチがONの場合に、アクセサリー
にDC 12Vの電源を供給します。また、12V 
OUT端子を経由してREC Tally信号の出力、REC 
Trigger信号の入力をすることが可能です。

No. 信号 I/O 仕様
1 UNREG GND － GND for UNREG
2 REC TALLY OUT Open Collector 

output
(Max. 50 mA)
Low: REC

3 REC TRIGGER IN Open or +5 V dc: 
Normal
GND: Active(REC)

4 UNREG +12 V 
OUT

OUT +11 V to 17 V dc 
output
11 V～ 17 V入力時
出力電圧：入力電圧
と同じ
出力最大電流：1.0 A
22 V～ 32 V入力時
出力電圧：15 V
出力最大電流：0.8 A

24V OUT端子（DC OUT 
24V、Fischer 3ピン）

電源スイッチがONの場合に、アクセサリー
にDC 24Vの電源を供給します。また、24V 
OUT端子を経由してREC Tally信号の出力、REC 
Trigger信号の入力をすることが可能です。

No. 信号 仕様
1 GND
2 24V-AUX 11 V～ 17 V入力時

出力電圧：24 V
出力最大電流：1.0 A
22 V～ 32 V入力時
出力電圧：入力電圧と同
じ
出力最大電流：2.0 A

3 R/S



000 7章　外部機器の接続：外部モニターや記録装置を接続する114

AUX 端子（LEMO 5ピン）

タイムコード信号を出力します。

No. 信号
1 Factory Use
2 NC
3 －
4 TC OUT
5 GND
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本機を複数台使用して撮影するときなど、特定
の基準信号に同期させたり、タイムコードを合
わせることができます。

映像信号の位相を合わせる
（ゲンロック）

本機のGENLOCK IN端子（11ページ）に以下
の基準信号を入力することによって、ゲンロッ
クが可能です。

ˎˎ HDSDI 1.5G デジタル（interlace or PsF）
ˎˎ HD Yアナログ
ˎˎ SD VBSアナログ
ゲンロック入力信号は、フルメニューの
Technical > Genlock > Input Source （84
ページ）で設定できます。
入力できる基準信号は、設定されているプロジェ
クトフレームレートによって異なります。
プロジェクトフ
レームレート

入力可能な基準信号

23.98P 1920×1080 47.95i（23.98PsF）
24P 1920×1080 48i（24PsF）
25P 1920×1080 50i

720×576 50i
29.97P 1920×1080 59.94i

720×486 59.94i
47.952 1920x1080 47.95i(23.98PsF)
50i 1920×1080 50i

720×576 50i
50P 1920×1080 50i

720×576 50i
59.94i 1920×1080 59.94i

720×486 59.94i
59.94P 1920×1080 59.94i

720×486 59.94i

ゲンロックの状態は、メニューのTechnical > 
Genlock > Reference Lock Type（84ペー
ジ）で確認できます。

［ご注意］

ˎˎ 基準信号が不安定な場合は、ゲンロックできません。
ˎˎ サブキャリアは同期しません。

他機のタイムコードにロッ
クさせる

タイムコード供給源となる機器は、タイムコー
ド出力が更新されるモード（Free Run）に設定
してください。

1	メニューのTC/Media > Timecode > 
Mode（71ページ）をPreset F-Run  
(Ext-Lk)に設定する。

2	 GENLOCK IN端子（11ページ）とTC IN
端子（11ページ）に、それぞれHDまた
はSDのリファレンスビデオ信号およびそれ
に同期した基準タイムコードを供給する。

これで本機のタイムコードジェネレーターが基
準タイムコードにロックし、画面に「Ext-Lk」と
表示されます。
ロックしてから約10秒経過した後は、外部から
の基準タイムコードの接続を外しても、外部ロッ
ク状態は保たれます。

［ご注意］

ˎˎ 供給する基準タイムコードとリファレンスビデオ信号
が、SMPTEタイムコードの規格を満たした位相関係に
あることを確認してください。
ˎˎ 外部ロックの操作をすると、タイムコードは瞬時に外
部のタイムコードにロックし、外部タイムコードの値
と同じ値がタイムデータ表示部に出ますが、タイムコー
ドジェネレーターが安定するまでの数秒間は、記録を
開始しないでください。
ˎˎ リファレンスビデオ信号の周波数と本機のフレーム周
波数が同じでないと、正しくロックできず、本機が正
常に動作できません。この場合、タイムコードも外部
のタイムコードに正しくロックできません。
ˎˎ 接続を外した場合、基準タイムコードに対し1時間で1
フレームずれる場合があります。

外部ロックを解除するには

メニューのTC/Media > Timecode > Mode
（71ページ）の設定を変更してください。

外部同期
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使用上のご注意
安全にご使用いただくために、付属の「ご使用
になる前に」と併せてご覧ください。

取り扱い・保管上のご注意

強い衝撃を与えない

内部構造や外観の変形などの損傷を受けること
があります。

動作中は布などで包まないでくださ
い

内部の温度が上がり、好ましくありません。

使い終わったら

電源スイッチをOFFにしてください。

長時間使わないときは

バッテリーを抜いておいてください。

レンズを太陽光に向けて放置しない

太陽光がレンズを通して内部に焦点を結び、火
災の原因となることがあります。

輸送

ˎˎ メモリーカードは必ず取り出しておいてくだ
さい。

ˎˎ トラック、船、航空機など、本機を貨物とし
て扱う輸送では、お買い上げ時の梱包材をご
使用ください。

お手入れ

外装の汚れは、乾いた柔らかい布で拭き取りま
す。ひどい汚れは、中性洗剤液を少し含ませた
布で拭いた後、カラ拭きします。
アルコール、ベンジン、シンナーなどの薬品類は、
表面が変質したり、塗料がはげることがありま
すので、使わないでください。
エアダスター等の高風圧機器を使ったお手入れ
は光学部位の損傷につながりますのでお控えく
ださい。

万一、異常が生じたときは

お買い上げ店かソニーのサービス窓口にご相談
ください。

ファン、バッテリーは有寿
命部品として定期的な交換
が必要です

ファン、バッテリーは有寿命部品として定期的
な交換が必要です。
常温でのご使用の場合、5年を目安に交換して
ください。ただし、交換時期は目安であり、部
品の寿命を保証するものではありません。交換
の際はお買い上げ店にご相談ください。

電解コンデンサの寿命は約
5年です

電解コンデンサの寿命は約5年です。

（常温で1日に8時間、1カ月で25日間、通常に
使用すると想定した場合）
したがって、使用時間が上記より長い場合は、
その分寿命は短くなります。

バッテリー端子に関するご
注意

機器に搭載されているバッテリー端子（バッテ
リーパックやACアダプターとの接点部分）は消
耗品です。
振動や衝撃によって端子が変形したり、曲がっ
たり、あるいは長期の屋外での使用などによっ
て表面が腐食したりすると、本体に電源が供給
されなくなります。
長期間機器を使用していただくために、定期点
検を実施することをお願いします。点検につき
ましては、ソニーのサービス担当者または営業
担当者にご相談ください。

使用場所・保管場所

水平な場所、空調のある場所に保管してください。
次のような場所での使用・保管は避けてください。

ˎˎ 極端に寒い所、暑い所（使用温度は0℃～
40℃）。 
真夏、窓を閉め切った自動車内は50℃を越え
ることがあります。

ˎˎ 湿気・ほこりの多い所。

ˎˎ 雨があたる所。

ˎˎ 激しく振動する所。

ˎˎ 強い磁気を発生するものの近く。

ˎˎ 強力な電波を発生するテレビやラジオの送信
所の近く。

ˎˎ 直射日光が長時間当たる場所や暖房器具の近
く。

携帯電話などによる電波障害を防止
するために

携帯電話などを本機の近くで使用すると、誤動
作を引き起こしたり、映像、音声などに影響を
与えることがあります。
本機の近くでは、携帯電話などの電源はできる
だけ切ってください。

レーザービームについてのご注意

レーザービームはCMOSイメージセンサーに
損傷を与えることがあります。レーザービーム
を使用した撮影環境では、CMOSイメージセン
サー表面にレーザービームが照射されないよう
に充分注意してください。特に医療用などの強
力なレーザー光の場合は、反射光や散乱光でも
損傷を与えることがあります。

画面について

ˎˎ 画面を太陽に向けたままにすると、画面を傷
めます。屋外でご使用のときは、太陽に向け
て放置しないでください。

ˎˎ 画面を強く押したり、ひっかいたり、上に物
を置いたりしないでください。画面にムラが
出たり、パネルの故障の原因になります。

ˎˎ 使用中に画面が暖かくなることがありますが、
故障ではありません。
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LCD（液晶）画面について

本機のLCD（液晶）パネルは有効画素99.99％以
上の非常に精密度の高い技術で作られています
が、画面上に黒い点が現れたり（画素欠け）、常
時点灯している輝点（赤、青、緑など）や滅点が
ある場合があります。また、LCD（液晶）パネル
の特性上、長期間ご使用の間に画素欠けが生じ
ることもあります。
これらの現象は故障ではありませんので、ご了
承の上本機をお使いください。
なお、これらの点が記録されることはありませ
ん。

有機ELパネルについて

本機の有機ELパネルは有効画素99.99％以上の
非常に精密度の高い技術で作られていますが、
画面上に黒い点が現れたり（画素欠け）、常時点
灯している輝点や滅点がある場合があります。
また、有機ELパネルの特性上、長期間ご使用の
間に画素欠けが生じることもあります。これら
の現象は故障ではありませんので、ご了承の上
本機をお使いください。なお、これらの点が記
録されることはありません。
一般に、有機ELパネルは、その特性上、焼き付き、
輝度低下などが発生することがあります。
これらは故障ではありませんので、ご了承の上
本機をお使いください。

結露について

本機を寒いところから急に暖かいところに持ち
込んだときなど、機器表面や内部に水滴がつく
ことがあります。これを結露といいます。結露
が起きたときは電源を切り、結露がなくなるま
で放置し、結露がなくなってからご使用くださ
い。結露時のご使用は機器の故障の原因となる
場合があります。

CMOSイメージセンサー
特有の現象

撮影画面に出る下記の現象は、CMOSイメージ
センサー特有の現象で、故障ではありません。

白点

CMOSイメージセンサーは非常に精密な技術で
作られていますが、宇宙線などの影響により、
まれに画面上に微小な白点が発生する場合があ
ります。これは撮像素子の原理に起因するもの
で故障ではありません。
また、以下の場合、白点が見えやすくなります。

ˎˎ 高温の環境で使用するとき

折り返しひずみ

細かい模様、線などを撮影すると、ぎざぎざや
ちらつきが見えることがあります。

フォーカルプレーン

撮像素子（CMOSセンサー）の映像信号を読み出
す方法の性質により、撮像条件によっては、画
面をすばやく横切る被写体が少しゆがんで見え
ることがあります。

フラッシュバンド

フラッシュ光や、すばやく点滅する光源を撮影
したときに、画面の上下で輝度が変化すること
があります。

フリッカー

蛍光灯、ナトリウム灯、水銀灯などの放電管に
よる照明下で撮影すると、画面が明滅したり、
色が変化したり、横縞が流れるように見えるこ
とがあります。

画面表示に関するご注意

ˎˎ 次のような場合、ビューファインダーの映像
が乱れることがあります。

 – フォーマットを切り換えたとき
ˎˎ ビューファインダー内で視線を動かした場合
などに、赤、緑、青の原色が見えることがあ
りますが、故障ではありません。また、これ
らの原色が実際にメディアに記録されること
はありません。

ファイルの断片化について

画像が正しく記録・再生されないときは記録メ
ディアをフォーマット（初期化）してください。
長期間、映像の記録・クリップの消去を繰り返
していると、記録メディア内のファイル が断
片化（フラグメンテーション）して、映像が正
しく記録・保存できなくな る場合があります。
このような場合は、クリップのバックアップを
取ったあと、メニューの TC/Media > Format 
Media（71ページ）で記録メディアのフォー
マット（初期化）を行ってください。
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本機の出力電圧について

本機から出力できる周辺機器用電力の合計は、
本機への入力電圧やアクセサリーの接続状況に
よって変化します。条件によっては下記各電源
出力端子の最大許容電力まで供給できない場合
があります。

LENS端子：1 A max
12V OUT端子（4ピン）：

0.8 A max（入力電圧：22 V～ 32 V）
1 A max（入力電圧：11 V～ 17 V）

24V OUT端子（3ピン）：
2 A max（入力電圧：22 V～ 32 V）
1 A max（入力電圧：11 V～ 17 V）

本機器への入力電圧値に応じて、アクセサリー
（AXS-R7、DVFEL200およびCBK-3610XS）の
装着および周辺機器への供給電力が制限されま
す

本機器に供給される電圧：Ｘ[V]
周辺機器用供給電力合計：Ｙ[W]
本機器の消費電力：約60 W
 AXS-R7の消費電力：約24 W
 DVF-EL200の消費電力：約2.5 W
 CBK-3610XSの消費電力：約3.9 W

Y[W]=X[V]x9.0[A]1)-(60+++)2)[W]

上記アクセサリーの装着および周辺機器に電力
を供給する場合は、上記計算式でYが負の値に
ならないように運用してください。
（算出した結果Ｙが、各電源出力端子の最大許容
電力の和を超える場合は適用されません。）
1) AC-DN10A使用時は6.0[A]
2) AC-DN10A使用時はとの同時使用はしないでくだ

さい。使用条件によって供給電力オーバーとなる可能
性があります。

セキュリティに関するご注
意

ˎˎ 通信を行う機器でセキュリティ対策を行わな
かった結果、または、通信仕様上の、やむを
得ない事情により、データ漏洩等、セキュリ
ティ上の問題が発生した場合、弊社ではそれ
によって生じたあらゆる損害に対する責任を
負いかねます。

ˎˎ 使用環境によってはネットワーク上の意図せ
ぬ第三者から製品にアクセスされる可能性が
あります。本機をネットワークに接続する際
には、セキュアなネットワークであることを
ご確認の上ご使用ください。

ˎˎ セキュリティの面から、製品をネットワーク
に接続してご使用になる際は、ブラウザでコ
ントロール画面にアクセスし、アクセス制限
設定を工場出荷時の設定値から変更して設定
することを強く推奨します。（82ページ） 
また、定期的にパスワードを変更することを
推奨します。

ˎˎ 設定作業中または設定作業後のブラウザで他
のサイトを閲覧しないでください。ブラウザ
にログインした状態が残りますので、意図し
ない第三者の使用や悪意のあるプログラムの
実行を防ぐために、設定作業が完了したら必
ずブラウザを終了してください。
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SDI OUT端子の出力フォーマット

SDI OUT端子からのシリアルデジタル信号は、メニューのProjectカテゴリーとMonitoringカテゴリーの設定に応じて出力されます。
Projectカテゴリーの設定組み合わせに関しては「記録フォーマット設定表」（53ページ）を参照してください。

太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
59.94/50 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
4K 4:3/ 
4K 17:9/ 
4K 2.39:11)

XAVC-I 4K Class300/
Rec Off 4096x2160P 12G ― 4096x2160P 

YPbPr 12G
4096x2160P 
YPbPr 12G 無出力 無出力

4096x2160P Square 
Level B

4096x2160P Square 
Level B 4096x2160P YPbPr 3G Level B-DL

4096x2160P 2SI 
Level B

4096x2160P 2SI 
Level B 4096x2160P YPbPr 3G Level B-DL

2048x1080P Level B
1920x1080P Level B 2048x1080P 

YPbPr 3G Level B-DL
2048x1080P 

YPbPr 3G Level B-DL

1920x1080P 
YPbPr 3G Level B

1920x1080P 
YPbPr 3G Level B

1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G

1920x1080P Level B
1920x1080P Level B 1920x1080P 

YPbPr 3G Level B-DL
1920x1080P 

YPbPr 3G Level B-DL

1920x1080P 
YPbPr 3G Level B

1920x1080P 
YPbPr 3G Level B

1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G
1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G

3.8K 16:9 XAVC-I QFHD 
Class300/ 
Rec Off

3840x2160P 12G ― 3840x2160P 
YPbPr 12G

3840x2160P 
YPbPr 12G 無出力 無出力

3840x2160P Square 
Level B

3840x2160P Square 
Level B 3840x2160P YPbPr 3G Level B-DL

3840x2160P 2SI 
Level B

3840x2160P 2SI 
Level B 3840x2160P YPbPr 3G Level B-DL

1920x1080P Level B
1920x1080P Level B 1920x1080P 

YPbPr 3G Level B-DL
1920x1080P 

YPbPr 3G Level B-DL

1920x1080P 
YPbPr 3G Level B

1920x1080P 
YPbPr 3G Level B

1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G
1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G

6K 3:2/ 
6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
4K 4:3/ 
4K 17:9/ 
3.8K 16:9

ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920x1080P Level B
1920x1080P Level B 1920x1080P 

YPbPr 3G Level B-DL
1920x1080P 

YPbPr 3G Level B-DL

1920x1080P 
YPbPr 3G Level B

1920x1080P 
YPbPr 3G Level B

1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G
MPEG 1920x1080i/
ProRes 422 HQ HD i/ 
ProRes 422 HD i/ 
ProRes 422 Proxy HD i 

1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G

記録フォーマットと出力信号
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Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode AXS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
47.95 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
4K 4:3/4K 17:9/ 
4K 2.39:1

RAW SQ/ 
X-OCN XT/ 
X-OCN ST/ 
X-OCN LT/ 
Rec Off

4096x2160P Square 
Level B

4096x2160P Square 
Level B 4096x2160P YPbPr 3G Level B

4096x2160P 2SI 
Level B

4096x2160P 2SI 
Level B 4096x2160P YPbPr 3G Level B

2048X1080P Level B 1920x1080P 2048X1080P YPbPr 3G Level B 1920x1080P YPbPr 1.5G
1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P YPbPr 1.5G

Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
29.97/25 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:92)/ 
4K 6:5/4K 4:3/ 
4K 17:9/ 
4K 2.39:11)

XAVC-I 4K Class480/
XAVC-I 4K Class300/
Rec Off

4096x2160P 6G ― 4096x2160P YPbPr 6G 4096x2160P YPbPr 6G 無出力 無出力
4096x2160P 2SI ― 4096x2160P YPbPr 3G Level B-DS 無出力 無出力
4096x2160P Square 4096x2160P Square 4096x2160P YPbPr 1.5G

2048x1080PsF
1920x1080P

2048x1080PsF 
YPbPr 1.5G

2048x1080PsF 
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080PsF 1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

5.7K 16:93)/
3.8K 16:9

XAVC-I QFHD 
Class480/XAVC-I 
QFHD Class300/
Rec Off

3840x2160P 6G ― 3840x2160P YPbPr 6G 3840x2160P YPbPr 6G 無出力 無出力

3840x2160P 2SI ― 3840x2160P YPbPr 3G Level B-DS 無出力 無出力

3840x2160P Square 3840x2160P Square 3840x2160P YPbPr 1.5G

1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080PsF 1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

6K 3:2/ 
6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9/ 
4K 6:5/4K 4:3/ 
4K 17:9/ 
3.8K 16:9

MPEG 1920x1080P/ 
ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080PsF 1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

ProRes 4444 HD P4)

1920x1080P RGB 
Level B

1920x1080P
1920x1080P RGB 3G 

Level B
1920x1080P RGB 3G 

Level B

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G
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Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
24 6K 3:2/

6K 1.85:1/
6K 17:9/
6K 2.39:1/
4K 6:5/4K 4:3/
4K 17:9/
4K 2.39:11)

XAVC-I 4K Class480/
XAVC-I 4K Class300/
Rec Off

4096x2160P 6G ― 4096x2160P YPbPr 6G 4096x2160P YPbPr 6G 無出力 無出力
4096x2160P 2SI ― 4096x2160P YPbPr 3G Level B-DS 無出力 無出力
4096x2160P Square 4096x2160P Square 4096x2160P YPbPr 1.5G

2048x1080P 1920x1080P 2048x1080PsF 
YPbPr 1.5G

2048x1080PsF 
YPbPr 1.5G

1920x1080P 
YPbPr 1.5G

1920x1080P 
YPbPr 1.5G

1920x1080P
1920x1080P

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G 1920x1080P 

YPbPr 1.5G
1920x1080P 
YPbPr 1.5G

1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

6K 3:2/ 
6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9/ 
4K 6:5/4K 4:3/ 
4K 17:9/ 
3.8K 16:9

ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920x1080P

1920x1080P

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G 1920x1080P 

YPbPr 1.5G
1920x1080P 
YPbPr 1.5G

1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

ProRes 4444 HD P4) 1920x1080P RGB 
Level B 1920x1080P 1920x1080P RGB 3G 

Level B
1920x1080P RGB 3G 

Level B
1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

3.8K 16:9 Rec Off 3840x2160P 6G ― 3840x2160P YPbPr 6G 3840x2160P YPbPr 6G 無出力 無出力
3840x2160P Square 3840x2160P Square 3840x2160P YPbPr 1.5G

3840x2160P 2SI ― 3840x2160P  
YPbPr 3G Level-B

3840x2160P  
YPbPr 3G Level-B

無出力 無出力

1920x1080P

1920x1080P

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G 1920x1080P  

YPbPr 1.5G
1920x1080P  
YPbPr 1.5G

1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G
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Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
23.98 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:92)/ 
4K 6:5/4K 4:3/ 
4K 17:9/ 
4K 2.39:11)

XAVC-I 4K Class480/
XAVC-I 4K Class300/
Rec Off

4096x2160P 6G ― 4096x2160P YPbPr 6G 4096x2160P YPbPr 6G 無出力 無出力
4096x2160P 2SI ― 4096x2160P YPbPr 3G Level B-DS 無出力 無出力
4096x2160P Square 4096x2160P Square 4096x2160P YPbPr 1.5G

2048x1080P 1920x1080P 2048x1080PsF 
YPbPr 1.5G

2048x1080PsF 
YPbPr 1.5G

1920x1080P 
YPbPr 1.5G

1920x1080P 
YPbPr 1.5G

1920x1080P
1920x1080P

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G 1920x1080P 

YPbPr 1.5G
1920x1080P 
YPbPr 1.5G

1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

5.7K 16:93)/ 
3.8K 16:9

XAVC-I QFHD 
Class480/XAVC-I 
QFHD Class300/ 
Rec Off

3840x2160P 6G ― 3840x2160P YPbPr 6G 3840x2160P YPbPr 6G 無出力 無出力
3840x2160P 2SI ― 3840x2160P YPbPr 3G Level B-DS 無出力 無出力
3840x2160P Square 3840x2160P Square 3840x2160P YPbPr 1.5G

1920x1080P
1920x1080P

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G 1920x1080P 

YPbPr 1.5G
1920x1080P 
YPbPr 1.5G

1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

6K 3:2/ 
6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9/ 
4K 6:5/4K 4:3/ 
4K 17:9/ 
3.8K 16:9

MPEG 1920x1080P/ 
ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920x1080P

1920x1080P

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G 1920x1080P 

YPbPr 1.5G
1920x1080P 
YPbPr 1.5G

1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

ProRes 4444 HD P4) 1920x1080P RGB 
Level B 1920x1080P 1920x1080P RGB 3G 

Level B
1920x1080P RGB 3G 

Level B
1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1) 4K 2.39:1をImager Modeに選択した場合は、SxS Rec FormatはRec Offとなります。
2) SDI 1/2およびSDI 3/4に4096x2160Pを設定できません。
3) SDI 1/2およびSDI 3/4に3840x2160Pを設定できます。
4) 以下の有効画サイズでのみ設定可能です。
 5.7K 16:9
 4K 6:5
 4K 4:3
 3.8K 16:9

［ご注意］
SxS Rec Formatが以下に設定されていて、AXS Rec FormatがRec Off以外に設定されている場合は、4096x2160Pまたは3840x2160P SDIの設定および出力が可能です。
MPEG HD422 P
MPEG HD422 i
FHD ProRes 422 HQ P
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FHD ProRes 422 HQ i
FHD ProRes 422 P
FHD ProRes 422 i
FHD ProRes 422 Proxy P
FHD ProRes 422 Proxy i

MONITOR OUT端子/HDMI OUT端子の出力フォーマット

MONITOR OUT端子、HDMI OUT端子からのデジタル信号は、メニューのProjectカテゴリーとMonitoringカテゴリーの設定に応じて出力されます。
Projectカテゴリーの設定組み合わせに関しては「記録フォーマット設定表」（53ページ）を参照してください。

太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
59.94/50 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
4K 4:3/ 
4K 17:9/ 
4K 2.39:1

XAVC-I 4K Class300/
Rec Off

4096x2160P 12G ―

1920x1080P 
Level A 

4096x2160P
1920x1080P YPbPr 3G Level A

4096x2160P
1920x1080P 1920x1080P

1920x1080i
4096x2160P

1920x1080i YPbPr 1.5G
4096x2160P

1920x1080i 1920x1080i 

4096x2160P 2SI Level B 4096x2160P 2SI

1920x1080P 
Level A

4096x2160P
1920x1080P YPbPr 3G Level A

4096x2160P
1920x1080P 1920x1080P

1920x1080i
4096x2160P

1920x1080i YPbPr 1.5G
4096x2160P

1920x1080i 1920x1080i

4096x2160P Square 
Level B 4096x2160P Square

1920x1080P 
Level A 1920x1080P 1920x1080P YPbPr 3G Level A 1920x1080P

1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i 

2048x1080P Level B
1920x1080P Level B 1920x1080P 

Level A 1920x1080P 1920x1080P YPbPr 3G Level A 1920x1080P

1920x1080i 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i

1920x1080P Level B
1920x1080P Level B 1920x1080P 

Level A 1920x1080P 1920x1080P YPbPr 3G Level A 1920x1080P

1920x1080i 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i
1920x1080i 1920x1080i 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i
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Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI

3.8K 16:9 XAVC-I QFHD 
Class300/ 
Rec Off 3840x2160P 12G ―

1920x1080P 
Level A

3840x2160P
1920x1080P YPbPr 3G Level A

3840x2160P
1920x1080P 1920x1080P

1920x1080i
3840x2160P

1920x1080i YPbPr 1.5G
3840x2160P

1920x1080i 1920x1080i 

3840x2160P 2SI Level B 3840x2160P 2SI Level B

1920x1080P 
Level A

3840x2160P
1920x1080P YPbPr 3G Level A

3840x2160P
1920x1080P 1920x1080P

1920x1080i
3840x2160P

1920x1080i YPbPr 1.5G
3840x2160P

1920x1080i 1920x1080i

3840x2160P Square 
Level B

3840x2160P Square 
Level B

1920x1080P 
Level A 1920x1080P 1920x1080P YPbPr 3G Level A 1920x1080P

1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i 

1920x1080P Level B
1920x1080P Level B 1920x1080P 

Level A 1920x1080P 1920x1080P YPbPr 3G Level A 1920x1080P

1920x1080i 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i
1920x1080i 1920x1080i 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i

6K 3:2/ 
6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
4K 4:3/ 
4K 17:9/ 
3.8K 16:9

ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920x1080P Level B
1920x1080P Level B 1920x1080P 

Level A 1920x1080P 1920x1080P YPbPr 3G Level A 1920x1080P

1920x1080i 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i

ProRes 422 HQ HD i/
ProRes 422 HD i/
ProRes 422 Proxy HD i 

1920x1080i 1920x1080i 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i

MPEG 1920x1080i 
1920x1080i 1920x1080i

1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i

―
720x480P1) 2) 無出力 720x480P
720x576P1) 3) 無出力 720x576P

Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode AXS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
47.95 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
4K 4:3/4K 17:9/ 
4K 2.39:1

RAW SQ/
X-OCN XT/
X-OCN ST/
X-OCN LT/
Rec Off

4096x2160P Square 
Level B

4096x2160P Square 
Level B

1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P

4096x2160P 2SI Level B 4096x2160P 2SI Level B
2048x1080P Level B 1920x1080P
1920x1080P 1920x1080P
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Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
29.97/25 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:94)/ 
4K 6:5/4K 4:3/ 
4K 17:9/ 
4K 2.39:1

XAVC-I 4K Class480/
XAVC-I 4K Class300/
Rec Off 4096x2160P 6G ―

1920x1080P
4096x2160P

1920x1080P YPbPr 1.5G
4096x2160P

1920x1080P 1920x1080P

1920x1080PsF
4096x2160P 

1920x1080PsF YPbPr 1.5G
4096x2160P

1920x1080PsF 1920x1080PsF

4096x2160P 2SI ―
1920x1080P

4096x2160P
1920x1080P YPbPr 1.5G

4096x2160P
1920x1080P 1920x1080P

1920x1080PsF
4096x2160P

1920x1080PsF YPbPr 1.5G
4096x2160P

1920x1080PsF 1920x1080PsF

4096x2160P Square 4096x2160P Square
1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080PsF 1920x1080PsF 1920x1080PsF YPbPr 1.5G 1920x1080PsF

2048x1080PsF
1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF YPbPr 1.5G 1920x1080PsF

1920x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF YPbPr 1.5G 1920x1080PsF

5.7K 16:95)/ 
3.8K 16:9

XAVC-I QFHD 
Class480/XAVC-I 
QFHD Class300/
Rec Off

3840x2160P 6G ―
1920x1080P

3840x2160P
1920x1080P YPbPr 1.5G

3840x2160P
1920x1080P 1920x1080P

1920x1080PsF
3840x2160P

1920x1080PsF YPbPr 1.5G
3840x2160P

1920x1080PsF 1920x1080PsF

3840x2160P 2SI ―
1920x1080P

3840x2160P
1920x1080P YPbPr 1.5G

3840x2160P
1920x1080P 1920x1080P

1920x1080PsF
3840x2160P

1920x1080PsF YPbPr 1.5G
3840x2160P

1920x1080PsF 1920x1080PsF

3840x2160P Square 3840x2160P Square
1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080PsF 1920x1080PsF 1920x1080PsF YPbPr 1.5G 1920x1080PsF

1920x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF YPbPr 1.5G 1920x1080PsF

6K 3:2/ 
6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9/ 
4K 6:5/4K 4:3/ 
4K 17:9/ 
3.8K 16:9

MPEG 1920x1080P/ 
ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P

1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF YPbPr 1.5G 1920x1080PsF

ProRes 4444 HD P6)
1920x1080P RGB  
Level B

1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P

1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF YPbPr 1.5G 1920x1080PsF
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Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
24 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
4K 6:5/4K 4:3/ 
4K 17:9/ 
4K 2.39:1

XAVC-I 4K Class480/
XAVC-I 4K Class300/
Rec Off

4096x2160P 6G ― 1920x1080P
4096x2160P

1920x1080P YPbPr 1.5G
4096x2160P

1920x1080 1920x1080P

4096x2160P 2SI ― 1920x1080P
4096x2160P

1920x1080P YPbPr 1.5G
4096x2160P

1920x1080P 1920x1080P
4096x2160P Square 4096x2160P Square 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
2048x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080P

1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080PsF

6K 3:2/ 
6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9/ 
4K 6:5/4K 4:3/ 
4K 17:9/ 
3.8K 16:9

ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920x1080P

1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P

1920x1080PsF

ProRes 4444 HD P6) 1920x1080P RGB  
Level B 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P

3.8K 16:9 Rec Off
3840x2160P 6G ― 1920x1080P

3840x2160P
1920x1080PsF YPbPr 1.5G

3840x2160P
1920x1080P 1920x1080PsF

3840x2160P Square 3840x2160P Square 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P

3840x2160P 2SI ― 1920x1080P
3840x2160P

1920x1080P YPbPr 1.5G
3840x2160P

1920x1080P 1920x1080P
1920x1080P

1920x1080P 1920x1080PsF 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080PsF
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Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
23.98 6K 3:2/ 

6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:94)/ 
4K 6:5/4K 4:3/ 
4K 17:9/ 
4K 2.39:1

XAVC-I 4K Class480/
XAVC-I 4K Class300/
Rec Off

4096x2160P 6G ― 1920x1080P
4096x2160P

1920x1080P YPbPr 1.5G
4096x2160P

1920x1080P 1920x1080P

4096x2160P 2SI ― 1920x1080P
4096x2160P

1920x1080P YPbPr 1.5G
4096x2160P

1920x1080P 1920x1080P
4096x2160P Square 4096x2160P Square 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
2048x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080P

1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080PsF

5.7K 16:95)/ 
3.8K 16:9

XAVC-I QFHD 
Class480/XAVC-I 
QFHD Class300/
Rec Off

3840x2160P 6G ― 1920x1080P
3840x2160P

1920x1080 YPbPr 1.5G
3840x2160P

1920x1080P 1920x1080P

3840x2160P 2SI ― 1920x1080P
3840x2160P

1920x1080P YPbPr 1.5G
3840x2160P

1920x1080P 1920x1080P
3840x2160P Square 3840x2160P Square 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080P

1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080PsF

6K 3:2/ 
6K 1.85:1/ 
6K 17:9/ 
6K 2.39:1/ 
5.7K 16:9/ 
4K 6:5/4K 4:3/ 
4K 17:9/ 
3.8K 16:9

MPEG 1920x1080P/ 
ProRes 422 HQ HD P/ 
ProRes 422 HD P/ 
ProRes 422 Proxy HD P

1920x1080P

1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P

1920x1080PsF

ProRes 4444 HD P6)
1920x1080P RGB  
Level B 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P

1) AXS Rec FormatがRec Offに設定されているときに、フルメニューのTechnical > System Configuration > SD HDMIをOnにすると設定されます。
2) Project Frame Rateが59.94のとき。
3) Project Frame Rateが50.0のとき。
4) SDI 1/2およびSDI 3/4に4096x2160Pを設定できません。
5) SDI 1/2およびSDI 3/4に3840x2160Pを設定できます。
6) 以下の有効画サイズでのみ設定可能です。
 5.7K 16:9
 4K 6:5
 4K 4:3
 3.8K 16:9
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［ご注意］
SxS Rec Formatが以下に設定されていて、AXS Rec FormatがRec Off以外に設定されている場合は、4096x2160Pまたは3840x2160P SDIの設定および出力が可能です。
MPEG HD422 P
MPEG HD422 i
FHD ProRes 422 HQ P
FHD ProRes 422 HQ i
FHD ProRes 422 P
FHD ProRes 422 i
FHD ProRes 422 Proxy P
FHD ProRes 422 Proxy i
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エラー /警告表示
本機では警告、注意、動作確認などが必要な状況では、サブディスプレイ画面にメッセージ表示、
RECランプの点滅、および警告音で対応します。
警告音は、内蔵スピーカーまたはヘッドホン端子に接続したヘッドホンに出力します。
本機の電源起動時に、一定期間イメージセンサーの自動調整（APR）を実行していない場合は、APR
の実行を促すメッセージがサブディスプレイ画面に表示されます。この場合は、表示される指示に
従って、APR（84ページ）を実行してください。

エラー表示

次のような表示が出た場合は、本機は動作を停止します。
警告表示内容 警告音 RECランプ 原因と対策
E+エラーコード 断続音 高速点滅 本体の異常の可能性があります。ビューファイン

ダー・モニター画面上にRECと表示されていても記
録は止まっています。
電源を切り、接続している機器やケーブル類、メディ
アに異常がないか確認してください。これらに異常
がないときは、再度電源を入れ、エラーが継続する
場合はソニーのサービス窓口にご連絡ください。（電
源スイッチをOFFにしても電源が切れない場合は、
バッテリーパックやDC IN電源も外してください。）

警告表示

次のような表示が出た場合は、次表に従って対処してください。
警告表示内容 警告音 RECランプ 原因と対策
Media Full1) 連続音 高速点滅 SxSメモリーカードの残量がないため、記録、コピー、

クリップ分割はできません。
交換してください。

Battery End1) 連続音 高速点滅 バッテリーパックが消耗しました。記録はできませ
ん。
いったん操作を中止し、バッテリーパックを交換し
てください。

Temperature High1) 断続音 点滅 内部温度が上昇しました。
いったん電源を切り、温度が下がるまで使用を中止
してください。

警告表示内容 警告音 RECランプ 原因と対策
Insufficient Voltage1) 連続音 高速点滅 DC IN電圧が低すぎます。記録はできません。

他の電源に接続し直してください。
EXT. I/F Signal Error 断続音 高速点滅 拡張ユニット取り付け端子内の信号にエラーを検出

しました。
AXS-R7等との接続状態を確認してください。

AXS Firmware 
Mismatch

連続音 高速点滅 AXS-R7が正しく動作出来ません。
AXS-R7のバージョンアップをしてください。

AXS Recorder Temp. 
High1)

断続音 高速点滅 AXS-R7の内部温度が上昇しました。
いったん電源を切り、温度が下がるまで使用を中止
してください。

Lens Signal Error － － 拡張ユニット取り付け端子内の信号にエラーを検出
しました。
レンズ等との接続状態を確認してください。

1) モニター画面にはメッセージは表示されません。

温度に関する警告表示について

動作モードや周囲環境によっては、本機の動作保証温度範囲内であってもTemperature Highまた
はAXS Recorder Temp Highが表示されることがあります。これらの警告が表示されても直ちに記
録が止まることはありませんが、早めに上記の原因と対策の指示に従って対応してください。

注意・動作確認表示

モニター画面もしくはサブディスプレイ上に次のような注意・動作確認表示が現れたり、警告アイ
コンが表示され、メニューのInfoカテゴリー > Camera Conditionに次のような注意・動作確認表
示が現れることがあります。この場合は次表に従って対処してください。
表示内容 原因と対策
Battery Error
Please Change Battery

バッテリーパックに異常が検出されました。
正常なバッテリーパックに交換してください。

Backup Battery End
Please Change

バックアップ電池の残量が不足しています。
バックアップ電池を交換してください。

Cannot Use SxS(A)*
Please Change

パーティションが切られているメモリーカードや、
本機で扱えるクリップ数を超えて記録されたメモ
リーカードが挿入されました。
本機では使用できませんので、交換してください。
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表示内容 原因と対策
Cannot Use SxS(A)*
Unsupported File System

ファイルシステムの異なるカードまたはフォーマッ
トされていないカードが挿入されました。
本機では使用できませんので、交換または本機で
フォーマットしてください。

Media Error
SxS(A)* Needs to be Restored

メモリーカードに異常が発生し、修復が必要な状態
になりました。
メモリーカードの修復を行ってください。

SxS(A)* Error
Recording Stopped
Playback Stopped

メモリーカードに異常が発生したため、記録または
再生が停止しました。
頻繁に起きる場合には、メモリーカードを交換して
ください。

Input AES/EBU is Invalid Emphasis AES/EBU入力に対応していないEmphasis信号が入
力されました。
本機は50u-15u Emphasisにのみ対応しています。

Input AES/EBU is not Pro Use AES/EBU入力に、Professional Use以外の信号が
入力されました。
本機はProfessional Useにのみ対応しています。

Fan Stopped 本体内のファンが停止しています。
高温下での使用を避け、電源を切ってソニーのサー
ビス担当者に連絡してください。

AXS Recorder Fan Stopped 本機に接続されたAXS-R7内のファンが停止してい
ます。
高温下での使用を避け、AXS-R7を本機から取り外
してソニーのサービス担当者に連絡してください。

Unsupported FPS
Change AXS(A) to AXS S48 Memory

使用できないAXS Memoryが検出されました。
記録できませんので、AXSメモリーカードに記録す
るフォーマットを変更するか、AXS-A512S48また
はAXS-A1TS48に交換してください。

Abnormal Lens Communication
Please Check “Lens IF” Setting  

接続されたレンズの種類が本機の設定と合っていま
せん。
メニューのTechnical > Lens Configuration > PL-
Mt Interface Positionの設定を確認してください。

Please Execute APR 一定期間イメージセンサーの自動調整（APR）を実
行していません。
MENUダイヤルを押して、APRを実行してくださ
い。

XXXX License Yday Remaining 
（XXXX：ライセンスの種類、Y：残り日数）

期間限定ライセンス付ソフトウェアオプションの有
効期限が残り2日を切りました。

表示内容 原因と対策
Lens I/F Error Eマウントレンズ装着時にレンズI/F通信でレンズの

不具合が検出されました。
Eマウントレンズとの接続状態を確認してくださ
い。

AXS Rec Format was changed. AXS記録フォーマットが変更されました。AXS Rec 
FormatとSxS Rec Formatの組み合わせ（53ペー
ジ）を確認してください。

SxS Rec Format was changed. SxS記録フォーマットが変更されました。AXS Rec 
FormatとSxS Rec Formatの組み合わせ（53ペー
ジ）を確認してください。

FPS was set to Fixed. 可変速撮影から等速撮影に切り換わりました。1ス
ロット同時記録設定時に可変速撮影はできません。

Sub Rec was set to Off. SxSサブ記録フォーマットがオフになりました。可
変速撮影あるいはピクチャーキャッシュモードで
は、1スロット同時記録はできません。

Set the "Password" of "Authentication". Technicalメニュー > Authentication > Password
（82ページ）が未設定なので設定してください。

* SxSメモリーカードスロットBに入れたSxSカードの場合はSxS(B)、AXS-R7上のAXSメモリーカードスロットAに入れ
たAXSカードの場合はAXS(A)、AXSメモリーカードスロットBに入れたAXSカードの場合はAXS(B)が表示されます。



000 8章　付録131

ファイルに保存される項目
表凡例
○：保存する
×：保存しない
―：保存しない（一時的動作メニュー）

Shootingメニュー

項目 細目 保存先ファイル
All Scene

FPS Fixed/Variable Select ○ ×
FPS Select ○ ×

Shutter1） Shutter Select ○ ○
Step/Cont. Select ○ ○
Add/Change Step － －
Delete Step － －

ND ND Position ○ ○
Exposure Index EI Select ○ ○
Gain Gain Select ○ ○
White Balance1） Color Temp. Select ○ ○

Add/Change Step － －
Delete Step － －
Auto White Balance － －

LUT Select SDI 1/2 － －
SDI 3/4 ○ ×
Monitor ○ ×
HDMI － －
VF LUT ○ ×
SxS Rec ○ ×
Sub Rec ○ ×
SDR Gain ○ ×

項目 細目 保存先ファイル
All Scene

Look Category ○ ×
Preset Look Select ○ ×
ACES Select ○ ×
User 3D LUT Select ○ ×
ASC CDL Process ○ ×
ASC CDL Select ○ ×
ASC CDL Information － －

Look File Load User 3D LUT － －
Reset User 3D LUT － －
Reset All User 3D LUTs － －
Load ASC CDL － －
Reset ASC CDL － －
Reset All ASC CDLs － －

1） ユーザーが追加・編集した選択肢も保存されます。
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Projectメニュー

項目 細目 保存先ファイル
All Scene

Basic Setting Imager Mode ○ ×
Project Frame Rate ○ ×
Input Color Space ○ ○
AXS Rec Format ○ ×
SxS Rec Format ○ ×
Sub Rec Format ○ ×
Base ISO ○ ○
SxS/Output De-Squeeze ○ ×

Special Recording Cache Rec Select ○ ×
Max Cache Rec Duration ○ ×

Assignable Button <1> ○ ×
<2> ○ ×
<3> ○ ×
<4> ○ ×
<VF A> ○ ×
<VF B> ○ ×
<VF C> ○ ×
<User 1> ○ ×
<User 2> ○ ×
<User 3> ○ ×
<User 4> ○ ×
<User 5> ○ ×

All File Load SD Card － －
Save SD Card － －
File ID ○ ×
Format SD Card － －

Scene File Recall Internal Memory － －
Store Internal Memory － －
Load SD Card － －
Save SD Card － －
File ID × ○

項目 細目 保存先ファイル
All Scene

User Gamma Current Settings － －
Load SD Card － －
Reset － －
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TC/Mediaメニュー

項目 細目 保存先ファイル

All Scene
Timecode Mode ○ ×

Manual Setting － －
Reset － －
TC Format ○ ×
TC Source － －
Time Data Display ○ ×

Clip Name Format Camera ID ○ ×
Reel Number ○ ×
Camera Position ○ ×
SxS Root Folder Name ○ ×

Format Media AXS Slot A － －
AXS Slot B － －
SxS Slot A － －
SxS Slot B － －
SD Card － －

Update Media AXS Slot A － －
AXS Slot B － －
SxS Slot A － －
SxS Slot B － －

Monitoringメニュー

項目 細目 保存先ファイル
All Scene

Output Format SDI 1/2 ○ ×
SDI 3/4 ○ ×
Monitor ○ ×
HDMI ○ ×

OSD Appearance VF ○ ×
SDI
SDI 1/2
SDI 3/4

○ ×

Monitor ○ ×
HDMI － －
Status Info A/B Setup ○ ×
Frame Line A/B Setup ○ ×

Monitor Display Focus Distance Format ○ ×
Monitor Magnifier Ratio ○ ×

Frame Line Center Marker ○ ×
Aspect Ratio ○ ×
Aspect Safety Zone ○ ×
Safety Zone ○ ×
Color ○ ×
Surround View Type ○ ×
Aspect Ratio Type ○ ×
Mask Level ○ ×
Frame Line on Playback ○ ×

User Frame Line Select ○ ×
Preset Aspect Ratio ○ ×
Scaling ○ ×
Preset Aspect Ratio Type ○ ×
Aspect Ratio(Pixels) － －
Width ○ ×
Height ○ ×
H Position ○ ×
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項目 細目 保存先ファイル
All Scene

User Frame Line V Position ○ ×
Variable Aspect Type － －

False Color Level ○ ×
Red ○ ×
Red Upper Limit ○ ×
Red Lower Limit ○ ×
Yellow ○ ×
Yellow Upper Limit ○ ×
Yellow Lower Limit ○ ×
Orange ○ ×
Orange Upper Limit ○ ×
Orange Lower Limit ○ ×
Pink ○ ×
Pink Upper Limit ○ ×
Pink Lower Limit ○ ×
Light Pink ○ ×
Light Pink Upper Limit ○ ×
Light Pink Lower Limit ○ ×
Cyan ○ ×
Cyan Upper Limit ○ ×
Cyan Lower Limit ○ ×
Green ○ ×
Green Upper Limit ○ ×
Green Lower Limit ○ ×
Light Blue ○ ×
Light Blue Upper Limit ○ ×
Light Blue Lower Limit ○ ×
Blue ○ ×
Blue Upper Limit ○ ×
Blue Lower Limit ○ ×
Purple ○ ×
Purple Upper Limit ○ ×

項目 細目 保存先ファイル
All Scene

False Color Purple Lower Limit ○ ×
Reset － －

VF Display VF LUT ○ ×
Status Info ○ ×
Frame Line ○ ×
VF Magnifier Ratio ○ ×
Color ○ ×
SDR Gain ○ ×

VF Function Double Speed Scan ○ ×
Peaking Frequency ○ ×
Zebra ○ ×
Zebra Select ○ ×
Zebra1 Level ○ ×
Zebra1 Aperture Level ○ ×
Zebra2 Level ○ ×
Assign<VF A> ○ ×
Assign<VF B> ○ ×
Assign<VF C> ○ ×
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Audioメニュー

項目 細目 保存先ファイル
All Scene

Audio Input CH-1 Audio Select ○ ×
CH-2 Audio Select ○ ×
CH-1 Audio Level ○ ×
CH-2 Audio Level ○ ×
MIC Reference ○ ×

Audio Monitor Monitor CH ○ ×
Monitor Level ○ ×

Audio Configuration Alarm Level ○ ×
Input Limiter Mode ○ ×
AGC Level ○ ×
AGC Mono/Stereo ○ ×
MIC Input Mono/Stereo ○ ×
Phantom Power +48V ○ ×
Monitor Output CH Pair ○ ×
Headphone Mono/ST ○ ×

Paintメニュー

項目 細目 保存先ファイル
All Scene

Black Master Black ○ ○
R Black ○ ○
B Black ○ ○

Flare Setting ○ ○
Master Flare ○ ○
R Flare ○ ○
G Flare ○ ○
B Flare ○ ○

Gamma Setting ○ ○
Gamma Category － －
Gamma Select ○ ○

Black Gamma Setting ○ ○
Range ○ ○
Master Black Gamma ○ ○

Knee Setting ○ ○
Point ○ ○
Slope ○ ○

White Clip Setting ○ ○
Level ○ ○
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項目 細目 保存先ファイル
All Scene

Detail Setting ○ ○
Level ○ ○
H/V Ratio ○ ○
Crispening ○ ○
Level Depend ○ ○
Level Depend Level ○ ○
Frequency ○ ○
Knee Aperture ○ ○
Knee Aperture Level ○ ○
Limit ○ ○
White Limit ○ ○
Black Limit ○ ○

Matrix Setting ○ ○
User Matrix ○ ○
User Matrix R-G ○ ○
User Matrix R-B ○ ○
User Matrix G-R ○ ○
User Matrix G-B ○ ○
User Matrix B-R ○ ○
User Matrix B-G ○ ○

Multi Matrix Setting ○ ○
Area Indication × ×
Reset － －
Axis × ×
Hue ○ ○
Saturation ○ ○

Technicalメニュー

項目 細目 保存先ファイル
All Scene

Test Signals Color Bars ○ ×
Color Bars Type ○ ×
1kHz Tone on Color Bars ○ ×
Test Saw ○ ×
Test Type ○ ×

Switch & Rec Light Lock Operator Side ○ ×
Lock Assistant Side ○ ×
Rec Light ○ ×
Rec Start/Stop Beep ○ ×

System Configuration Fan Control ○ ×
RM/RCP Paint Control ○ ×
SDI Rec Remote Trigger ○ ×
SD HDMI ○ ×
Shutter Mode ○ ○
Media Near Full Alarm ○ ×

Special Configuration Flip Image ○ ×
Audio/Video Delay ○ ×
NR(4K 17:9/16:9 AXS) ○ ○
Level Gauge Adjust － －
Level Gauge Reset － －

Lens Configuration PL-Mt Interface Position ○ ×
Lens 12pin ○ ×
E-Mount Shading Comp. ○ ×
E-Mt Chro. Aber. Comp. ○ ×

Authentication User Name × ×
Password × ×

Network Setting ○ ×
LAN ○ ×
Wireless ○1) ×

APR APR － －
Reset － －
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項目 細目 保存先ファイル
All Scene

Battery Near End:Info Battery ○ ×
End:Info Battery ○ ×
Near End:Sony Battery ○ ×
End:Sony Battery ○ ×
Near End:Other Battery ○ ×
End:Other Battery ○ ×
Detected Battery － －

DC Voltage Alarm DC Low Voltage1 ○ ×
DC Low Voltage2 ○ ×
DC(24V) Low Voltage1 ○ ×
DC(24V) Low Voltage2 ○ ×

Control Display Brightness level ○ ×
Genlock Input Source ○ ×

Reference Lock Type － －
1) 以下の項目は保存されません。

ˎˎ Scan Networks
ˎˎ SSID
ˎˎ Password
ˎˎ WPS
ˎˎ MAC Address
ˎˎ Regenerate Password

Maintenanceメニュー

項目 細目 保存先ファイル
All Scene

Clock Set Time Zone ○ ×
Date Mode ○ ×
Date － －
Time － －

Language Select ○ ×
Hours Meter Camera(System) － －

R7 Recorder(System) － －
Camera(Resettable) － －
R7 Recorder(Resettable) － －
Reset-Cam(Resettable) － －
Reset-R7(Resettable) － －

Reset to Default Reset － －
Network Reset Reset － －
License Options Install: xxx － －

Anamorphic － －
Full-Frame － －
High Frame Rate － －
Unique Device ID － －

Firmware Camera － －
AXS － －
FW Update-camera － －
FW Update-AXS-R7 － －

[ご注意]
Technicalメニュー > System Configuration > RM/RCP Paint Control（81ページ）がOnに設定されている場合は、
以下のリモートコントロールユニットの操作項目（109ページ）もALL Fileに保存されます。
ˎˎ Black
ˎˎ Flare
ˎˎ Gamma 1)

ˎˎ Black Gamma 1)

ˎˎ Gain
1) S-Log3のときを除く。
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記録・出力メタデータ一覧
表凡例
Opt: 情報が取得できた場合のみ記述
○：記述する
―：記述しない

項目 RAW VIEWERでの表記例 RAW/
X-OCN 
MXF

RAW/
X-OCN 
XML

XAVC XAVC 
XML

ProRes ProRes 
XML

MPEG 
HD

MPEG 
HD XML

HD-SDI

Creation Date 2019-10-29 11:04:05 ○ ○ ○ ○ ○ ○ ○ ○ ―
Last Update 2019-10-30 11:04:05 ― ○ ○ ○ ○ ○ ○ ○ ―
UMID 060A2B340101010501010D4313000000070BF41

D2F494EB7A16DD045A68CDF2E
○ ○ ○ ○ ○ ○ ○ ○ ―

Start 03:36:29:20 ○ ○ ○ ○ ○ ○ ○ ○ ―
End 03:36:32:19 ○ ○ ○ ○ ○ ○ ○ ○ ―
Duration 00:00:03:00 ○ ○ ○ ○ ○ ○ ○ ○ ―
Poster Frame ― ― ― ― ― ― ― ― ―
Recording Mode ― ○ ― ○ ― ○ ― ○ ―
Drop Frame NDF ○ ○ ○ ○ ○ ○ ○ ○ ―
Camera VENICE/CineAltaV ○ ○ ○ ○ ― ○ ○ ○ ―
Video Codec X-OCN XT ○ ○ ○ ○ ○ ○ ○ ○ ―
Resolution 6048x4032 ○ ○ ○ ○ ○ ○ ○ ○ ―
Aspect Ratio 3:2 ○ ○ ○ ○ ○ ○ ○ ○ ―
Format FPS 23.98p ○ ○ ○ ○ ○ ○ ○ ○ ―
Capture FPS 23.98p ○ ○ ○ ○ ― ○ ○ ○ ―
Flip normal ― ○ ― ― ― ― ― ― ―
Number of Audio Channels 4 ○ ○ ○ ○ ○ ○ ○ ○ ―
Audio Codec LPCM ○ ○ ○ ○ ○ ○ ○ ○ ―
Audio Bit Depth 24 ○ ○ ○ ○ ○ ○ ○ ○ ―
Audio Sampling Rate 48000 ○ ○ ○ ― ○ ― ○ ― ―
Auto Exposure Mode ManualExposureMode ○ ― ○ ― ― ― ○ ― ○
Exposure Index 500 ○ ○ ○ ― ○ ― ○ ― ○
Auto Focus Sensing Area Setting ManualFocusMode Opt ― Opt ― ― ― Opt ― Opt
ND Filter Wheel 1/4 ○ ○ ○ ― ― ― ○ ― ○
Image Sensor Dimension Effective Width 35925um ○ ― ○ ― ― ― ○ ― ○
Image Sensor Dimension Effective Height 23950um ○ ― ○ ― ― ― ○ ― ○
Image Sensor Readout Mode ProgressiveFrame ○ ○ ○ ― ― ― ○ ― ○
Shutter Speed Angle 172.50deg ○ ○ ○ ― ― ― ○ ― ○
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項目 RAW VIEWERでの表記例 RAW/
X-OCN 
MXF

RAW/
X-OCN 
XML

XAVC XAVC 
XML

ProRes ProRes 
XML

MPEG 
HD

MPEG 
HD XML

HD-SDI

Shutter Speed Time 1/50sec ○ ― ○ ― ― ― ○ ― ○
Camera Master Gain Adjustment 0.00dB ○ ― ○ ― ― ― ○ ― ○
ISO Sensitivity 500 ○ ○ ○ ― ○ ― ○ ― ○
Electrical Extender Magnification 100% ○ ― ○ ― ― ― ○ ― ○
Auto White Balance Mode PresetWhiteBalanceSetup ○ ― ○ ― ○ ― ○ ― ○
White Balance 5500 ○ ○ ○ ― ○ ― ○ ― ○
Tint Correction 0.00000 ○ ― ○ ― ― ― ― ― ○
Camera Master Black Level 3.0% ― ― ○ ― ― ― ○ ― ○
Capture Gamma Equation scene-linear ○ ○ ○ ○ ○ ○ ○ ○ ○
Gamma for CDL rec709 ○ ○ ○ ― ○ ― ○ ― ○
Color Primaries (Capture Color Primaries) ― ― ○ ○ ○ ― ― ― ○
Camera Attributes MPC-36109999999Version5.00 ○ ○ ○ ― ― ― ― ― ○
Effective Marker Aspect Ratio 6048:3202 ○ ○ ○ ― ― ― ― ― ○
Active Area Aspect Ratio 6048:4032 ○ ○ ○ ― ― ― ― ― ○
Pixel Aspect Ratio 1:1 ○ ○ ○ ― ○ ― ― ― ○
Image Orientation normal ○ ― ○ ― ― ― ― ― ○
Raw Black Code 512 ○ ○ ― ― ― ― ― ― ―
Raw Gray Code 1504 ○ ○ ― ― ― ― ― ― ―
Raw White Code 5472 ○ ○ ― ― ― ― ― ― ―
Gamma for Look s-log3-cine ○ ○ ○ ― ― ― ― ― ○
Color for Look s-gamut3-cine ○ ○ ○ ― ― ― ― ― ○
Pre-CDL Transform LUT:SL3SG3Ctos709.cube ○ ○ ○ ― ― ― ― ― ○
Post-CDL Transform none ○ ○ ○ ― ― ― ― ― ○
Look Process Baked false ○ ○ ○ ― ― ― ― ― ○
Monitoring Characteristics rec709 ○ ○ ○ ― ― ― ― ― ○
Monitoring Base Curve rec709 ○ ○ ○ ― ○ ― ― ― ○
Monitoring Color Primaries rec709 ○ ○ ○ ― ― ― ― ― ○
Monitoring Coding Equations rec709 ○ ○ ○ ― ― ― ― ― ○
Monitoring Descriptions LUT:SL3SG3Ctos709.cube ○ ○ ○ ― ○ ― ― ― ○
Focus Distance 2296mm Opt ― Opt ― ― ― ― ― Opt
Aperture Value 3.14 Opt ― Opt ― ― ― ― ― Opt
Aperture Ring T Stop Position 2.8 + 3/10 Opt ― Opt ― ― ― ― ― Opt
Current Focal Length 0mm Opt ― Opt ― ― ― ― ― Opt
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項目 RAW VIEWERでの表記例 RAW/
X-OCN 
MXF

RAW/
X-OCN 
XML

XAVC XAVC 
XML

ProRes ProRes 
XML

MPEG 
HD

MPEG 
HD XML

HD-SDI

Hyperfocal Distance 219224mm Opt ― Opt ― ― ― ― ― Opt
Near Focus Distance 2273mm Opt ― Opt ― ― ― ― ― Opt
Far Focus Distance 2319mm Opt ― Opt ― ― ― ― ― Opt
Horizontal Field of View 27.9deg Opt ― Opt ― ― ― ― ― Opt
Entrance Pupil Position +51mm Opt ― Opt ― ― ― ― ― Opt
Normalised Zoom Value 0.000 Opt ― Opt ― ― ― ― ― Opt
Lens Serial Number xxxxxxxx Opt ― Opt ― ― ― ― ― Opt
Iris F-Number 2.87 Opt ― Opt ― ― ― Opt ― Opt
Iris T-Number 3.1 Opt ― Opt ― ― ― Opt ― Opt
Iris Ring Position Opt ― Opt ― ― ― Opt ― Opt
Focus Position from Image Plane 2.296m Opt ― Opt ― ― ― Opt ― Opt
Focus Ring Position Opt ― Opt ― ― ― Opt ― Opt
Macro Setting OFF Opt ― Opt ― ― ― Opt ― Opt
Lens Zoom 35mm Still Camera Equivalent 85mm Opt ― Opt ― ― ― Opt ― Opt
Lens Zoom Actual Focal Length 85mm Opt ― Opt ― ― ― Opt ― Opt
Zoom Ring Position Opt ― Opt ― ― ― Opt ― Opt
Anamorphic Lens Squeeze Ratio Opt ― Opt ― ― ― ― ― Opt
Optical Extender Magnification 100% Opt ― Opt ― ― ― ― ― Opt
Lens Attributes xxxxxxxx Opt Opt Opt ― ― ― Opt ― Opt
Cooke /i technology Opt ― Opt ― ― ― ― ― Opt
Cooke /i2 technology Opt ― Opt ― ― ― ― ― Opt
Cooke /i3 technology Opt ― Opt ― ― ― ― ― Opt
Zeiss eXtended metadata Opt ― Opt ― ― ― ― ― Opt
Description ― ― ― ― ― ― ― ― ―
Circle ― ― ― ― ― ― ― ― ―
Project ― ― ― ― ― ― ― ― ―
Director Name ― ― ― ― ― ― ― ― ―
Director of Photography Name ― ― ― ― ― ― ― ― ―
Production ― ― ― ― ― ― ― ― ―
Camera Index ― ○ ― ― ― ― ― ― ―
Reel ― ○ ― ― ― ― ― ― ―
Scene ― ― ― ― ― ― ― ― ―
Cut ― ― ― ― ― ― ― ― ―
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項目 RAW VIEWERでの表記例 RAW/
X-OCN 
MXF

RAW/
X-OCN 
XML

XAVC XAVC 
XML

ProRes ProRes 
XML

MPEG 
HD

MPEG 
HD XML

HD-SDI

Take ― ― ― ― ― ― ― ― ―
Shot ― ○ ― ― ― ― ― ― ―
Mark In ― ― ― ― ― ― ― ― ―
Mark Out ― ― ― ― ― ― ― ― ―
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ライセンスについて
MPEG-4 Visual Patent 
Portfolio Licenseについて

本製品は、MPEG LA, LLC.がライセンス活
動を行っているMPEG-4 VISUAL PATENT 
PORTFOLIO LICENSEの下、次の用途に限りラ
イセンスされています：

（i）消費者が個人的、非営利の使用目的で、
MPEG-4 Visual規格に合致したビデオ信号（以
下、MPEG 4 VIDEOといいます）にエンコード
すること。
（ii）MPEG-4 VIDEO（消費者が個人的に非営利
目的でエンコードしたもの、若しくはMPEG LA
よりライセンスを取得したプロバイダーがエン
コードしたものに限られます）をデコードする
こと。

なお、その他の用途に関してはライセンスされ
ていません。プロモーション、商業的に利用
することに関する詳細な情報につきましては、
MPEG LA, LLC.のホームページ（HTTP://WWW.
MPEGLA.COM）をご参照ください。

MPEG LAは、（i）MPEG-4 Visualビデオ情報を
記録した媒体（PACKAGED MEDIA）を製造し、
販売する行為、（ii）MPEG-4 Visualビデオ情報
を何らかの方法（オンラインビデオ配信サービ
ス、インターネット放送、TV放送など）で配信・
放送する行為について、ライセンスを提供して
います。
その他の使用方法につきましても、MPEG LAか
らのライセンス取得が必要な場合があります。
詳しくは、MPEG LAにお問い合わせください。

MPEG LA. L.L.C., 250 STEELE STREET, SUITE 
300, DENVER, COLORADO 80206
ホームページ：http://www.mpegla.com

MPEG-4 AVC Patent 
Portfolio Licenseについて

本製品は、MPEG LA, LLCがライセンス活動を
行っているAVC PATENT PORTFOLIO LICENSE
の下、次の用途に限りライセンスされています：

（i）消費者が個人的又は他の報酬を受けていない
使用目的で、MPEG-4 AVC規格に合致したビデ
オ信号（以下、AVC VIDEOといいます）にエン
コードすること。
（ii）AVC VIDEO（消費者が個人的又は他の報酬
を受けていない目的でエンコードしたもの、若
しくはMPEG LAよりライセンスを取得したプロ
バイダーがエンコードしたものに限られます）
をデコードすること。

なお、その他の用途に関してはライセンスされ
ていません。プロモーション、商業的に利用
することに関する詳細な情報につきましては、
MPEG LA, LLC.のホームページをご参照くださ
い。

GPL/LGPL適用ソフトウェ
アの入手について

本製品はGPL/LGPL適用のソフトウェアを使用
しており、お客様には、これらのソフトウェア
のソースコードの入手、改変、再配布の権利が
あることをお知らせします。
これらのソースコードはインターネットのサー
バーからダウンロードすることが可能です。以
下のURLにアクセスすれば、具体的なダウンロー
ドの方法がわかるようになっています。
http://www.sony.net/Products/Linux/
common/search.html

なお、ソースコードの中身についてのお問い合
わせはご遠慮ください。

ライセンスの内容に関しては、本機をネット
ワークに接続して、Webリモコン画面のOSS 
Information画面（97ページ）をご覧くださ
い。

オープンソースソフトウェ
アのライセンスについて

本製品には、弊社がその著作権者とのライセン
ス契約に基づき使用しているソフトウェアが搭
載されています。
当該ソフトウェアの著作権者の要求に基づき、
弊社はこれらの内容をお客様に通知する義務が
あります。
ライセンスの内容に関しては、本機をネット
ワークに接続して、Webリモコン画面のOSS 
Information画面（97ページ）をご覧くださ
い。
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保証書とアフターサービス
保証書

ˎˎ この製品には保証書が添付されていますので、
お買い上げの際お受け取りください。

ˎˎ 所定の事項の記入および記載内容をお確かめ
のうえ、大切に保存してください。

アフターサービス

調子が悪いときはまずチェックを

この説明書をもう一度ご覧になってお調べくだ
さい。

それでも具合が悪いときは

お買い上げ店、または添付の「ソニー業務用商
品相談窓口のご案内」にあるお近くのソニーの
サービス窓口にご相談ください。

保証期間中の修理は

保証書の記載内容に基づいて修理させていただ
きます。詳しくは保証書をご覧ください。

保証期間経過後の修理は

修理によって機能が維持できる場合、ご要望に
より有料修理させていただきます。
保証期間中の修理など、アフターサービスにつ
いてご不明な点は、お買い上げ店、またはソニー
のサービス窓口にお問い合わせください。
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主な仕様
一般仕様

質量 約3.9 kg（ハンドル、VFアタッチメント、
ボトムカバーを除く）

外形寸法 146ページ参照
電源電圧 DC 12 V（11 V～ 17 V）
  DC 24 V（22 V～ 32 V）
消費電力 約60 W（XAVC記録時）
動作温度 0 ℃～ 40 ℃
保存温度 －20 ℃～＋60 ℃
連続操作時間
  約60分（BP-FLX75使用時）
記録フォーマット（ビデオ）
 X-OCN XT（AXS-R7装着時）
 RAW SQ(4K 17:9, 3.8K 16:9)（AXS-R7装着時）
 X-OCN ST（AXS-R7装着時）
 X-OCN LT（AXS-R7装着時）
 XAVC-I Class480（4K, QFHD）
 XAVC-I Class300（4K, QFHD）
 MPEG HD422（HD）
 Apple ProRes 422 HQ（HD）
 Apple ProRes 422（HD）
 Apple ProRes 422 Proxy（HD）
 Apple ProRes 4444（HD）
記録フォーマット（オーディオ）
 LPCM 8CH（記録再生2CH）、24-bit、48 kHz
記録プロジェクトフレームレート
 RAW SQ(AXS-R7装着時)：
  4K 17:9/3.8K 16:9
   59.94P/50P/29.97P/25P/24P/ 

23.98P
 X-OCN（AXS-R7装着時）：
  6K 3:2
   25P/24P/23.98P
  6K 17:9/6K 1.85:1/6K 2.39:1/5.7K 

16:9/4K 6:5/4K 17:9 Surround 
View/4K 4:3/4K 4:3 Surround 
View/3.8K 16:9 Surround View

   29.97P/25P/24P/23.98P

  4K 17:9/4K 2.39:1/3.8K 16:9
   59.94P/50P/29.97P/25P/24P/ 

23.98P
  4K 4:3/4K 17:9
   47.95P
 XAVC-I Class480：
  4K:4096×2160
   29.97P/25P/24P/23.98P
  QFHD:3840×2160
   29.97P/25P/ 23.98P
 XAVC-I Class300：
  4K:4096×2160
   59.94P/50P/29.97P/25P/24P/ 

23.98P
  QFHD:3840×2160
   59.94P/50P/29.97P/25P/ 23.98P
 MPEG HD422(50Mbps)：
  HD:1920×1080
   29.97P/25P/ 23.98P/59.94i/50i
 Apple ProRes 422 HQ：
  HD:1920×1080
   23.98P/24P/25P/29.97P/50i/ 

59.94i/50P/59.94P
 Apple ProRes 422：
  HD:1920×1080
   23.98P/24P/25P/29.97P/50i/ 

59.94i/50P/59.94P
 Apple ProRes 422 Proxy（HD）
  HD:1920×1080
   23.98P/24P/25P/29.97P/50i/ 

59.94i/50P/59.94P
 Apple ProRes 4444（HD）
  HD:1920×1080
   23.98P/24P/25P/29.97P
記録・再生時間
 XAVC-I Class480 23.98P
  約34分：SBP-128B/C/D使用時
 XAVC-I Class300 23.98P
  約54分：SBP-128B/C/D使用時
 MPEG2 HD422
  約108分：SBS-64G1A/B使用時

 Apple ProRes 422 HQ (HD) 23.98P
  約33分：SBP-64B/C/D/E使用時
 Apple ProRes 422 (HD) 23.98P
  約49分：SBP-64A/B/C/D/E使用時
 Apple ProRes 422 Proxy (HD) 23.98P
  約145分：SBS-64G1A/B/C使用時
 Apple ProRes 4444 (HD) 23.98P
  約22分：SBP-64B/C/D/E使用時

［ご注意］

ˎˎ 記録・再生時間は、1クリップとして連続記録したとき
のものです。記録するクリップ数によっては記載の時
間より短くなる場合があります。また、使用条件やメ
モリーの特性などにより、多少の誤差が生じる場合が
あります。
ˎˎ  6K 3:2 50P/59.94Pと4K 4:3 50P/59.94PのX-OCN記録
は可能ですが、再生は本機ではできません。

カメラ部

撮像素子 35mmFull Size相当単板CMOSイメー
ジセンサー

画素数 24.8M（total）
内蔵フィルター

NDフィルター A
Clear 0.3 

(1/2)
0.6 

(1/4)
NDフィル
ター B

Clear Clear 0.3  
(1/2)

0.6 
(1/4)

0.9 
(1/8)

0.9 
(1/8)

1.2 
(1/16)

1.5 
(1/32)

1.8 
(1/64)

1.8 
(1/64)

2.1 
(1/128)

2.4 
(1/256)

ISO感度 ISO 500（D55 Light source）
  ISO 2500（D55 Light source）
レンズマウント
  PLマウント（レンズマウントアダプ

ター使用）

  Eマウント（レンズマウントアダプター
未使用時）

フランジバック
  PLマウント：52 mm
  Eマウント：18 mm
ラチチュード
  15+ stop

入出力

オーディオ入力
  CH-1/CH-2：XLR型5ピン（1）、凹型、

LINE / AES/EBU / MIC / MIC+48V
切り換え可能

DC入力 XLR型、4ピン（1）、凸、11 V～ 17 V
または22 V～ 32 V DC

DC出力（12 V）
  Hirose 4ピン（1）、11 V～ 17 V DC 

（出力電圧：入力電圧と同じ、出力
最大電流：1.0 A）、22 V～ 32 V 
DC（出力電圧：15 V、出力最大電
流：0.8 A）、バッテリーアダプター
使用時

[ご注意]

ˎˎ 12V OUT端子を経由してREC Tally信号の出力、REC 
Trigger信号の入力をすることが可能です。
ˎˎ 12V OUT端子には、11 V～ 17 V入力時は消費電流が

1.0 A以下の機器を、22 V～ 32 V入力時は消費電流が
0.8 A以下の機器を接続してください。

DC出力（24 V）
  Fischer 3ピン（2）、11 V～ 17 V DC（出

力電圧：24 V、出力最大電流： 
1.0 A）、22 V～ 32 V DC（出力電圧：
入力電圧と同じ、出力最大電流： 
2.0 A）
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[ご注意]
24V OUT端子には、11 V～ 17 V入力時は消費電流が1.0 A
以下の機器を、22 V～ 32 V入力時は消費電流が2.0 A以下
の機器を接続してください。

SDI出力 BNC型（4）
  3G-SDI：SMPTE ST424/425  

Level B-DL/DS
  HD SDI：SMPTE ST292 準拠
AUX LEMO 5ピン（1）
ビューファインダー出力
  LEMO 26ピン（1）
ネットワーク
  RJ45型（1）
リモートコントロール
  8ピン（1）
MONITOR出力
  BNC型（1）
  HD SDI：SMPTE ST292 準拠
タイムコード入力
  TC IN：BNC型（1）
GENLOCK入力
  BNC型（1）
HDMI出力
  Type A型（1）
外部機器接続端子
  USB host：Type A（1）
ヘッドホン出力
  ステレオミニジャック（1）
スピーカー出力
  モノラル

メディアスロット部

タイプ ExpressCard/34（2）
  SD card（1）

付属品

VFアタッチメント（1）
ハンドル（1）
VFケーブル（1）(A-2203-745-A)
シム（円弧型）（1）(4-730-328-11)
シム（1/3円弧型）（15）(4-730-328-21)
Eマウントレンズキャップ（1）
ご使用になる前に（1）
取扱説明書（CD-ROM）（1）

別売りアクセサリー

0.7型ビューファインダー
  DVF-EL200
カメラエクステンションシステム
  CBK-3610XS
ワイヤレスLANアダプター
  CBK-WA02
リモートコントロールユニット
  RM-B170/B750
  RCP-1000/1500/1530
  RCP-1001/1501
ポータブルメモリーレコーダー
  AXS-R7
SxSメモリーカード（SxS Pro+/SxS-1）
  SBP-64/128/256E、 

SBS-32/64/128G1C、
SBP-240F/120F

カードリーダー
  SBAC-US30、SBAC-T40、 

AXS-AR1
ショルダーアダプター（VシューでVCT-14に装着

するアダプター）
  VCT-FSA5

PLマウントレンズ
  SCL-PK6/F（Feet表示）、SCL-PK6/

M（Meter表示）（6本セット: 20、
25、35、50、85、135 mm）、 
SCL-P11X15（11 mm～ 16 mm 
Zoom）

Eマウントレンズ
  SELP28135G、SEL1635GM、

SEL2470GM、SEL70200GM、
SEL100400GM、SEL1224G、
SEL35F14Z、SEL50F14Z、
SEL85F14GM、SEL90M28G、
SEL100F28GM

バッテリーパック
  BP-FL75、BP-GL95B
ACアダプター
  AC-DN10A
マイク ECM-680S、ECM-678*、ECM-674*
* XLR 3ピン→5ピン変換ケーブルEC-0.5X3F5Mが必要
2連バッテリーアダプター
  BKW-L200（バッテリー接続アダプター

を介して接続）
SDI/HDMIモニター
  BVMシリーズ、PVMシリーズ、LMD

シリーズ
XQDメモリーカード（XQD→SxS ExpressCardア

ダプター QDA-EX1が必要）
  QD-G32F/G64F/G120F/G240F

仕様および外観は、改良のため予告なく変更す
ることがありますが、ご了承ください。

ˎˎ 必ず事前に記録テストを行い、正常に記録
されていることを確認してください。本機
や記録メディア、外部ストレージなどを使
用中、万一これらの不具合により記録され
なかった場合の記録内容の補償については、
ご容赦ください。

ˎˎ お使いになる前に、必ず動作確認を行って
ください。故障その他に伴う営業上の機会
損失等は保証期間中および保証期間経過後
にかかわらず、補償はいたしかねますので
ご了承ください。

ˎˎ 本製品を使用したことによるお客様、また
は第三者からのいかなる請求についても、
当社は一切の責任を負いかねます。

ˎˎ 本機内、記録メディア、外部のストレージ
等に記録されたデータの損失、修復、複製
の責任は負いかねます。

ˎˎ 諸事情による本製品に関連するサービスの
停止、中断について、一切の責任を負いか
ねます。
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外形寸法
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商標について

ˎˎ“XAVC”および  はソニー株式会社の登
録商標です。

ˎˎ HDMI、High-Definition Multimedia 
Interface、およびHDMIロゴ は、米国お
よびその他の国におけるHDMI Licensing 
Administrator, Inc.の商標または、登録商標
です。

ˎˎ その他、本書で登場するシステム名、製品名は、
一般に各開発メーカーの登録商標あるいは商
標です。なお、本文中で®、™マークは明記し
ておりません。
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